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Preface

Welcome to the IBM SPSS Data Collection Server 6 Installation Guide. This guide provides
information on installing IBM SPSS Data Collection Server 6 products. For information about
using the products, refer to the appropriate application user guide.

Adobe Portable Document Format (.pdf) versions of the guides are available on the IBM SPSS
Data Collection Server 6 DVD-ROM. Viewing and printing the documents requires Adobe
Reader. If necessary, you can download it at no cost from www.adobe.com. Use the Adobe Reader
online Help for answers to your questions regarding viewing and navigating the documents.

About SPSS Inc., an IBM Company

SPSS Inc., an IBM Company, is a leading global provider of predictive analytic software
and solutions. The company’s complete portfolio of products — data collection, statistics,
modeling and deployment — captures people’s attitudes and opinions, predicts outcomes of
future customer interactions, and then acts on these insights by embedding analytics into business
processes. SPSS Inc. solutions address interconnected business objectives across an entire
organization by focusing on the convergence of analytics, IT architecture, and business processes.
Commercial, government, and academic customers worldwide rely on SPSS Inc. technology as
a competitive advantage in attracting, retaining, and growing customers, while reducing fraud
and mitigating risk. SPSS Inc. was acquired by IBM in October 2009. For more information,
visit http://www.spss.com.

Technical support

Technical support is available to maintenance customers. Customers may contact
Technical Support for assistance in using SPSS Inc. products or for installation help
for one of the supported hardware environments. To reach Technical Support, see the
SPSS Inc. web site at http://support.spss.com or find your local office via the web site at
http://support.spss.com/default.asp?refpage=contactus.asp. Be prepared to identify yourself, your
organization, and your support agreement when requesting assistance.
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Chapter

1
IBM SPSS Data Collection Server 6
Installation Instructions

IBM SPSS Data Collection Server 6 Installation Instructions and
configuration notes

These instructions are for installing IBM SPSS Data Collection Server 6, which includes the
following products:

IBM® SPSS® Data Collection Interviewer Server Administration
IBM® SPSS® Data Collection Interviewer Server, including the Accessories, Interview, and
Web services and the IBM® SPSS® Data Collection Load Tool.
IBM® SPSS® Data Collection Phone Interviews
IBM® SPSS® Data Collection Remote Administration
IBM® SPSS® Data Collection Survey Tabulation
IBM® SPSS® Data Collection Survey Reporter Server Edition
IBM® SPSS® Data Collection Survey Reporter Developer Kit
IBM® SPSS® Data Collection Author Server Edition

Before you start

Before you attempt to install IBM SPSS Data Collection Server 6, take the time to read and
understand these notes.

If you are upgrading from a previous version of Interviewer Server\mrInterview, Web Reports for
Surveys\mrTables, or Reports for Surveys\Reporter, refer to Required Software Checklist and
Requirements for Installation before you install the new version. This ensures that your system
satisfies the requirements for version 6.

Note: If you have an earlier version of Interviewer Server\mrInterview, Web Reports for
Surveys\mrTables, or Reports for Surveys\Reporter installed, the IBM SPSS Data Collection
Server 6 installation procedure will prompt you to uninstall the earlier versions before installing
IBM SPSS Data Collection Server 6.

© Copyright SPSS Inc. 2000, 2010 1
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What you need to run the IBM SPSS Data Collection Server 6 applications

The minimum hardware and software requirements for IBM SPSS Data Collection Server 6
applications are as follows:

IBM SPSS Data Collection Interviewer Server

Web Service

Microsoft Windows Server 2003 or 2008 Standard or Enterprise Edition (x86 32-bit or x64
64-bit edition) with Service Pack 2.
Pentium®-class processor operating at 1GHz or faster. 2GHz recommended..
512MB RAM, more recommended.
A hard disk with at least 100MB of available disk space.
A 1024 x 768 or higher resolution graphics adaptor that supports at least 16-bit color.
A DVD-ROM drive.
Internet Explorer 6.0 or above.
Internet Information Server (IIS) 6.0 or later.

Interview Service

Microsoft Windows Server 2003 or 2008 Standard or Enterprise Edition (x86 32-bit or x64
64-bit edition) with Service Pack 2.
Pentium®-class processor operating at 1GHz or faster. 2GHz recommended..
512MB RAM, more recommended.
A hard disk with at least 200MB of available disk space (space depends on the number of
projects on the server).
A 1024 x 768 or higher resolution graphics adaptor that supports at least 16-bit color.
A DVD-ROM drive.
Internet Explorer 6.0 or above.
Microsoft Data Access Components (MDAC) 2.8 or later (supplied).
Microsoft .NET Framework 3.5 SP1 (supplied).
Internet Information Server (IIS) 6.0 or later.
IBM® SPSS® Data Collection Developer Library (recommended) .

Accessories Service

As Interview Service.
Microsoft Office Web Components (OWC) version 10 or later (for the charting feature of
the Phone Reports activity only).

Database Service
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Microsoft Windows Server 2003 or 2008 Standard or Enterprise Edition (x86 32-bit or x64
64-bit edition) with Service Pack 2.
Microsoft® SQL Server®.

Scriptwriter Service

Microsoft® Windows® XP Professional (x86 32-bit edition) with Service Pack 3, Microsoft
Windows Vista Business or Enterprise Edition (x86 32-bit or x64 64-bit edition), or Microsoft
Windows 7 Professional or Enterprise Edition (x86 32-bit or x64 64-bit edition).
Pentium-class processor running at 500MHz or faster.
256MB or more of random-access memory (RAM).
A hard disk with at least 150MB of available disk space.
A 1024 x 768 or higher resolution graphics adaptor that supports at least 16-bit color.
A DVD-ROM drive.

For XP Professional
Internet Explorer 6.0 or above.
Microsoft Data Access Components (MDAC) 2.8 or later (supplied).
For XP Professional, Microsoft .NET Framework 3.5 SP1 (supplied).

For Vista
Internet Explorer 7.0 or above.
Microsoft .NET Framework 3.0.

Telephone Interviewing Supervisor Stations

Microsoft® Windows® XP Professional (x86 32-bit edition) with Service Pack 3, Microsoft
Windows Vista Business or Enterprise Edition (x86 32-bit or x64 64-bit edition), or Microsoft
Windows 7 Professional or Enterprise Edition (x86 32-bit or x64 64-bit edition)
Pentium-class processor running at 500MHz or faster.
256MB or more of random-access memory (RAM).
A hard disk with at least 100MB of available disk space.
A 1024 x 768 or higher resolution graphics adaptor that supports at least 16-bit color.
A DVD-ROM drive.

For XP Professional
Internet Explorer 6.0 or above.

For Vista
Internet Explorer 7.0 or above.

Telephone Interviewing Interviewer Stations

Either:
Microsoft® Windows® XP Professional (x86 32-bit edition) with Service Pack 3, Microsoft
Windows Vista Business or Enterprise Edition (x86 32-bit or x64 64-bit edition), or Microsoft
Windows 7 Professional or Enterprise Edition (x86 32-bit or x64 64-bit edition)
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Or:
Wyse terminals running Linux V6 and Firefox Web Browser Version 1.0.
For Windows: Pentium-class processor running at 500MHz or faster; For Wyse: 486-type
processor operating at 66MHz or faster; Intel Pentium III or later recommended.
For Windows: 256MB or more of random-access memory (RAM); For Wyse: 32MB of
random-access memory (RAM); 128MB recommended.
A hard disk with at least 100MB of available disk space.
A 1024 x 768 or higher resolution graphics adaptor that supports at least 16-bit color.
A DVD-ROM drive.

For XP Professional
Internet Explorer 6.0 or above.

For Vista
Internet Explorer 7.0 or above.

For Linux
Firefox Web Browser Version 1.0.

Note: Modem dialing is not supported on Wyse Winterms: a PC running Microsoft Windows,
as previously specified, is required.

IBM SPSS Data Collection Remote Administration

As Interview Service

IBM SPSS Data Collection Survey Tabulation

Operating systems

Microsoft Windows Server 2003 or 2008 Standard or Enterprise Edition (x86 32-bit or x64
64-bit edition) with Service Pack 2.

Important: Installing IBM® SPSS® Data Collection Survey Tabulation on Microsoft Windows
XP is not supported. Instructions relating to XP are provided solely to enable demonstration and
evaluation copies of the software to be installed.

Hardware

Pentium®-class processor operating at 1GHz or faster. 2GHz recommended..
512MB RAM (2 GB recommended).
A hard disk with at least 200MB of available disk space.
DVD-ROM drive required for installation.

Software

Microsoft .NET Framework 3.5 SP1.
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Microsoft Data Access Components (MDAC) 2.8 or later (supplied).
Microsoft Internet Explorer 6.0 or above. MS XML 4.0 SP3 add-in is required. If you do not
have the MS XML 4 SP3 add-in installed, it will be installed during installation. However,
note that client end users must manually install MS XML 4.0 SP3. For more information, see
the topic Installing Internet Explorer 6.0 or above in Chapter 2 on p. 9.
Notes: Some Survey Tabulation pages do not display well in Internet Explorer 6.0. For best
results, use Internet Explorer 7.0 or above.
Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit).
Microsoft Internet Information Server (IIS) 6.0, with ASP.NET option.
SQL Server.
For running the charting feature, Microsoft Office Web Components (OWC) version 10 or
later must be installed.
For more information about the required software, see the Required Software Checklist.

IBM SPSS Data Collection Survey Reporter Server Edition and IBM SPSS Data Collection Author
Server Edition

Operating systems

Microsoft® Windows® XP Professional (x86 32-bit edition) with Service Pack 3, Microsoft
Windows Vista Business or Enterprise Edition (x86 32-bit or x64 64-bit edition), or Microsoft
Windows 7 Professional or Enterprise Edition (x86 32-bit or x64 64-bit edition).

Hardware

A graphics adapter with 1024 x 768 resolution or higher and a minimum 16-bit color quality
setting.
DVD-ROM drive required for installation.

Software

For Windows XP systems:
Microsoft .NET Framework 3.5 SP1.
Microsoft Internet Explorer 6.0 or above. MS XML 4.0 SP3 add-in is required. Client end
users must manually install MS XML 4.0 SP3. For more information, see the topic Installing
Internet Explorer 6.0 or above in Chapter 2 on p. 9.
Note: Some Survey Tabulation pages do not display well in Internet Explorer 6.0. For best
results, use Internet Explorer 7.0 or above.
Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit).
Microsoft Office 2000, XP, 2003, or 2007 (required for exporting to Microsoft Word, Excel
or PowerPoint, or to HTML). For Microsoft Office 2000 or XP, Service Pack 3 or later
is required; for Microsoft Office 2003, Service Pack 2 or later (with Office 2003 update
KB907417) is required.
For viewing charts, Microsoft Office Web Components (OWC) license (version 10 or later).
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For Windows Vista systems:
Microsoft .NET Framework 3.0.
Microsoft Internet Explorer 7.0 or above. MS XML 4.0 SP3 add-in is required. Client end
users must manually install MS XML 4.0 SP3. For more information, see the topic Installing
Internet Explorer 6.0 or above in Chapter 2 on p. 9.
Microsoft Office 2000, XP, 2003, or 2007 (required for exporting to Microsoft Word, Excel
or PowerPoint, or to HTML). For Microsoft Office 2000 or XP, Service Pack 3 or later
is required; for Microsoft Office 2003, Service Pack 2 or later (with Office 2003 update
KB907417) is required.
For viewing charts, Microsoft Office Web Components (OWC) license (version 10 or later).

Additional IBM® SPSS® Data Collection Survey Reporter Server Edition and IBM® SPSS® Data
Collection Author Server Edition considerations

The Internet Explorer security settings can adversely affect access to Survey Reporter Server
Edition and Author Server Edition. It is recommended that you configure Internet Explorer for
Medium security (Tools→ Internet Options→ Security tab→ Security level for this zone).
– A security setting of High will prevent all users from logging into IBM® SPSS® Data
Collection Interviewer Server Administration, thus preventing access to Survey Reporter
Server Edition and Author Server Edition.
– A security setting of Medium -high will allow users to login to Interviewer Server
Administration, but will prevent most users from launching Survey Reporter Server Edition
and Author Server Edition from their respective links.
Users who only belong to the Windows Guests account are not able to install or run Survey
Reporter Server Edition and Author Server Edition.
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Required software checklist

Before you install any of the IBM SPSS Data Collection Server 6 applications you should verify
that any required software is installed and running. If the IBM SPSS Data Collection Server 6
installation procedure is unable to find an application, or that application is not running correctly,
the installation procedure will fail.

IBM SPSS Data Collection Server 6 applications requires the following software.

IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey Reporter Server
Edition, and IBM SPSS Data Collection Author Server Edition

Microsoft .NET Framework 3.5 SP1
Microsoft Data Access Components (MDAC) 2.8
Microsoft Internet Explorer 6.0 or above with MS XML 4.0 SP3 add-in
Microsoft Internet Information Services (IIS) with the ASP.NET option
Microsoft SQL Server 2005 or 2008
Microsoft Office Web Components (OWC) (required to display charts in IBM® SPSS®
Data Collection Survey Tabulation)
Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit)

IBM SPSS Data Collection Interviewer Server

Available on the IBM® SPSS® Data Collection Interviewer Server installation CD

The following software is required and can be installed manually from the IBM SPSS Data
Collection Server 6 installation CD.

Software Web Servers Interviewing
Servers

Accessories
Servers

Database
Servers

Scriptwriters’
machines

Microsoft
Data Access
Components
2.8

Yes Yes Yes No Yes

IBM® SPSS®
Data Collection
Developer
Library

No No No No Optional

© Copyright SPSS Inc. 2000, 2010 7
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Purchase and install separately

The following required software must be purchased and installed separately before Interviewer
Server can be installed.

Software Web Servers Interviewing
Servers

Accessories
Servers

Database
Servers

Scriptwriters’
machines

Microsoft
Internet
Information
Services with
the ASP.NET
option

Yes Yes Yes No No

Microsoft
SQL Server
2005 or 2008
(Interviewer
Server
Professional
only)

No No No Yes No

Download and install separately

The following required software must be downloaded (for free) and installed separately.

Software Web Servers Interviewing
Servers

Accessories
Servers

Database
Servers

Scriptwriters’
machines

Microsoft .NET
Framework 3.5
SP1

Yes Yes Yes No Yes

Microsoft
Internet
Explorer 6.0
or above

Yes Yes Yes No Yes

Microsoft
Office Web
Components
10.0 or above

No No Yes No No

Microsoft
Visual
C++ 2008
Redistributable
Package (x86
32-bit)

No No Yes No Yes

Note: Some Survey Tabulation pages do not display well in Internet Explorer 6.0. For best
results, use Internet Explorer 7.0 or above.

Installing Microsoft .NET Framework 3.5 SP1

Before you can run any of the IBM SPSS Data Collection Server applications, you need to
install Microsoft .NET Framework 3.5 SP1 on your computer, and on machines that will run the
Accessories, Interview, or Scriptwriter services. If you attempt to install any of the IBM SPSS
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Data Collection Server applications when Microsoft .NET Framework 3.5 SP1 is not installed,
the installation program will display a message explaining that you need to install it in order
for the applications to run.
Note: Installing Microsoft .NET Framework 3.5 SP1 upgrades a number of Windows

components.

Installing Microsoft .NET Framework 3.5 SP1

E Download and install Microsoft .NET Framework 3.5 SP1 from the Microsoft download site
(http://www.microsoft.com/downloads/details.aspx?familyid=ab99342f-5d1a-413d-8319-81da479ab0d7&displaylan

E Follow the instructions on the screen.

E Restart your computer. This is recommended even if the installation program does not request it.

E From Control Panel select
Administrative Tools > Internet Information Services

E In the left-hand frame, right-click Web Sites and choose Properties.

This opens the Web Sites Properties dialog box.

E On the Documents tab click Add.

This opens the Add Default Document dialog box.

E Type Default.aspx and click OK.

E Close IIS.

Installing Microsoft Data Access Components 2.8

You need to install Microsoft Data Access Components (MDAC) 2.8 on your computer before
you can install any of the IBM SPSS Data Collection Server applications. If MDAC 2.8 (in any
language) is not already installed, the IBM SPSS Data Collection Server installation program will
install the English language version for you. If you you want to use a non-English version of
MDAC, you must manually install the appropriate language version of MDAC 2.8. You can do
this by selecting Install Microsoft Data Access Components (MDAC) 2.8 from the autoplay menu
(MDAC can also be found in the MDAC folder on the installation DVD-ROM, or you can
download it from http://www.microsoft.com/Windows/downloads/default.mspx)

Installing Internet Explorer 6.0 or above

Internet Explorer 6.0 or above, with the MS XML 4.0 SP3 add-in (required for IBM® SPSS®
Data Collection Survey Reporter Server Edition and IBM® SPSS® Data Collection Author
Server Edition), must be installed before you can install any of the IBM SPSS Data Collection
Server 6 applications. If you do not have a suitable version of Internet Explorer installed, the IBM
SPSS Data Collection Server 6 installation program will not run.

http://www.microsoft.com/downloads/details.aspx?familyid=ab99342f-5d1a-413d-8319-81da479ab0d7&displaylang;=en
http://www.microsoft.com/downloads/details.aspx?familyid=ab99342f-5d1a-413d-8319-81da479ab0d7&displaylang;=en
http://www.microsoft.com/Windows/downloads/default.mspx
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If you do not have the MS XML 4.0 SP3 add-in installed on the server machine, it will be
automatically installed. However, note that client end users must manually install the MS XML
4.0 SP3 add-in. See instructions below.

Installing Internet Explorer 6.0 or above

E Go to http://www.microsoft.com/windows/ie/downloads/default.mspx
(http://www.microsoft.com/windows/ie/downloads/default.mspx) and from there
navigate to the page that provides downloads in the language of your choice.

E Follow the instructions provided to download Internet Explorer.

Note: If you are using Microsoft Internet Explorer 8.x or above, you may experience
various issues when using the IBM SPSS Data Collection Server applications. You
can avoid these issues by adding the appropriate IBM SPSS Data Collection Server
application URLs to the Internet Explorer 8.x Compatibility View list. Refer to the
Compatibility View topic on the Microsoft Internet Explorer 8: Features website
(http://www.microsoft.com/windows/internet-explorer/features/easier.aspx) for more information.

Installing MS XML 4.0 SP3 add-in

E Go to MSXML 4.0 Service Pack 3 (Microsoft XML Core Services)
(http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=7F6C0CB4-7A5E-4790-A7CF-9E139E6819C0&d

E Follow the instructions provided to download MS XML.

Installing Internet Information Services

With some operating systems, Internet Information Services (IIS) is installed as part of the
operating system. This is not the case with Windows 2003 Server, where you must manually
install IIS before installing any of the IBM SPSS Data Collection Server 6 applications. If you
are installing onto a 64-bit version of any Windows operating system you must configure IIS
to create 32-bit worker processes.

Important:
IIS must be properly configured in order to ensure sensitive information is not exposed in
response headers. For more information, see the topic Configuring Internet Information
Services to avoid the detection of hidden directories on p. 12.
You must install the ASP.NET and ISAPI extensions in addition to the default installation
features.

Refer to the Microsoft support article Internet Information Server returns IP address in HTTP
header (Content-Location) (http://support.microsoft.com/default.aspx?scid=KB;EN-US;Q218180)
for more information.

http://www.microsoft.com/windows/ie/downloads/default.mspx
http://www.microsoft.com/windows/ie/downloads/default.mspx
http://www.microsoft.com/windows/internet-explorer/features/easier.aspx
http://www.microsoft.com/windows/internet-explorer/features/easier.aspx
http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=7F6C0CB4-7A5E-4790-A7CF-9E139E6819C0&displaylang;=en
http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=7F6C0CB4-7A5E-4790-A7CF-9E139E6819C0&displaylang;=en
http://support.microsoft.com/default.aspx?scid=KB;EN-US;Q218180
http://support.microsoft.com/default.aspx?scid=KB;EN-US;Q218180
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IBM SPSS Data Collection Interviewer Server

In IBM® SPSS® Data Collection Interviewer Server, IIS is used by the Accessories, Interviewing,
and Web services. If any of these machines is running Windows 2003 you must install IIS before
installing Interviewer Server.

Installing IIS on machines running Windows 2003 Server

E Install IIS, including the ASP.NET option on Windows 2003 Server, using the installation
instructions provided with the software.

Additional steps for IIS on all 64-bit operating systems

E Open a command prompt and navigate to \Inetpub\AdminScripts. This folder is usually on the C
drive.

E Type cscript.exe adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 "true" and press
Enter.

E From Control Panel, select:
Administrative Tools > Internet Information Services

E In Web Service Extensions, select ASP.NET v2.0.50727 (32-bit) and set it to Allowed.

E In Web Service Extensions, select All Unknown ISAPI Extensions and set it to Allowed.

E Close Internet Information Services.

Installing ASP.NET manually

Use the following steps if you need to install ASP.NET manually on a 64-bit system.

E Open a command prompt and navigate to C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727.

E Type aspnet_regiis.exe /i and press Enter.

Note: ASP.NET v2.0.50727 is for 64-bit systems only, and ASP.NET v2.0.50727 (32-bit) is for
32-bit systems.

Notes on WebDAV

Web-based Distributed Authoring and Versioning (WebDAV) is a collection of extensions that
allow users to edit and manage files on remote servers. If you do not need WebDAV enabled on
your server, ensure that you either disable it, or disallow unneeded HTTP methods (verbs) (due to
potential security issues). WebDAV can be disabled via the Internet Information Services (IIS)
Manager. By default, the WebDAV service is disabled on the version of IIS deployed with IBM®
SPSS® Data Collection products.

If WebDAV is required on your server, use a tool UrlScan security tool to disallow the
unneeded HTTP methods (verbs). Refer the Microsoft TechNet article UrlScan Security Tool
(http://technet.microsoft.com/en-us/security/cc242650.aspx) for more information.

http://technet.microsoft.com/en-us/security/cc242650.aspx
http://technet.microsoft.com/en-us/security/cc242650.aspx
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Configuring Internet Information Services to avoid the detection of hidden directories

Web-based applications will sometimes inadvertently expose a site’s directory structure. Although
the exposed directories do not list their contents, the exposed directory information is detrimental
to the site’s overall security. By knowing a directories name, a potential hacker can guess its
content and possible file names that reside within. Sensitive content can pose a severe security
threat when directory names are exposed.

To avoid this potential security risk, you can issue 404 - Not Found response status codes instead of
403 - Forbidden response status codes. This change will obfuscate the presence of directories on
the site, and will prevent the site structure from being exposed.

You must be a member of the Administrators group on the local computer to perform the following
procedure, or you must be delegated the appropriate authority. As a security best practice, logon to
your computer using an account that is not in the Administrators group, and then use the Windows
Run as command to run the Internet Information Services Manager as an administrator.

E Open a Windows Command Prompt and enter the following:

runas /user:<administrative_accountname> "mmc %systemroot%\system32\inetsrv\iis.msc"

Where <administrative_accountname> is the account name for someone with administrative
authority to the workstation.

E In Internet Information Services Manager, expand the local computer, expand Web Sites,
right-click Default Web Site, and then select Properties.

E Click the Custom Errors tab.

E In the Error Messages for HTTP Errors list, select the HTTP error 403;14, and click Edit Properties.

E Select URL from the Message Type list box.

E Enter the following in the URL field:\spssmr\shared\404-custom.asp.

E Click OK, and then click OK again.

E Exit the Internet Information Services Manager.

E Launch the Windows Registry Editor (type regedit in a Windows Command Prompt).

E Navigate to the following location:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W3SVC\Parameters

Create a new DWORD value named IgnoreAppPoolForCustomErrors and give it a value of 1.

E Open a Windows Command Prompt and enter iisreset.

Installing Microsoft SQL Server

You must have SQL Server installed on all machines.

E To install SQL Server, follow the instructions that come with the application.
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E If you have installed SQL 2005 Developer Edition, enable remote connections as follows:
From the Start menu choose

Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL Server Surface Area
Configuration

This opens the SQL Server 2005 Surface Area Configuration dialog box.
Click Surface Area Configuration for Services and Connections
In the left-hand frame of the next screen, select the View by Instance tab. Expand the node for
the SQL instance that you are using and click Remote Connections.
In the right-hand frame, select Local and remote connections and then Using both TCP/IP and
Named Pipes.
Click OK to save your changes and then close the program.
Stop and restart SQL Server to implement the change.

Installing SQL Server on machines running the database service

You must have SQL Server, including the latest service packs, installed on all machines that will
run the Database Service. If you are going to have more than one machine running the Database
Service they must operate in Active–Passive mode rather than Active–Active mode. Refer to your
SQL documentation for further information about operation modes.
Note: SQL Server 2005 comes in a number of different editions. Since it is only the feature set

that differs across editions, you should be able to use IBM® SPSS® Data Collection Interviewer
Server with any edition, but note that there are limitations on the maximum number of CPUs
supported and on memory.

For more information, see the topic Installing Microsoft SQL Server on p. 12.

Installing Microsoft Office Web Components (OWC)

If you will be using the charting feature, Microsoft Office Web Components (OWC) version
10 or later must be installed on your server. To view charts in IBM® SPSS® Data Collection
Survey Tabulation or IBM® SPSS® Data Collection Survey Reporter, you must also have a
license for Microsoft OWC on each client machine. Before enabling this feature for any user,
you must verify that the user is appropriately licensed for Microsoft OWC. Check your Microsoft
OWC license agreement or EULA.

On machines running the accessories service

Microsoft Office Web Components (OWC) version 10 or later is required for the charting feature
of the Phone Reports activity.
Note: The charting facility is normally disabled in Phone Reports. Before enabling it for

a user, you must verify that the user is appropriately licensed for MS OWC. Check your MS
OWC license agreement or EULA.
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Microsoft OWC can be downloaded directly from Microsoft, but is also installed automatically
with Microsoft Office 2000, XP, and 2003. Microsoft OWC version 9 is installed with Microsoft
Office 2000, version 10 is installed with Office XP, and version 11 is installed with Office 2003.
However, Microsoft has stated there are issues using Microsoft OWC in server configurations
in version 9 and lower. Therefore, it is important to install version 10 or higher. You can install
Microsoft OWC from the Microsoft Download Center.

Microsoft OWC is not supplied with Microsoft Office 2007. For information on the options
available for installing Microsoft OWC version 11 for use with Microsoft Office 2007, see
http://technet2.microsoft.com/Office/en-us/library/0dee24b3-09af-485b-b5ed-d4b879dcc8f61033.mspx?mfr=true.

For further information, see the Microsoft Office XP Web Components Licensing web site
http://www.microsoft.com/office/previous/xp/developer/platform/owcfaq.asp.

Installing Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit)

You must have Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit) installed on all
machines running IBM® SPSS® Data Collection Survey Reporter Server Edition or IBM®
SPSS® Data Collection Author Server Edition. You can download the Microsoft Visual C++ 2008
Redistributable Package (x86 32-bit) directly from the Microsoft download Web site
(http://www.microsoft.com/downloads/details.aspx?familyid=9b2da534-3e03-4391-8a4d-074b9f2bc1bf&displaylang

http://technet2.microsoft.com/Office/en-us/library/0dee24b3-09af-485b-b5ed-d4b879dcc8f61033.mspx?mfr=true
http://www.microsoft.com/office/previous/xp/developer/platform/owcfaq.asp
http://www.microsoft.com/downloads/details.aspx?familyid=9b2da534-3e03-4391-8a4d-074b9f2bc1bf&displaylang;=en
http://www.microsoft.com/downloads/details.aspx?familyid=9b2da534-3e03-4391-8a4d-074b9f2bc1bf&displaylang;=en
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The IBM SPSS Data Collection Server installation procedure installs IBM® SPSS® Data
Collection Interviewer Server, optionally with IBM® SPSS® Data Collection Web Interviews,
onto a single machine or onto a cluster of machines. The installation procedure for single
machines and clusters is completely configurable at all stages.

Work systematically through the topics in the following sections to install Interviewer Server.
Depending on how your system is set up, you may find that some topics are not relevant to you
and can be skipped.

Pre-installation checklist for the IBM SPSS Data Collection Interviewer Server installation
procedure
Installation procedures
Post-installation checklist for IBM SPSS Data Collection Interviewer Server installation

Installation checklist

Click here to display an installation checklist showing all the pre-installation, installation, and
post-installation tasks that you may need to carry out. This topic is a simple task list designed for
printing, and does not provide links to the topics in this document.

Upgrade notes

IBM® SPSS® Data Collection Interviewer Server 6 is not compatible with earlier versions
of Interviewer Server\mrInterview, so it is essential that you upgrade all machines that
are running any of the Interviewer Server services, including all machines running the
Scriptwriter Service. If you have machines running Professional\mrStudio with the Interview
Scripting option you should also upgrade those machines to use IBM® SPSS® Data
Collection Base Professional 6 to ensure that your interview scripts are compatible with the
version of Interviewer Server you are running.
If you want to use projects from a prior release, you must either enter the project path that
was defined for the prior release during installation (default is C:\Program Files\SPSS
Dimensions\mrInterview\Projects), or manually copy the existing project files to the new
installation location.

© Copyright SPSS Inc. 2000, 2010 15
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Installation checklist

Install Required Software
Microsoft Data Access Components 2.8 (only on machines running the Interview, Accessories and/or
Scriptwriter Services).
Internet Explorer 6.0 or above with the MS XML 4.0 SP3 add-in (on all machines except those running
the Database Service only).
Internet Information Services with the ASP.NET option (only on machines running the Web, Interview,
and/or Accessories Services).

SQL Server (only on machines running the Database Service).

Microsoft Office Web Components (only on machines running the Accessories Service).

Microsoft .NET Framework 3.5 SP1 (only on machines running IBM® SPSS® Data Collection Survey
Reporter Server Edition or IBM® SPSS® Data Collection Author Server Edition).
Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit) (only on machines running Survey
Reporter Server Edition or Author Server Edition).

Pre-Installation Tasks
Internet Explorer 6.0 or above with the MS XML 4.0 SP3 add-in installed on all machines (except
those running the Database Service only).

Each machine in a cluster can communicate with all other machines in the cluster.

DCOM is enabled on all machines.

SQL Server is running correctly on all machines that will host the Database Service.

IIS is running correctly on all machines that will host the Web, Interview, and/or Accessories Services.

Create the Installing User on all machines (remember that this user requires ‘Log on as a service’
and ‘Log on as a batch job’ security settings).

Create the Running User on all machines. Optional.

Create the Anonymous Access User on all machines.

Create the Data Collection User Group on all machines.

If any machines are behind a firewall, open ports on the firewall.

Make a back-up or image of all machines on which you will be installing IBM® SPSS® Data
Collection Interviewer Server software.

Installation

Log in as the Installing User and install Interviewer Server.

For cluster installations, install Interviewer Server on all machines named in the site preparation file.
Install the Scriptwriter Service on any scriptwriter machines that do not have browser access to IBM®
SPSS® Data Collection Interviewer Server Administration.

Post-Installation
On all machines running the Web Service, if the image cache is installed on a machine with only the
Web Service installed and that machine is outside the firewall, configure the image cache as remote.
Set up users and roles in Interviewer Server Administration and assign roles to Interviewer Server
Administration applications.
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On all machines running the Accessories Service, if a machine is running Windows XP Service Pack 3,
add the ASPNET account to the Launch permissions on LogBck02.
If you have installed onto a machine on which IBM® SPSS® Data Collection Base Professional is
installed, add Base Professional users to the IBM® SPSS® Data Collection group on that machine
so that they have access to the log file folder.
On all machines running the Web Service, if that machine has multiple IP addresses and web sites
configured for each IP address, replace the Web Service machine names with IP addresses in DPM
and reregister the Interview Service machines.
If machines running the Web Service will be accessed through the internet, replace the machine names
in the DimensionsInterviewURL and FileManagerWebserviceURL properties with fully qualified
machine names.
On all machines running the Interviewing Service, if your site uses SSL, cancel the requirement for
mrIEngWS to use a secure channel.
On all machines running the Interviewing Service, start mrUserAdminServer and mrDPMServer3 if
they are not already running.

Check that access control permissions have been set correctly for FMRoot and all its subfolders.

If using an IBM® SPSS® Data Collection Dialer, license the Dialer via the License Authorization
Wizard. Run the License Authorization Wizard from Start > All Programs > IBM SPSS Data Collection 6
> License Authorization Wizard.
Note: When licensing Dialer in a Windows Server 2003 or 2008 (x64 64-bit edition) environment,
you must locally login to the server before attempting to license Dialer. If you attempt to login to
a domain and then license Dialer, you will not be able to work with CATI projects in the Phone
Participants activity.

Post-Installation on Local Machines

Enable pop-ups and file downloads.

Set up automatic NT login for Interviewer Server Administration users who use the Firefox browser.

For users who will run Interviewer Server Administration using the Firefox browser on the WYSE
5150SE, increase the default font size in Firefox.

Optional Post-Installation
If you are upgrading from an earlier version of Interviewer Server\mrInterview, delete the Signal
call outcome code from DPM.
On machines running the Database Service, add indexes to any existing sample tables to improve
performance
If your site uses telephone interviewing (CATI), increase the size of the appRequestQueueLimit setting
for the .NET Framework on all machines running the Web Service.
If your site uses telephone interviewing, change the configuration settings for the interviewing engine
and the .NET Framework on all machines running the Interview Service to avoid requests being
queued due to blocked thread pools.
Install the IBM® SPSS® Data Collection Load Tool on a machine of your choice, preferably one
outside the Interviewer Server cluster.

Configure the Interviewer Server Administration Email activity if not already done during installation.

On machines running the Interviewing or Accessories Services, increase the number and/or size of
the log files.
If necessary, create a hosts file linking machine names to IP addresses (may be needed for some
firewalls).
Set up your Web site to use SSL.

On machines running the Accessories Service, set up Interviewer Server Administration load balancing
to specify the machines on which Interviewer Server and its applications will run.



18

Chapter 3

Configure Interviewer Server Administration load balancing to use an SSL accelerator.

On all machines running the Interviewing Service, change the Interview Engine load balancing
algorithm used to distribute interviews to those machines.

Modify the TCP/IP registry settings on all machines running the Interview and Web Services.

If you are using SQL Server 2005 and a named instance, edit SampleMgtGUI.Config.xml to control the
servers available to the Participants and Activate activities.
If you are upgrading from a previous version of IBM SPSS Data Collection Server, and you want to
query your old log files (from the Manage Logs activity for example), copy the old logs from the
previous version’s log directory to the new IBM SPSS Data Collection Server 6 log location (by
default, [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server Administration\Logs).

Install the IBM® SPSS® Data Collection Developer Library on the appropriate machines.

IBM SPSS Data Collection Interviewer Server system configurations
IBM® SPSS® Data Collection Interviewer Server has the following services:

Web Service. Interacts with respondents through their browsers.
Interview Service. Runs the majority of the interviewing and Project Management software,
including the IBM® SPSS® Data Collection Data Model. If you install this service on a
number of machines in a cluster, the installation procedure makes the first machine hosting
the service the Primary Interviewer Server and the second machine the Secondary Interviewer
Server.
Accessories Service. Hosts Internet Information Server (IIS) and stores IBM® SPSS® Data
Collection Interviewer Server Administration and all Interviewer Server Administration
and Interviewer Server activities.
Database Service. Runs SQL Server and stores the response data. May also store the sample
and quota databases. The Interviewer Server installation procedure does not install anything
on machines running just this service.
Scriptwriter Service. Installed on a client machine. Includes the Data Model and Activate
components. The Scriptwriter Service is typically used by scriptwriters who do not have
access to Interviewer Server Administration via their browsers.

Depending on the size of your installation, you may install several services all on one machine, or
install each service on a different machine, or install the same service on a number of machines.

Note: If you install onto more than one machine (known as a “cluster installation”) you must
install onto machines running the Accessories Service first. Follow this with machines running the
Interview and Web Services in that order. Finally, install the Scriptwriter Service where necessary.

Very small sites may use a single machine for all functions, and you will install the Scriptwriter
Service, Web Service, Interview Service, Accessories Service, and Microsoft SQL Server all on
that machine. Larger sites may wish to use this type of set-up for testing purposes, while setting
up their main system using several machines. If this is the type of installation that you require,
you may prefer to use the Standard installation procedure.

Larger sites may have a database machine running SQL Server, and a Web and interview machine
running IIS, the Web Service, Interview Service, and Accessories Service.
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Very large sites will probably have separate machines for each service except the Accessories
Service. This will be installed on the machine running the Interview Service.

Generally, scriptwriters access the activities they require by connecting to Interviewer Server
Administration via their browsers. If your site has scriptwriters who work off-line and do not
always have access to Interviewer Server Administration, you can install the Scriptwriter
Service on those machines, and the scriptwriters will be able to create, compile, and activate
questionnaires using desktop activities.

Interviewer Server is flexible with regard to how the various machines are set up. It allows all
machines to be in the same domain or workgroup, or you can have the database server in one
domain with the machines running the other services in another domain.

Note: If you use more than one domain, the domains must trust one another. It is important that
you consider carefully how your site will be configured before starting to install Interviewer
Server, so that you install the correct services on each machine.

Installations using disk imaging or terminal services

With the exception of the Operating System and Microsoft subcomponents, disk imaging
installation techniques (such as those accomplished with Symantec’s Ghost or PowerQuest’s Drive
Image) cannot be used for IBM® SPSS® Data Collection Interviewer Server servers. Interviewer
Server has distinct configuration information on a per server basis, so imaging a server after
installing Interviewer Server is not a viable option for multiple-server installations.

Interviewer Server cannot be installed using terminal services such as Citrix remote administration
because, unless XP terminal services are used, the user that is logged on does not have rights to
launch services as the interactive user. Interviewer Server can, however, be installed remotely
using a program such as Remote Desktop.

Installations onto a domain controller

Installing IBM® SPSS® Data Collection Interviewer Server onto a domain controller is not
recommended. There are known issues with .NET running on domain controllers and there may
be an additional security risk if IIS runs on a domain controller that is accessible from the internet.

If there is no choice but to install onto a domain controller, you must take the following steps.

E If you are installing onto a domain controller, and the scriptwriters who will be using the client
installation are located in another domain, refer to Installation procedures for further information.

Installing from a downloaded file

You must run the installer as administrator:

E Using Windows Explorer, browse to folder where you downloaded the file.

E Right-click the downloaded file and choose Run as Administrator.
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E Follow the instructions that appear on the screen. See Post-installation checklist for IBM SPSS
Data Collection Interviewer Server installation for any special instructions.

Pre-installation checklist for the IBM SPSS Data Collection Interviewer
Server installation procedure

Before you install IBM® SPSS® Data Collection Interviewer Server you should check that
any software required by Interviewer Server is installed and running. If the Interviewer Server
installation procedure is unable to find an application, or that application is not running correctly,
the Interviewer Server installation procedure will fail.

Check that Internet Explorer 6.0 or above is installed on all machines.
Check that each machine in a cluster can communicate with all other machines in the cluster.
Check that DCOM is enabled on all machines.
Check that SQL Server is running correctly on all machines that will host the Database Service.
Check that IIS is running correctly on all machines that will host the Web, Interview, and/or
the Accessories Service.
Create a user for installing Interviewer Server. This user will be referred to as the Installing
User in the rest of this document.
Optionally, create a user for running the Interviewer Server services. This user will be referred
to as the Running User in the rest of this document. You can use the Installing User as the
Running User if you wish.
Create a user that can be used for anonymous IIS access to Interviewer Server applications.
This user will be referred to as the Anonymous Access User in the rest of this document.
Create a group for Interviewer Server users. This group will be referred to as the IBM®
SPSS® Data Collection Group in the rest of this document.
Check that Everyone has full permissions to the \InetPub\wwwroot folder.
If any machines that will be running Interviewer Server services are behind a firewall, you
may need to open ports on the firewall so that Interviewer Server can function correctly.

Note: When implementing a cluster in a Windows Server 2008 environment, you must ensure
that TCP port 65100 is open via the Windows firewall. Refer to you Windows Server 2008
documentation for information on opening ports.

Make an image or back-up of all machines on which Interviewer Server software will be
installed before you run the installation program.

Checking that Internet Explorer 6.0 or above is installed

IBM® SPSS® Data Collection Interviewer Server cannot be installed unless the machine(s) on
which it is being installed are running Internet Explorer 6.0 or above. To check which version
of Internet Explorer is installed, simply start the application. The splash screen reports the
version number.
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Checking that machines in a cluster can communicate with each other

Each machine in a cluster must be able to communicate with all the other machines in the same
cluster. The easiest way to verify this is to use ping. This program sends a short stream of data
from one machine to another and waits for the receiving machine to return the data.

E On each machine in turn, open a DOS window and type ping machine_namewheremachine_name
is the name of one of the machines in the cluster.

If the machines can communicate, you will see several lines starting ‘Reply from’ appear on your
screen as the pinged machine returns the signal. If the machines cannot communicate you will see
the message ‘Request timed out’.

E Repeat this step for each other machine in the cluster.

Checking that DCOM is enabled

Carry out the following steps to check that DCOM is enabled.

E From the Windows Start menu, choose Run.

E Type dcomcnfg in the text box and click OK.

This opens the Component Services window.

E In the left-hand frame, expand Component Services and then Computers.

E Right-click My Computer and choose Properties.

This opens the My Computer Properties dialog box.

E On the Default Properties tab, check that Enable Distributed COM on this computer is selected.

E Click OK.

Checking that SQL Server is running correctly

The machines running the Interview Service need to be able to connect to the Database server.
You can test that these connections work by creating a test DSN on each of the Interviewing
machines in turn.
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E Open Control Panel and choose:
Administrative Tools > Data Sources (ODBC)

This opens the ODBC Data Source Administrator dialog box.

E On the System DSN tab, click Add.

This opens the Create New Data Source dialog box.

E Choose SQL Server and then click Finish.

This opens the Create a New Data Source to SQL Server dialog box.

E In Name, type a name for the test DSN.

E In Server, select the name of the IBM® SPSS® Data Collection Interviewer Server database server.

E Click Next.

E On the next two screens, just click Next.

E On the following screen, click Finish.

This opens the ODBC Microsoft Server Setup dialog box.

E Click Test Data Source.

The system checks that it can access the database using the DSN you have just created, and
displays the results of the test. Normally the test will be successful, so click OK. If the test is not
successful, you should make a note of any messages the system has displayed and then try to
resolve the problem before trying to create a test DSN again.

E Return to the ODBC Data Source Administrator dialog box. Select the test DSN you have just
created and click Remove. Confirm your request when prompted to do so.

Checking that IIS is running correctly

Note: This is required on all machines that will host the Web, Interview, and/or the Accessories
Service. IIS is not required on machines running just the Interview Service.

E In Internet Explorer, type http://machine_name, where machine_name is the name of your local
machine.

As long as your browser does not issue the message “Cannot find server or DNS Error” then
IIS is running.

Creating the installing and running users

IBM® SPSS® Data Collection Interviewer Server must be installed by a user with local
administrative rights. This user must have SQL DB Creator permission on the Database server
while the installation is running, in order to create or update the main Interviewer Server
databases. Once the installation is finished you may remove this right.
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The Interviewer Server servers and services must be run by a user with the same rights as the
Installing User, but this user must also have the ‘Log on as a service’ and ‘Log on as a batch job’
options set. This user does not require SQL DB Creator rights.

Although you can use the same user account for both the Installing and the Running User, we
recommend creating a new user account on each server that is used specifically for running
Interviewer Server. This maintains any existing security that you have in place and ensures that
there will be no problems if the local administrator password is changed.

If you are installing on machines within a workgroup, you must create the Installing and Running
Users on all machines in the workgroup that will run Interviewer Server services. The user and
group names should match exactly across all machines as some operating systems can be case
sensitive. If you are installing Interviewer Server on machines within a domain, you should create
the accounts for the Installing and Running Users as domain accounts and then give those accounts
the appropriate local access on each of the servers on which Interviewer Server will be installed.

Note: If you are using machines in different domains, the Installing and Running Users must be
visible and trusted in all those domains. Both Users must also have permission to create databases
on the machine hosting the Database Service.

Creating the installing and running users and set the log on options (single machine installations)

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, right-click Users and choose New User.

This opens the New User dialog box.

E Enter the details for the Installing User and click Create and then Close.

Note: Do not give the user a password that contains single or double quotation marks or a
backslash as this will cause the application installation to fail.

E In the Tree frame, click Groups.

E In the right-hand frame, right-click Administrators and choose Add to Group.

This opens the Administrator Properties dialog box.

E Click Add.

This opens the Users or Groups dialog box.

E In the list of names, choose the user name you have just created and click Add.

E Click OK to close the Users or Groups dialog box.

E Close the Computer Management window.

E Open Control Panel and choose:
Administrative Tools > Local Security Policy
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This opens the Local Security Settings window.

E In the Tree frame, expand Local Policies and click User Rights Assignment.

E In the right-hand frame, double-click Log on as a service. This allows the user to run services.

This opens the Log on as a service Properties dialog box.

E Click Add.

E In the list of names, choose the user name you created earlier and then click Add.

E Click OK to close the Select Users or Groups dialog box.

E Click OK again to return to the Local Security Settings window.

E In the right-hand frame, double-click Log on as a batch job. This allows the user to run a service
that itself starts another application or service.

This opens the Log on as a batch job Properties dialog box.

E Click Add.

E In the list of names, choose the user name you created earlier and then click Add.

E Click OK to close the Select Users or Groups dialog box.

E Click OK again to return to the Local Security Settings window.

E Close the Local Security Settings window.

E Open your SQL administration program and grant the Installing UserSYSADMIN authority. For
example, if you have SQL Enterprise Manager, or SQL Server Management Studio, the steps
will be as follows:

From the Windows Start menu choose:
Programs > Microsoft SQL Server > Enterprise Manager or SQL Server Management Studio

Expand the tree in the left-hand frame until the contents of the Security node are visible for
the Interviewer Server Database server, and select Server Roles.
In the right-hand frame, double-click System Administrators or sysadmin.
This opens the Server Role Properties dialog box.
Click Add.
In the list of names, choose the user name you created earlier and then click OK.
Click OK to close the Server Role Properties dialog box and then close Enterprise
Manager/SQL Server Management Studio.

E Repeat these steps, except the one to add SYSADMIN authority in SQL, to create the Running
User account.
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Creating the installing and running users (domain installations)

E Create new domain accounts for the Installing and Running Users.

Note: If the domain uses case sensitive SQL, you must create the Running User with the Full name
and Logon name in the same case.

E Add the domain accounts for the Installing and Running Users to the local Administrator group on
each machine that will be running the Web, Interviewing, or Accessories Services. This is not
necessary on machines that will be running only the Database Service.

E Follow the procedure documented for single machine installations to set the local security policy
for these users.

Creating the anonymous access user

Many of the IBM® SPSS® Data Collection Interviewer Server applications must be run using
the Anonymous IIS User account rather than the account of the user who started the application.
The Anonymous User account is also required for accessing the Interviewer Server databases on
the database server. We recommend that you create a new user specifically for this purpose. The
Anonymous Access User must be a member of the group that you create for IBM® SPSS® Data
Collection users. It must also have the same privileges as the local ASPNet account.

If you are installing Interviewer Server on machines within a domain, you should create the
account for the Anonymous Access User as a domain account and then give that account the
appropriate local access on each of the servers on which Interviewer Server will be installed

The steps below explain how to set up an anonymous access user account. There is no need to
make the suggested changes to the machine.config file.

Notes

When installing in a Windows Server 2003 environment,
refer to http://msdn2.microsoft.com/en-us/library/Aa302396
(http://msdn2.microsoft.com/en-us/library/Aa302396) for information on setting up the
account with the necessary privileges.
When installing in a Windows Server 2008 environment, use the following steps for setting up
the account with the necessary privileges:
1. Open Computer Management from the Windows Control Panel (Start > Control Panel >
Administrative Tools > Computer Management) and navigate to Local Users and Groups > Groups.
2. Add the account specified for the application pool identity to the IIS_IUSRS group.
3. Close the Computer Management dialog.

Creating the anonymous access user

For single machine and workgroup installations:

E Open Control Panel and choose:
Administrative Tools > Computer Management

http://msdn2.microsoft.com/en-us/library/Aa302396
http://msdn2.microsoft.com/en-us/library/Aa302396
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This opens the Computer Management window.

E Expand Local Users and Groups, right-click Users and choose New User.

This opens the New User dialog box.

E Enter the user’s details and click Create and then Close.

For domain installations:

E Create a new domain account for the Anonymous User.

Note: If the domain uses case sensitive SQL, you must create the Anonymous Access User with
the Full name and Logon name in the same case.

Creating the IBM SPSS Data Collection user group

The Installing User, the Anonymous Access User and all scriptwriters must belong to a single
group. This ensures that these users will have access to the IBM® SPSS® Data Collection
Interviewer Server components and that Interviewer Server will function correctly. If you do not
have a suitable group already set up, you must create a new group before you install Interviewer
Server.

The notes that follow describe the process for single machine installations. The procedure
for workgroup and domain installations is similar. If you are installing Interviewer Server on
machines within a workgroup, you must create the IBM® SPSS® Data Collection user group on
all machines in the workgroup that will run Data Collection applications. If you are installing
Interviewer Server on machines within a domain, you should create the Data Collection user
group as a domain global group, unless you have two domains in your configuration, in which
case you should create the group as a domain local group. (Note that domain local groups are
supported in native-mode domains only, not in mixed-mode domains.)

Creating a new group (single machine installations)

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, right-click Group and choose New Group.

This opens the New group dialog box.

E Enter a name and description for the group and click Add.

This opens the Select Users or Groups dialog box.
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E Choose the users who will be part of the group and click Add.

Note: You must add the Installing User, the Running User and the Anonymous Access User to
this group.

E Click OK to close the Select Users or Groups dialog box.

E Click Create and then Close.

Giving everyone full permissions on \InetPub\wwwroot

The installation program requires that Everyone has full permissions on the \InetPub\wwwroot
folder, and will fail if incorrect permissions are set. If necessary, set the appropriate permissions
before installing IBM® SPSS® Data Collection Interviewer Server and then change them back
again once the installation is complete.

E Navigate to \InetPub, right-click wwwroot and select Properties.

E On the wwwroot Properties dialog box, select the Security tab.

E In “Group or user names” select Everyone and ensure that Full control is allowed in the Permissions
frame. If Everyone does not appear in the list, add it and set the appropriate permission.

Preparing to run IBM SPSS Data Collection Interviewer Server through a firewall

If you will be running IBM® SPSS® Data Collection Interviewer Server through a firewall certain
ports on the firewall must be open.

Firewall between the Internet and the web server

All communication between the browser and the Interviewer Server Web Server (mrIWeb) and
between the browser and the Accessories server defaults to using HTTP on port 80. If your web
site runs SSL or uses a different port number, you can specify this on the Internet Information
Services (IIS) Configuration page during the installation procedure.

Firewall between the web server and the accessories server

When the Web Server needs to communicate with the Accessories server in order to access the
image cache, and there is a firewall between the two machines, communication normally takes
place using HTTP over port 80. The firewall must allow traffic in both directions on this port.
If your web site runs SSL or uses a different port number, you can specify this on the Internet
Information Services (IIS) Configuration page during the installation procedure.

Firewall between the web server and the interviewing server

Communication between the Web Server (mrIWeb) and the Interviewer Server (mrIEng) usually
takes place using SOAP over port 80. If your web site runs SSL or uses a different port number,
you can specify this on the Internet Information Services (IIS) Configuration page during the
installation procedure.
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Firewall between the IBM SPSS Data Collection Interviewer Server/Accessories server and the
data server

Communication between the Interviewer Server/Accessories server and the data server takes
place using TCP on port 1433. This port must be opened before the installation begins, as the
installation process writes to the data server.
If you have SQL running on a named instance, then the port number is dynamically assigned

and could be something other than 1433. If you know which port number is being used, you
should open this port rather than port 1433. If you do not know which port is being
used (and for more information about named SQL instances in general) refer to
http://groups.google.nl/groups?q=connecting+to+second+SQL+instance+through+firewall&hl=nl&lr=&selm=uGvO
(http://groups.google.nl/groups?q=connecting+to+second+SQL+instance+through+firewall&hl=nl&lr=&selm=u

Firewall between the DPM servers in the cluster

Communication between DPM servers in a cluster takes place using TCP on port 65100.

Note: When implementing a cluster in a Windows Server 2008 environment, you must ensure
that TCP port 65100 is open via the Windows firewall. Refer to you Windows Server 2008
documentation for information on opening ports.

Ports used by IBM SPSS Data Collection products

Default
TCP/UDP
Ports

Product\Service Notes

80 (HTTP)
443
(HTTPS)

All Web Services (Interviewer Server
Web Server, Accessories Server)

If your web site
runs SSL or uses a
different port number,
you can specify
this on the Internet
Information Services
(IIS) Configuration
page during the
installation procedure.

1433 SQL Server (Data Server) If you have SQL
running on a named
instance, then the port
number is dynamically
assigned and could be
something other than
1433.

5080 IBM® SPSS® Data Collection Base
Professional(for debugging survey
scripts)

http://groups.google.nl/groups?q=connecting%2Bto%2Bsecond%2BSQL%2Binstance%2Bthrough%2Bfirewall&hl;=nl&lr;=&selm;=uGvOuCRGEHA.1988%40cpmsftngxa06.phx.gbl&rnum;=1
http://groups.google.nl/groups?q=connecting%2Bto%2Bsecond%2BSQL%2Binstance%2Bthrough%2Bfirewall&hl;=nl&lr;=&selm;=uGvOuCRGEHA.1988%40cpmsftngxa06.phx.gbl&rnum;=1
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Default
TCP/UDP
Ports

Product\Service Notes

7000 IBM® SPSS® Data Collection Dialer Refer to your Dialer
documentation for
instructions on
changing the default
port.

65100 .NET Remoting for Scriptwriter
Services/DPM Servers

If you want to use a
different port, you may
set it in the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS
\MRPropertyManagement\2.0\
Remoting\PortNo.

Note: When
implementing a cluster
in a Windows Server
2008 environment,
you must ensure that
TCP port 65100 is
open via the Windows
firewall. Refer to you
Windows Server 2008
documentation for
information on opening
ports.

Ports needed for domains

The following ports must be open in order to establish a domain trust or secure channel across
a firewall. If there are hosts that have both client and server roles on both sides of the firewall,
you may need to mirror these rules.

Note: These lists were obtained from the Microsoft document How to Configure a Firewall for
Domains and Trusts (Q179442) and have not been tested.

On Windows, the following ports must be open.

Client Port(s) Server Port Service
1024-65535/TCP 135/TCP RPC. Note: There are

specific requirements for RPC
communications beyond what is
listed in the table. For additional
information about configuring
RPC communication for a
firewall, refer to the Microsoft
article Configuring RPC Dynamic
Port Allocation to Work With a
Firewall.

137/UDP 137/UDP NetBIOS Name
138/UDP 138/UDP NetBIOS Netlogon and Browsing
1024-65535/TCP 139/TCP NetBIOS Session
1024-65535/TCP 42/TCP WINS Replication
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Backing up your system

It is recommended that you back up or make images of all machines on which you will be installing
IBM® SPSS® Data Collection Interviewer Server software before you run the installation
program. This ensures that you will be able to go back to your current setup should anything go
wrong. It also means that it will be easier to add extra machines into the cluster at a later date.

Installation procedures
The installation procedure varies depending on whether you are installing IBM® SPSS® Data
Collection Interviewer Server on a single machine or on more than one machine.

Single machine installation. When you want to install all of the services onto a single machine, you
install from the DVD-ROM. Note that the Database Service can be located either on the same
machine as Interviewer Server or on a central server.

Multiple machine installation. A typical installation consists of the following steps:
First, you log in on the Primary DPM server and run the installation from the DVD-ROM
to create a site preparation file that names the machines on which the various services will
be installed, and to set up a central installation folder on the server that can be used by other
machines in the cluster. When the installation program finishes, you need to share this folder
manually.
Then, for each of the machines named in the site preparation file, you run the installation from
the central installation directory. During these installations, most of the dialog boxes are
completed automatically using the information in the site preparation file.
Finally, you use the client installation on the DVD-ROM to install the Scriptwriter Service
onto machines that are not named in the site preparation file.

The installation procedure supports the following configurations:
All servers and scriptwriter machines in one domain
The installation procedure uses Domain\Running User, Domain\Anonymous User, and
Domain\IBM® SPSS® Data Collection Group to set up the Interviewer Server services and
the database access group.
All servers and scriptwriter machines in one workgroup
The Running and Anonymous Access users and the Data Collection group that you choose
during the installation must exist on all servers (including the database server) and scriptwriter
machines in the workgroup. The installation procedure uses LocalMachineName\Running
User, LocalMachineName\Anonymous User, and LocalMachineName\Data Collection Group
to set up the Interviewer Server services, and DBMachineName\Data Collection Group to
set up the database access group.
All servers except the database server in one domain and the database server in another domain
Domains must trust one another (that is, be bidirectional), so the users and group that you
choose during the installation will be visible in both domains. The installation procedure uses
Domain\Running User, Domain\Anonymous User, and Domain\Data Collection Group to set
up the Interviewer Server services.
All servers in one domain and all scriptwriter machines in another domain, or domain controller
installations with two domains
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The domains must have a two-way trust or the server domain must trust the scriptwriter
domain. The group that you choose during the installation procedure must exist on the
server’s domain, and must be created as a domain local group, not as the default global
security group. The users from both domains must be added as members of this domain
local group. Domain local groups are supported in a native-mode domain only, not in a
mixed-mode domain. The installation procedure treats this type of installation like one or
other of the previous domain-based installations.
All servers in a workgroup and scriptwriter machines in a domain
The Running and Anonymous Users and Data Collection Group must exist on all servers in
the workgroup, and the scriptwriter domain user must be synchronized as a local user on
the workgroup servers. The scriptwriter user must be added to the Data Collection Group
on the servers. The installation procedure uses LocalMachineName\Running User and
LocalMachineName\Data Collection Group to set up the Interviewer Server services, and
DBMachineName\Data Collection Group to set up the database access group.

Installation flowchart

This flowchart provides an overview of the questions you will be asked during the installation.
Each box in the flowchart corresponds to a dialog box that is displayed by the installation program.



32

Chapter 3

Figure 3-1
Installation Flowchart
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Single machine installation
E Log on as the Installing User.

E Insert the DVD-ROM into the DVD-ROM drive.

Depending on your system configuration, the AutoPlay feature may detect and start the installation
program when you insert the DVD-ROM into the drive. If this does not happen, you can start
the installation program manually, as follows:

From the Windows Start menu, choose Run.
In the Run dialog box, type d:\autoplay where d:\ is the DVD-ROM drive.

This opens the IBM SPSS Data Collection Server 6 Installer window.

E From the IBM SPSS Data Collection Server 6 Installer window, choose Install IBM SPSS Data
Collection Server 6.

This starts the IBM SPSS Data Collection Server 6 Setup wizard.

E Click Next on the Welcome screen.

E On the License Agreement screen, read the license agreement.

E If you accept the agreement, click Yes.

E On the Select Features page, select the IBM® SPSS® Data Collection Interviewer Server option
and choose the appropriate services and utilities to be installed. Possible Interviewer Server
options are as follows:

Accessories Service. Installs the Accessories Service, including IBM® SPSS® Data
Collection Interviewer Server Administration.
Interview Service. Installs the Interview Service.
Web Service. Installs the Web Service.
Load Tool. Installs the IBM® SPSS® Data Collection Load Tool utility.

Note: The services and utilities listed above are for use with the Interviewer Server. You can also
choose to install other IBM SPSS Data Collection Server applications.

Starting with the IBM® SPSS® Data Collection 6 release, all application names have changed.
The application names map as follows:

Old Application Name New Application Name
Interviewer Server\mrInterview Interviewer Server
Interviewer\Interview Player Phone Phone Interviews
Interviewer\Interview Player Web Web Interviews
Remote Manager Remote Administration
Web Reports for Surveys\mrTables Survey Tabulation
Reports for Surveys\Reporter Survey Reporter Server Edition
Reports for Surveys Components\Dimensions
Component Pack

SPSS Survey Reporter Developer Kit

N/A Author Server Edition
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E On the Machine Configuration page, choose Single Machine Install.

E On the Machine Settings page, enter a name for your IBM® SPSS® Data Collection site and click
Next. The site name that you choose is displayed on the main Interviewer Server Administration
page and can be any name of your choice.

E On the User and Group page, enter information about the user and group that should be used
for running the Interviewer Server services.

For each account, click Domain if it is a domain account and enter the domain name in the box. If
the account is a workgroup account, click Workgroup.

In the Username, Password and Group boxes, enter the name and password of the Running User
and the name of the Data Collection Group. Click Next after entering the appropriate information.

Note: The names that you enter must be valid names for the domain or workgroup on which
you will be installing.

E On the Anonymous User page, enter the name and password of the Anonymous Access User that
you created. Click Domain if this is a domain user account orWorkgroup if this is a workgroup user
account. Click Next after entering the appropriate information.

E On the Database Setup page, enter the name of the database server on which you want to create
the Interviewer Server Data database and click Next.

E On the DPM User Admin Details page, enter a name and password for the Interviewer Server
Administration Administrator. You can also select whether or not to enable integrated Windows
login. Refer to the topic “Configuring for Single Sign-on” in the IBM® SPSS® Data Collection
Developer Library 6 for more information on integrated Windows login.

Note: This user name is simply for accessing the Distributed Property Management (DPM)
database to perform administrative tasks such as setting up Interviewer Server Administration
users and roles, and managing access to Interviewer Server Administration files and applications.
It exists only in DPM. To avoid possible conflicts with other user names, the name that you choose
should not match any existing NT user names on your system.

E On the Email Settings page, enter the name and port number of your Email SMTP server.
Alternatively, if you do not want to use the Email activity or do not have the required information
at hand, click I want to configure my email settings later. In either case, click Next to move to
the next page.

E On the Internet Information Services (IIS) Configuration screen, the installation program detects
any web sites available on the installation machine and displays them in the drop-down list box.
If you want to use a Web site other than the default for your SPSS Inc. applications, select
it from the drop-down list.

The default file location for the web site you have selected is displayed. If the installation program
detects a folder called SPSSMR within the web site folder structure, you are prompted to install
the files in this folder instead. If you want to install the files to a different location, click Browse
and choose the folder you want to use.
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Note: When selecting a non-default web site location on a 64-bit server, you cannot select a web
files location under C:\Program Files in the Internet Information Services (IIS) Configuration
dialog. For example, if you defined a non-default web site named myWebSite, and its local path
is C:\Program Files\myWebSite, you must select a web files location that is not located under
C:\Program Files when you select myWebSite for the Data Collection folders and applications
(you can instead select the location C:\Program Files (x86)).

The Advanced button is available for advanced configuration of your chosen web site. This allows
you to place Interviewer Server Administration in its own application pool so each process can be
split across multiple application pools The operating system places a 2 GB restriction on processes
in IIS. Put simply, splitting a process across application pools means it is possible to run larger
processes. Refer to your IIS documentation for general information about application pools. If
you want to use application pools, proceed as follows:

Click Advanced.
This opens the Advanced IIS Configuration screen.
To place Interviewer Server Administration in its own application pool, select Use
“SPSSDimensionNetPool” application pool. If you want processes to recycle and/or shut down
after specific number of minutes, select the appropriate option and enter the number of minutes
elapse time required. Selecting this option means that if the Interviewer Server Administration
process is recycled or shut down, anyone using Interviewer Server Administration activities at
that time will have to restart their session in order to continue working.
To place Interviewer Server in its own application pool, select Use “SPSSmrInterviewPool”
application pool. If you want processes to recycle and/or shut down after so many minutes,
select the appropriate option and enter the number of minutes elapse time required. Selecting
this option means that if the application process is recycled or shut down, anyone using
Interviewer Server activities at that time will have to restart their session in order to continue
working.
Click Apply.

On the Internet Information Services (IIS) Configuration screen, click Next when you are ready to
continue.

Note: If you already installed Interviewer Server, the IIS configuration settings are automatically
inherited, so the Internet Information Services Configuration screen will not appear.

E On the Choose Destination Location page, choose the folder in which you want to install
Interviewer Server. The default is [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\. Click
Next.

E On the File Management Folder page, choose the location of the File Management root folder
(FMRoot). This is the folder in which the master copies of project files created using Interviewer
Server Administration or the Scriptwriter desktop activities will be stored, and it is from here that
the interviewing machines will make local copies of these files.

The File Management root folder must be shared so that it is accessible by other machines. If
you choose a folder on your current machine, the installation procedure will create the share for
you. If you choose a folder with a UNC pathname (that is, one that starts \\machine_name\...) this
will be used as the shared folder. Click Next.
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Note: You can create the File Management root folder on any machine as long as its share is
visible to all machines running the Interviewing and Scriptwriter Services. The ideal location is
a separate machine that acts as a file server rather than a machine running the Interviewing or
Accessories service. This is because the File Management root folder is an integral part of most
Interviewer Server Administration and Interviewer Server functionality, and needs to be available
all the time that Interviewer Server Administration is running. You will need to manually share
the specified UNC directory:

1. Navigate to and select the specified UNC directory.

2. Right-click the directory and select Properties, then select the Sharing tab.

3. Select Share this folder and enter SPSSMR_FMROOT in the Share name field.

4. Click Permissions and select Full control for the Everyone group.

5. Click OK to save your changes.

6. Select the Security tab, add the Interviewer Server group (only if it is not already present), and
select Full control for the Interviewer Server group.

7. Click OK to save your changes.

If you install it on a machine that is running the Interviewing or Accessories service and you
need to restart that machine, Interviewer Server Administration becomes effectively unusable by
anyone on any other machine until the service machine has restarted.

Updating the registry after moving FMROOT

If you change the location of the FMROOT in DPM Explorer post installation, you must also
update the associated registry entries to match the DPM Explorer values. If the environment is a
cluster environment, you must update the registry entries on all clustered accessory servers, IBM®
SPSS® Data Collection Survey Tabulation servers and IBM® SPSS® Data Collection Survey
Reporter servers. The mapping of DPM properties and registry entries is as follows:

DPM Property Registry Entry
FileMgt_RootFolderLocalPath HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\InstallOptions

\FMRoot_Local
and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview \3
\InstallOptions\FMRoot_Local

FileMgt_RootFolderUNC HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet
\InstallOptions \FMRoot_UNC
and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3
\InstallOptions\FMRoot_UNC

E The Choose the location of Interviewer Server Project and Source files page allows
you to specify the folder that you want to create for storing the project and source files
that the Interview Services use for running interviews. When a scriptwriter activates a
project, the activation program copies the questionnaire file and the templates into the
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Projects folder so that they are available for interviewing. The default project folder is
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer. Click Next to continue.

E On the FIPS 140-2 Compliance page, select whether or not the installation will be configured for
FIPS 140-2 compliance. FIPS 140-2 is a U.S. government computer security standard used to
accredit cryptographic modules. Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information.

Note: When configuring for FIPS 140-2 compliance in the Windows Server 2008 environment,
you must first install a Microsoft hotfix. Failure to install the hotfix may result in problems when
using the Interviewer Server Administration User Administration activity. Refer to the Microsoft
support article “FIX: You cannot run an ASP.NET 3.5-based application that uses a ScriptManager
control” (http://support.microsoft.com/kb/981119) for more information.

Configure for FIPS 140-2 Compliance. If your system is already configured to be FIPS 140-2
compliant prior to installation, the installation process will not let you deselect the Configure for
FIPS 140-2 Compliance option. If you no do not want the installed applications to be FIPS 140-2
compliant, you must manually set a Windows System cryptography setting to disabled:

1. From the Windows Control panel, select:
Administrative Tools > Local Security Policy > Local Policies (located in the left panel) > Security
Options (located in the left panel) > System cryptography: Use FIPS compliant algorithms... (located
in the right panel)

2. Double-click the System cryptography: Use FIPS compliant algorithms... policy and select Disabled.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not
Configure for FIPS 140-2 Compliance is enabled; for upgrade installations, the following
rules apply:

If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded
in the following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup
log file. The log file is located at: C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\\Installer\NewPassword.logInterviewer Server
Administration administrators can supply users these new, temporary passwords in a manner
that is in accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change
their passwords at next login.
When upgrading on a server that is currently not configured for FIPS 140-2, you are presented
with the option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash
function algorithm.
Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the
SHA-1 hash function algorithm will continue to be employed.

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
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– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the
parameters outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information
regarding FIPS 140-2.

Note: When FIPS 140-2 is configured for IBM SPSS Data Collection products, the applications
adhere to the password protection security protocols that are defined on the Interviewer Server.
For example, if the Interviewer Server is configured for MD5 security, the client-side applications
will also use MD5 security for password protection, regardless of whether or not the Configure for
FIPS 140-2 Compliance setting was selected during installation.

E The Start Copying Files page lists the services you have chosen to install and the name of the
database server you have chosen to use. If these settings are correct, click Next. If not, click Back
and step back through the pages to make the necessary changes.

During the installation process you may see a number of DOS windows open and close. This is
expected behavior and can be ignored.

E When the installation has finished, choose whether to restart your machine now or later and click
Finish. If you want to run the post-installation steps straight away you must restart your machine
now.

E To complete the installation, you now need to perform the post-installation tasks.

Cluster installation

When you install onto more than one machine you typically follow these steps:

E First, log in to the server that will host the Accessories Service and create a site preparation file .
This file names the machines on which the various services will be installed, and sets up a central
site preparation folder that can be used by other machines in the cluster. The installation procedure
installs not only the services you choose for the machine you have logged in to but also the project
management components. This machine becomes the Primary DPM server.

E Secondly, on each of the machines named in the site preparation file, run the installation program
from the site preparation folder. Always install onto your Accessories servers first, followed by all
Interviewing servers, and finally all Web servers.

What’s installed where?

Software Web Servers Interviewing
Servers

Accessories
Servers

Database
Servers

Scriptwriters’
machines

IBM® SPSS®
Data Collection
Data Model

No Yes Yes No Yes

DPM No Yes Yes No Yes (partial)

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
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Software Web Servers Interviewing
Servers

Accessories
Servers

Database
Servers

Scriptwriters’
machines

IBM® SPSS®
Data Collection
Interviewer
Server
Administration
and activities

No No Yes No No

Activate client
component

No No Yes No Yes

Activate server
component

No Yes Yes No No

Quota No Yes Yes No Yes
Interviewing
components

No Yes No No No

Web
components

Yes No No No No

Image cache Yes No Yes No No

Creating the site preparation file and folder

Note: The site preparation file must identify servers by name not by IP address. The names must
be actual machine names and not domain names, aliases, or any other name. If the servers are
not part of a domain you will need to create a hosts file on each server so that each IP address is
associated with a name that you can use in the site preparation file. If you use IP addresses, you
will not be able to enter the server license code when you use the site preparation file to install the
IBM® SPSS® Data Collection Interviewer Server services on the servers.

E Log on as the Installing User.

E Insert the DVD-ROM into the DVD-ROM drive.

Depending on your system configuration, the AutoPlay feature may detect and start the installation
program when you insert the DVD-ROM into the drive. If this does not happen, you can start
the installation program manually, as follows:

From the Windows Start menu, choose Run.
In the Run dialog box, type d:\autoplay where d:\ is the DVD-ROM drive.

This opens the IBM SPSS Data Collection Server 6 Installer window.

E From the IBM SPSS Data Collection Server 6 Installer window, choose Install IBM SPSS Data
Collection Server 6.

This starts the IBM SPSS Data Collection Server 6 Setup wizard.

E Click Next on the Welcome screen.

E On the License Agreement screen, read the license agreement.

E If you accept the agreement, click Yes.
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E On the Select Features page, select the Interviewer Server option and choose the appropriate
services and utilities to be installed. Possible Interviewer Server options are as follows:

Accessories Service. Installs the Accessories Service, including IBM® SPSS® Data
Collection Interviewer Server Administration.
Interview Service. Installs the Interview Service.
Web Service. Installs the Web Service.
Load Tool. Installs the IBM® SPSS® Data Collection Load Tool utility.

Note: The services and utilities listed above are for use with the Interviewer Server. You can also
choose to install other IBM SPSS Data Collection Server applications.

Starting with the IBM® SPSS® Data Collection 6 release, all application names have changed.
The application names map as follows:

Old Application Name New Application Name
Interviewer Server\mrInterview Interviewer Server
Interviewer\Interview Player Phone Phone Interviews
Interviewer\Interview Player Web Web Interviews
Remote Manager Remote Administration
Web Reports for Surveys\mrTables Survey Tabulation
Reports for Surveys\Reporter Survey Reporter Server Edition
Reports for Surveys Components\Dimensions
Component Pack

SPSS Survey Reporter Developer Kit

N/A Author Server Edition

E On the Machine Configuration page, choose Cluster Install.

E On the Machine Settings page, enter a name for your IBM® SPSS® Data Collection site and click
Next. The site name that you choose is displayed on the main Interviewer Server Administration
page and can be any name of your choice.

E On the Site Install Destination page, enter the name of the site preparation folder. The default
is c:\mrInterviewSiteInstallation. Click Next.

E On the Cluster Machines page, enter the names of the machines that will host the Interview,
Web, and Accessories Services. You can also specify the IBM® SPSS® Data Collection Survey
Tabulation, IBM® SPSS® Data Collection Survey Reporter Server Edition, and IBM® SPSS®
Data Collection Author Server Edition server names if you selected to also install the applications.
The names must be machine names not domain names, aliases, IP addresses, or any other name.
Lists of names must be separated with semicolons. If you want to communicate using a port other
than the default port 80 or you want to use SSL for greater security, click Advanced and proceed
as follows. Otherwise, click Next.

When you click Advanced, the Advanced Cluster Configuration dialog box lists the names of
the servers you specified on the previous page. For each server shown, enter the port number
you want to use and, if you want to use SSL, check the SSL box. Your changes are saved
automatically as soon as you make them.
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To enter specifications for a different server, select it from the appropriate drop-down list and
then change the port number and/or SSL setting as necessary.
Click Apply.
On the Question dialog box, click Yes if all the URLs shown are correct or No if you want
to make further changes.
When you are ready to continue, click Next.

E On the Cluster Server Selection page, choose the names of the machines that will run the
Interviewing Web, Image Cache Web, and (if appropriate) Phone Interviewer services. Click Next.

E On the Data Collection User and Group page, enter the name and password of the Running User
and the name of the Data Collection Group. Click Next after entering the appropriate information.

Note: The names that you enter must be valid names for the domain or workgroup on which
you are installing.

E On the Anonymous User page, enter the name and password of the Anonymous Access User that
you created. Click Domain if this is a domain user account orWorkgroup if this is a workgroup user
account. Click Next after entering the appropriate information.

E On the Database Setup page, enter the name of the database server on which you want to create
the Interviewer Server Data database and click Next.

E On the DPM User Admin Details page, enter a name and password for the Interviewer Server
Administration Administrator. You can also select whether or not to enable integrated Windows
login. Refer to the topic “Configuring for Single Sign-on” in the IBM® SPSS® Data Collection
Developer Library 6 for more information on integrated Windows login.

Note: This user name is simply for accessing the Distributed Property Management (DPM)
database to perform administrative tasks such as setting up Interviewer Server Administration
users and roles, and managing access to Interviewer Server Administration files and applications.
It exists only in DPM. To avoid possible conflicts with other user names, the name that you choose
should not match any existing NT user names on your system.

E On the Email Settings page, enter the name and port number of your Email SMTP server.
Alternatively, if you do not want to use the Email activity or do not have the required information
at hand, click I want to configure my email settings later. In either case, click Next to move to
the next page.

E On the Internet Information Services (IIS) Configuration screen, the installation program detects
any web sites available on the installation machine and displays them in the drop-down list box.
If you want to use a Web site other than the default for your SPSS Inc. applications, select
it from the drop-down list.

The default file location for the web site you have selected is displayed. If the installation program
detects a folder called SPSSMR within the web site folder structure, you are prompted to install
the files in this folder instead. If you want to install the files to a different location, click Browse
and choose the folder you want to use.
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Note: When selecting a non-default web site location on a 64-bit server, you cannot select a web
files location under C:\Program Files in the Internet Information Services (IIS) Configuration
dialog. For example, if you defined a non-default web site named myWebSite, and its local path
is C:\Program Files\myWebSite, you must select a web files location that is not located under
C:\Program Files when you select myWebSite for the Data Collection folders and applications
(you can instead select the location C:\Program Files (x86)).

The Advanced button is available for advanced configuration of your chosen web site. This allows
you to place Interviewer Server Administration in its own application pool so each process can be
split across multiple application pools The operating system places a 2 GB restriction on processes
in IIS. Put simply, splitting a process across application pools means it is possible to run larger
processes. Refer to your IIS documentation for general information about application pools. If
you want to use application pools, proceed as follows:

Click Advanced.
This opens the Advanced IIS Configuration screen.
To place Interviewer Server Administration in its own application pool, select Use
“SPSSDimensionNetPool” application pool. If you want processes to recycle and/or shut down
after specific number of minutes, select the appropriate option and enter the number of minutes
elapse time required. Selecting this option means that if the Interviewer Server Administration
process is recycled or shut down, anyone using Interviewer Server Administration activities at
that time will have to restart their session in order to continue working.
To place Interviewer Server in its own application pool, select Use “SPSSmrInterviewPool”
application pool. If you want processes to recycle and/or shut down after so many minutes,
select the appropriate option and enter the number of minutes elapse time required. Selecting
this option means that if the application process is recycled or shut down, anyone using
Interviewer Server activities at that time will have to restart their session in order to continue
working.
Click Apply.

On the Internet Information Services (IIS) Configuration screen, click Next when you are ready to
continue.

Note: If you already installed Interviewer Server, the IIS configuration settings are automatically
inherited, so the Internet Information Services Configuration screen will not appear.

E On the Choose Destination Location page, choose the folder in which you want to install
Interviewer Server. The default is [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\. Click
Next.

E On the File Management Folder page, choose the location of the File Management root folder
(FMRoot). This is the folder in which the master copies of project files created using Interviewer
Server Administration or the Scriptwriter desktop activities will be stored, and it is from here that
the interviewing machines will make local copies of these files.

The File Management root folder must be shared so that it is accessible by other machines. If
you choose a folder on your current machine, the installation procedure will create the share for
you. If you choose a folder with a UNC pathname (that is, one that starts \\machine_name\...) this
will be used as the shared folder. Click Next.
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Note: You can create the File Management root folder on any machine as long as its share is
visible to all machines running the Interviewing and Scriptwriter Services. The ideal location is
a separate machine that acts as a file server rather than a machine running the Interviewing or
Accessories service. This is because the File Management root folder is an integral part of most
Interviewer Server Administration and Interviewer Server functionality, and needs to be available
all the time that Interviewer Server Administration is running. You will need to manually share
the specified UNC directory:

1. Navigate to and select the specified UNC directory.

2. Right-click the directory and select Properties, then select the Sharing tab.

3. Select Share this folder and enter SPSSMR_FMROOT in the Share name field.

4. Click Permissions and select Full control for the Everyone group.

5. Click OK to save your changes.

6. Select the Security tab, add the Interviewer Server group (only if it is not already present), and
select Full control for the Interviewer Server group.

7. Click OK to save your changes.

If you install it on a machine that is running the Interviewing or Accessories service and you
need to restart that machine, Interviewer Server Administration becomes effectively unusable by
anyone on any other machine until the service machine has restarted.

Updating the registry after moving FMROOT

If you change the location of the FMROOT in DPM Explorer post installation, you must also
update the associated registry entries to match the DPM Explorer values. If the environment is a
cluster environment, you must update the registry entries on all clustered accessory servers,
Survey Tabulation servers and IBM® SPSS® Data Collection Survey Reporter servers. The
mapping of DPM properties and registry entries is as follows:

DPM Property Registry Entry
FileMgt_RootFolderLocalPath HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\InstallOptions

\FMRoot_Local
and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview \3
\InstallOptions\FMRoot_Local

FileMgt_RootFolderUNC HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet
\InstallOptions \FMRoot_UNC
and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3
\InstallOptions\FMRoot_UNC

E The Choose the location of Interviewer Server Project and Source files page allows
you to specify the folder that you want to create for storing the project and source files
that the Interview Services use for running interviews. When a scriptwriter activates a
project, the activation program copies the questionnaire file and the templates into the
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Projects folder so that they are available for interviewing. The default project folder is
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer. Click Next to continue.

Note: When configuring for FIPS 140-2 compliance in the Windows Server 2008 environment,
you must first install a Microsoft hotfix. Failure to install the hotfix may result in problems when
using the Interviewer Server Administration User Administration activity. Refer to the Microsoft
support article “FIX: You cannot run an ASP.NET 3.5-based application that uses a ScriptManager
control” (http://support.microsoft.com/kb/981119) for more information.

E On the FIPS 140-2 Compliance page, select whether or not the installation will be configured for
FIPS 140-2 compliance. FIPS 140-2 is a U.S. government computer security standard used to
accredit cryptographic modules. Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information.

Configure for FIPS 140-2 Compliance. If your system is already configured to be FIPS 140-2
compliant prior to installation, the installation process will not let you deselect the Configure for
FIPS 140-2 Compliance option. If you no do not want the installed applications to be FIPS 140-2
compliant, you must manually set a Windows System cryptography setting to disabled:

1. From the Windows Control panel, select:
Administrative Tools > Local Security Policy > Local Policies (located in the left panel) > Security
Options (located in the left panel) > System cryptography: Use FIPS compliant algorithms... (located
in the right panel)

2. Double-click the System cryptography: Use FIPS compliant algorithms... policy and select Disabled.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not
Configure for FIPS 140-2 Compliance is enabled; for upgrade installations, the following
rules apply:

If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded
in the following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup
log file. The log file is located at: C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\\Installer\NewPassword.logInterviewer Server
Administration administrators can supply users these new, temporary passwords in a manner
that is in accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change
their passwords at next login.
When upgrading on a server that is currently not configured for FIPS 140-2, you are presented
with the option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash
function algorithm.
Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the
SHA-1 hash function algorithm will continue to be employed.

http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
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– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the
parameters outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information
regarding FIPS 140-2.

Note: When FIPS 140-2 is configured for IBM SPSS Data Collection products, the applications
adhere to the password protection security protocols that are defined on the Interviewer Server.
For example, if the Interviewer Server is configured for MD5 security, the client-side applications
will also use MD5 security for password protection, regardless of whether or not the Configure for
FIPS 140-2 Compliance setting was selected during installation.

E The Start Copying Files page displays the name of the folder in which the site preparation file
will be created. If this is correct, click Next. If not, click Back and step back through the pages to
make the necessary changes.

E When the installation has finished, you need to share the mrInterviewSiteInstallation folder
manually. To do this, proceed as follows.

In Windows Explorer, browse to the mrInterviewSiteInstallation folder, right-click and choose
Properties.
On the Sharing tab, select Share this folder.
Click Permissions and add the Installing User and the Data Collection Group.

E If the installation procedure prompted you to reboot and you chose not to do so at that point,
reboot now.

Installing the IBM SPSS Data Collection Interviewer Server services on each machine
named in the site preparation file

The first machine on which you install IBM® SPSS® Data Collection Interviewer Server must
be one that runs the Accessories Service. We recommend that you install in the following order:
all Accessories servers, all Interview servers, all Web servers.

E Log on as the Installing User.

E In Windows Explorer, browse to the network directory in which the site preparation file was
created.

E Double-click the AutoPlay file (autoplay.exe).

This opens the IBM SPSS Data Collection Server 6 Installer window.

E From the IBM SPSS Data Collection Server 6 Installer window, choose Install IBM SPSS Data
Collection Server 6.

This starts the IBM SPSS Data Collection Server 6 Setup wizard.

E Click Next on the Welcome screen.

E On the License Agreement screen, read the license agreement.

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
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E If you accept the agreement, click Yes.

E On the Select Features page, choose the services and utilities to be installed, and then click Next. If
you are installing onto a machine that will be running the Accessories Service and you want to use
the IBM® SPSS® Data Collection Interviewer Phone and/or IBM® SPSS® Data Collection Remote
Administration, select those options as well. Click Next after selecting the appropriate options.

E The Permissions Settings page opens showing the names of the Running User and the IBM®
SPSS® Data Collection Group specified in the site preparation file. Enter the password for the
Running User and click Next.

E The Anonymous User page opens showing the name of the Anonymous User specified in the site
preparation file. Enter the password for the Anonymous User and click Next.

E On the DPM User Admin Details page, enter the user name and password for the IBM® SPSS®
Data Collection Interviewer Server Administration Administrator that you specified when creating
the site preparation file.

E On the Internet Information Services (IIS) Configuration screen, the installation program detects
any web sites available on the installation machine and displays them in the drop-down list box.
If you want to use a Web site other than the default for your SPSS Inc. applications, select
it from the drop-down list.

The default file location for the web site you have selected is displayed. If the installation program
detects a folder called SPSSMR within the web site folder structure, you are prompted to install
the files in this folder instead. If you want to install the files to a different location, click Browse
and choose the folder you want to use.

Note: When selecting a non-default web site location on a 64-bit server, you cannot select a web
files location under C:\Program Files in the Internet Information Services (IIS) Configuration
dialog. For example, if you defined a non-default web site named myWebSite, and its local path
is C:\Program Files\myWebSite, you must select a web files location that is not located under
C:\Program Files when you select myWebSite for the Data Collection folders and applications
(you can instead select the location C:\Program Files (x86)).

The Advanced button is available for advanced configuration of your chosen web site. This allows
you to place Interviewer Server Administration in its own application pool so each process can be
split across multiple application pools The operating system places a 2 GB restriction on processes
in IIS. Put simply, splitting a process across application pools means it is possible to run larger
processes. Refer to your IIS documentation for general information about application pools. If
you want to use application pools, proceed as follows:

Click Advanced.
This opens the Advanced IIS Configuration screen.
To place Interviewer Server Administration in its own application pool, select Use
“SPSSDimensionNetPool” application pool. If you want processes to recycle and/or shut down
after specific number of minutes, select the appropriate option and enter the number of minutes
elapse time required. Selecting this option means that if the Interviewer Server Administration
process is recycled or shut down, anyone using Interviewer Server Administration activities at
that time will have to restart their session in order to continue working.
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To place Interviewer Server in its own application pool, select Use “SPSSmrInterviewPool”
application pool. If you want processes to recycle and/or shut down after so many minutes,
select the appropriate option and enter the number of minutes elapse time required. Selecting
this option means that if the application process is recycled or shut down, anyone using
Interviewer Server activities at that time will have to restart their session in order to continue
working.
Click Apply.

On the Internet Information Services (IIS) Configuration screen, click Next when you are ready to
continue.

Note: If you already installed Interviewer Server, the IIS configuration settings are automatically
inherited, so the Internet Information Services Configuration screen will not appear.

Note: The Internet Information Services Configuration page appears only if the machine you are
installing on is an Accessories server.

E On the Choose Destination Location page, choose the folder in which you want to install
Interviewer Server. The default is [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\. Click
Next.

E On the File Management Folder page, choose the location of the File Management root folder
(FMRoot). This is the folder in which the master copies of project files created using Interviewer
Server Administration or the Scriptwriter desktop activities will be stored, and it is from here that
the interviewing machines will make local copies of these files.

The File Management root folder must be shared so that it is accessible by other machines. If
you choose a folder on your current machine, the installation procedure will create the share for
you. If you choose a folder with a UNC pathname (that is, one that starts \\machine_name\...) this
will be used as the shared folder. Click Next.

Note: You can create the File Management root folder on any machine as long as its share is
visible to all machines running the Interviewing and Scriptwriter Services. The ideal location is
a separate machine that acts as a file server rather than a machine running the Interviewing or
Accessories service. This is because the File Management root folder is an integral part of most
Interviewer Server Administration and Interviewer Server functionality, and needs to be available
all the time that Interviewer Server Administration is running. You will need to manually share
the specified UNC directory:

1. Navigate to and select the specified UNC directory.

2. Right-click the directory and select Properties, then select the Sharing tab.

3. Select Share this folder and enter SPSSMR_FMROOT in the Share name field.

4. Click Permissions and select Full control for the Everyone group.

5. Click OK to save your changes.

6. Select the Security tab, add the Interviewer Server group (only if it is not already present), and
select Full control for the Interviewer Server group.

7. Click OK to save your changes.
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If you install it on a machine that is running the Interviewing or Accessories service and you
need to restart that machine, Interviewer Server Administration becomes effectively unusable by
anyone on any other machine until the service machine has restarted.

Updating the registry after moving FMROOT

If you change the location of the FMROOT in DPM Explorer post installation, you must also
update the associated registry entries to match the DPM Explorer values. If the environment is a
cluster environment, you must update the registry entries on all clustered accessory servers, IBM®
SPSS® Data Collection Survey Tabulation servers and IBM® SPSS® Data Collection Survey
Reporter servers. The mapping of DPM properties and registry entries is as follows:

DPM Property Registry Entry
FileMgt_RootFolderLocalPath HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\InstallOptions

\FMRoot_Local
and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview \3
\InstallOptions\FMRoot_Local

FileMgt_RootFolderUNC HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet
\InstallOptions \FMRoot_UNC
and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3
\InstallOptions\FMRoot_UNC

E The Choose the location of Interviewer Server Project and Source files page allows
you to specify the folder that you want to create for storing the project and source files
that the Interview Services use for running interviews. When a scriptwriter activates a
project, the activation program copies the questionnaire file and the templates into the
Projects folder so that they are available for interviewing. The default project folder is
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer. Click Next to continue.

E On the FIPS 140-2 Compliance page, select whether or not the installation will be configured for
FIPS 140-2 compliance. FIPS 140-2 is a U.S. government computer security standard used to
accredit cryptographic modules. Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information.

Note: When configuring for FIPS 140-2 compliance in the Windows Server 2008 environment,
you must first install a Microsoft hotfix. Failure to install the hotfix may result in problems when
using the Interviewer Server Administration User Administration activity. Refer to the Microsoft
support article “FIX: You cannot run an ASP.NET 3.5-based application that uses a ScriptManager
control” (http://support.microsoft.com/kb/981119) for more information.

Configure for FIPS 140-2 Compliance. If your system is already configured to be FIPS 140-2
compliant prior to installation, the installation process will not let you deselect the Configure for
FIPS 140-2 Compliance option. If you no do not want the installed applications to be FIPS 140-2
compliant, you must manually set a Windows System cryptography setting to disabled:

1. From the Windows Control panel, select:
Administrative Tools > Local Security Policy > Local Policies (located in the left panel) > Security
Options (located in the left panel) > System cryptography: Use FIPS compliant algorithms... (located
in the right panel)

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
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2. Double-click the System cryptography: Use FIPS compliant algorithms... policy and select Disabled.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not
Configure for FIPS 140-2 Compliance is enabled; for upgrade installations, the following
rules apply:

If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded
in the following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup
log file. The log file is located at: C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\\Installer\NewPassword.logInterviewer Server
Administration administrators can supply users these new, temporary passwords in a manner
that is in accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change
their passwords at next login.
When upgrading on a server that is currently not configured for FIPS 140-2, you are presented
with the option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash
function algorithm.
Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the
SHA-1 hash function algorithm will continue to be employed.
– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the
parameters outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information
regarding FIPS 140-2.

Note: When FIPS 140-2 is configured for IBM SPSS Data Collection products, the applications
adhere to the password protection security protocols that are defined on the Interviewer Server.
For example, if the Interviewer Server is configured for MD5 security, the client-side applications
will also use MD5 security for password protection, regardless of whether or not the Configure for
FIPS 140-2 Compliance setting was selected during installation.

E The Start Copying Files page displays details about what will be installed and where. If this is
correct, click Next. If not, click Back and step back through the pages to make the necessary
changes.

E Reboot the computer if prompted to do so.

E Perform the post-installation tasks.

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
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Single sign-on in a cluster environment

A single sign-on implementation for clustered environments improves user and role
administration. The single sign-on implementation is required when signing onto a cluster results
in the user signing onto all of the cluster’s IBM® SPSS® Data Collection Interviewer Server
Administration instances. Cluster single sign-on allows a Interviewer Server Administration user
to perform activities on each clustered Interviewer Server Administration server without signing
onto each server.

A clustered server installation is configured for single sign-on as follows:

E The activity instance that provides the best performance is selected.
For each activity in a cluster environment, the installed instance information is saved under
[Server/Application/ApplicationSettings].
The property MultiInstance is used to determine whether each activity utilizes the web load
balancing feature. In DPM Explorer, MultiInstance should be configured as True (even
when there is only one instance) for the IBM® SPSS® Data Collection Interviewer Server,
IBM® SPSS® Data Collection Survey Tabulation and IBM® SPSS® Data Collection Survey
Reporter activities, as these application activities are accessed from a different server.
Note: When load balancing is utilized for computer assisted telephone interviewing (CATI)
performance testing purposes, the MultiInstance property must be set to False.
Interviewer Server Administration load balance selects the instance that exhibits the best
performance. Refer to the Interviewer Server Administration Load Balancing topic in the
IBM® SPSS® Data Collection Developer Library for more information.

E The server that hosts the activity instance is logged into.

If a user request is redirected to the activity on a different server, the username and ticket
are appended as form parameters. Depending on the username and ticket, httpModules
SingleSignOnModule handles the creation of the ASP.NET authentication ticket.

E The activity instance is exited.

Upon exiting an activity, httpHandlers EndApplication signs-out the ASP.NET authentication
ticket.

E The Interviewer Server Administration session is logged off.

When a user logs out of Interviewer Server Administration, the ASP.NET authentication cookie is
cleared and the DPM ticket is deleted from the DPM data base.

Post-installation checklist for IBM SPSS Data Collection Interviewer
Server installation

After you have installed IBM® SPSS® Data Collection Interviewer Server there are a number of
tasks that you may need to do to ensure that all components are able to function correctly. Full
details of these tasks are given below under separate headings.
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Things you must do

If the image cache is installed on a machine with only the Web Service installed and that
machine is outside the firewall, configure the image cache as remote
Set up users and roles in IBM® SPSS® Data Collection Interviewer Server Administration
On Accessories servers running Windows XP Service Pack 3, add the ASPNET account to the
Launch permissions on LogBck02
If you have installed onto a machine on which IBM® SPSS® Data Collection Base
Professional is installed, add Base Professional users to the IBM® SPSS® Data Collection
group on that machine so that they have access to the log file folder
If you have installed the Web Service on machines that have multiple IP addresses and
web sites configured for each IP address, replace the Web Service machine names with IP
addresses in DPM and reregister the Interview Service machines
If you have Web servers that are accessed through the internet, replace the machine name in
certain URLs with the fully qualified machine name
If your site uses SSL, cancel the requirement for mrIEngWS to use a secure channel

Things you must do if they are not done automatically

Register the Interview Service machines with the Web Service machines
Start mrUserAdminServer and mrDPMServer3 if they are not already running
Check that access permissions are set correctly for FMRoot and all its subfolders

Optional tasks

Add indexes to any existing sample tables to improve performance
If your site uses telephone interviewing, increase the size of the appRequestQueueLimit
setting for the .NET Framework.
If your site uses telephone interviewing, change the thread configuration settings for the
interviewing engine and the .NET Framework to avoid requests beings queued due to blocked
thread pools.
Install the Load Tool
Configure the Interviewer Server Administration Email activity
Increase the number and/or size of the log files
Create a hosts file that will allow Interviewer Server services to communicate across a firewall
Set up your Web site to use SSL
Change the Interview Engine load balancing algorithm used to distribute interviews to the
Interview Service machines
In cluster installations, modify the TCP/IP registry settings on machines running the Interview
and Web Services
If you are using SQL Server 2005 or 2008 and a named instance, edit
SampleMgtGUI.Config.xml to control the servers available to the Participants and Activate
activities
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If you are upgrading from a previous version of IBM SPSS Data Collection Server, and you
want to query your old log files (from the Manage Logs activity for example), copy the old
logs from the previous version’s log directory to the new IBM SPSS Data Collection Server
6 log location (by default, [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server Administration\Logs).
Install the IBM® SPSS® Data Collection Developer Library

Things you must do on local machines

If Phone Reports users will need to create charts, enable the charting facility
Enabling pop-ups and file downloads
Enable the Internet Explorer security setting “Allow websites to open windows without
address or status bars”.
Set up automatic Windows login for Interviewer Server Administration users who use the
Firefox browser
For users who will run Interviewer Server Administration using the Firefox browser on the
WYSE 5150SE, increase the default font size in Firefox

Adding DCOM permissions for scriptwriters to LogBckO2

If you have installed the Scriptwriter Service onto individual scriptwriters’ machines, and those
scriptwriters will be logging in using an account other than that of the installing user, you should
add DCOM permissions for the machine’s Users group to LogBckO2. This will prevent access
problems if the scriptwriter works on projects that use quota control.

E From the Windows Start menu, choose Run.

E Type dcomcnfg in the text box and click OK.

E In the left-hand frame expand the display to show the following hierarchy: Component Services >
Computers > My Computer > DCOM Config.

E In the left-hand frame, right-click LogBck02 and select Properties.

This opens the LogBckO2 Properties dialog box.

E Select the Security tab.

E In the Access Permissions frame click Edit.

This opens the Launch Permissions dialog box.

E Click Add.

This opens the Select Users, Computers or Groups dialog box.

E In “Enter the object names to select”, type MachineName\Users, where MachineName is the
name of the scriptwriter’s machine.

E Click OK to save the change and then close dcomcnfg.
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Enabling charts in the Phone Reports activity

The charting feature in IBM® SPSS® Data Collection Interviewer Server Administration is
disabled by default. Before enabling this feature for any user it is your responsibility to verify
that the said user is appropriately licensed for MS Office Web Components (OWC). Check
your MS OWC license agreement or EULA.

To enable the charting feature, you need to carry out the following steps:

1. Run the Chart Configuration program that is installed with IBM SPSS Data Collection Desktop
6.

2. Enable access to charts for users and roles.

Running the chart configuration program

E Use Windows Explorer to locate the executable file ChartConfiguration.exe. By default, this is
installed in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server Administration.

E Double-click the file name to run the program, then check the Display Charts in Interviewer Server
Administration box and click OK.

Enabling access to charting for users and roles

After running the chart configuration program, you can enable access to charting for users in a
particular role, so that only correctly licensed users are able to access it. You may find that you
need to create a separate role for these users. For more information, see the topic Adding roles
on p. 57.

E In Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E In the left frame, click Activities.

E Depending on the application, expand the Phone, IBM® SPSS® Data Collection Survey Reporter,
or IBM® SPSS® Data Collection Survey Tabulation activity, then expand the Features option.

E Select the Can display charts feature.

A frame appears on the right of the page listing the roles currently assigned to this feature.

E Click Add/Remove.

This opens the Add Role dialog box.

E Choose the roles you want to assign to the feature and click OK.
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Enabling pop-ups and file downloads

If the browser that is running IBM® SPSS® Data Collection Interviewer Server Administration
and IBM® SPSS® Data Collection Interviewer Server has pop-up blockers or restrictions on
downloading files, users will encounter problems with activities that make use of these features.
In order for Interviewer Server to work as intended pop-ups and file downloads should be enabled.

Enabling pop-ups

E In Internet Explorer, select:
Tools > Pop-up blocker > Pop-up blocker settings

E Add the name of the machine that is running Interviewer Server to the settings.

Enabling file downloads

E Follow the instructions that the browser provides the first time it is unable to download a file. The
changes made at this point enable all subsequent file downloads in Interviewer Server.

For example, when a user runs Export Data and chooses to download the exported data onto
his/her computer, the export process will run but will display a message in the browser’s
information bar saying that Internet Explorer has blocked the site from downloading files onto
the computer. To allow file downloads, the user should click on the location indicated in the
message to display options for enabling downloads.

Things you must do
If the image cache is installed on a machine with only the Web Service installed and that
machine is outside the firewall, configure the image cache as remote
Set up users and roles in IBM® SPSS® Data Collection Interviewer Server Administration
On Accessories servers running Windows XP Service Pack 3, add the ASPNET account to the
Launch permissions on LogBck02
If you have installed onto a machine on which IBM® SPSS® Data Collection Base
Professional is installed, add Base Professional users to the IBM® SPSS® Data Collection
group on that machine so that they have access to the log file folder
If you have installed the Web Service on machines that have multiple IP addresses and
web sites configured for each IP address, replace the Web Service machine names with IP
addresses in DPM and reregister the Interview Service machines
If you have Web servers that are accessed through the internet, replace the machine name in
certain URLs with the fully qualified machine name
If your site uses SSL, cancel the requirement for mrIEngWS to use a secure channel
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Setting up the image cache on Web Service machines without direct access to FMRoot

When the Web server cannot access FMRoot you need to configure the Web server’s image
cache application to connect to the Accessories server’s image cache application, which in turn
goes to the FMRoot folder and selects images from the project folders. Perform the following
steps on all machines running the Web Service:

E On each Web Service machine, open Windows Explorer and browse to
\InetPub\wwwroot\SPSSMR\ImageCache.

E Remove the Read-Only properties on the Web.config file and then open the file.

E In the <appSettings> section, locate the line that defines the BASE_LOCATION key and change
the key’s value so that it points to the Accessories server:

<add key"BASE_LOCATION" value="http://AccServer/SPSSMR/ImageCache/ImageCache.aspx">

E Locate the line <add key="IS_REMOTE" value="false"/> and change the value from
false to true.

E Save and close the file.

Depending on the way your system is configured, you may also need to change some
settings in Web.config in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb. The file contains two settings to do with the Image Cache.

ImageCacheURL. Defines the URL that the respondent’s browser will use to reference the image
cache on the Web tier.

<appSettings>
<add key="ImageCacheURL" value="http://WebServer/SPSSMR/ImageCache/ImageCache.aspx"/>

</appSettings>

This URL needs to be accessible from a machine outside the Web tier — that is, on a machine
other than the one on which respondents will take surveys. You can test this by opening a browser
on a machine that represents your respondents’ machines and accessing this URL.

LocalImageCacheURL. Used only if the local machine cannot access the ImageCacheURL when
run locally.

<appSettings>
<add key="LocalImageCacheURL" value="http://localhost/SPSSMR/ImageCache/ImageCache.aspx"/>

</appSettings>

The LocalImageCacheURL must be accessible from the local machine. You can test this by
opening a browser on the Web server and accessing the URL. If the URL set by the installer
cannot be accessed from the local machine you may need to replace the machine name with a
fully qualified domain name or an IP address.

E Browse to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb.

E Remove the Read-Only properties on the Web.config file and then open the file.

E Make whatever changes are necessary to ImageCacheURL and LocalImageCacheURL.
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E Save and close the file.

E Stop and restart IIS to implement the changes. If you are running Windows Server 2003 or 2008,
you can stop and restart the IBM® SPSS® Data Collection Interviewer Server application pool
(usually SPSSmrInterviewPool) rather than restarting IIS if you prefer. This has the advantage
of not affecting any other applications that may be using IIS.

Setting up IBM SPSS Data Collection Interviewer Server Administration users, roles, and
permissions

Users and roles are part of the IBM® SPSS® Data Collection Interviewer Server Administration
security system. Every Interviewer Server Administration user has a unique user name and
password, plus a personal working directory within the FMRoot\Users directory. Roles are a
means of grouping users according to the activities they will use. For example, you might create a
Scriptwriting role for users who need access to questionnaire design and building activities,
and an Analysis role for users who need access to the activities that generate tables and export
data. You might also create an Analysis role for users who need access to the applications that
generate tables and export data.

The installation procedure creates one administrator with a name and password of your choice
and places that user in the DPMAdmins role.

In addition, three further roles are created when you install IBM® SPSS® Data Collection Survey
Tabulation: TabulationFullAccess, TabulationMediumAccess, and TabulationMinimumAccess.
Each role is set up with the appropriate Interviewer Server Administration activities and features.
You can attach users to these roles if required, or use them as a basis for creating your own roles.
For details of the activities and features assigned to each role, see the Access Levels in Survey
Tabulation topic in the Survey Tabulation Technical Documentation section of the IBM® SPSS®
Data Collection Developer Library.

Before you can add users and roles and set permissions, you need to start Interviewer Server
Administration.

E Open your browser and go to http://machine_name/SPSSMR/DimensionNet/default.aspx.

E On the Interviewer Server Administration login screen, enter the name and password for the user
you specified as the Interviewer Server Administration administration user during installation
and click Login.

This opens the main Interviewer Server Administration screen.

Adding users

E In IBM® SPSS® Data Collection Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.
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E Click Users.

A list of current user names appears on the right of the screen.

E On the right of the screen, click New User....

This opens the User Administration dialog box.

E Complete the fields in the dialog box and click OK to create the new account.

Adding roles

E In IBM® SPSS® Data Collection Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E Click Roles.

A list of current role names appears on the right of the screen.

E In this frame click New Role....

This opens the User Administration dialog box.

E Complete the fields in the dialog box and click OK.

E In the Add User\Project\Activity dialog box, select the users who will be members of this role.

E Click OK to create the role with the selected users as members.

Assigning activities to roles

Once you create users and roles, you can decide which roles may use each activity.

Some features of some activities have their own security settings. For example, while all users
may be able to run an activity, you may be able to restrict access to certain features within the
activity to a subset of users. When you assign activities to roles, you are prompted to specify
which activity features should be available to role members.

When you assign activities to roles, always check whether the activity has security controlled
features and consider who needs access to these features. The default may be that no one except
administrators have access (which is probably not what you want). You may find that you need to
create a separate role for these users.

E In IBM® SPSS® Data Collection Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E Click Activities.
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E Select an activity from the Activities tree.

Click the Roles tab on the right of the page. The tab lists the roles currently assigned to the
selected activity.

E Click Add/Remove.

This opens the Add Role dialog box.

E Choose the roles you want to assign to this activity and click OK.

E If the activity has features, a second dialog box is displayed. Select the features that should be
accessible to the roles you have just added.

E Click OK to assign the features to the role.

Adding the ASPNET account to the launch permissions on LogBck02

This task applies only to Accessories servers that are running Windows XP Service Pack 3.

E From the Windows Start menu, choose Run.

E Type dcomcnfg in the text box and click OK.

E In the left-hand frame, expand the display to show the following hierarchy:
Component Services > Computers > My Computer > DCOM Config

E In the left-hand frame, right-click LogBck02 and select Properties.

This opens the LogBckO2 Properties dialog box.

E Select the Security tab.

E In the Launch and Activation Permissions frame click Edit.

This opens the Launch Permissions dialog box.

E Click Add.

This opens the Select Users or Groups dialog box.

E Click Locations, and change the location to be your local machine. Then click OK.

E Add ASPNET, and click OK.

E In the Launch Permissions window, verify that Local Launch and Local Activation are allowed for
the ASPNET user and set them if they are not.

E Close dcomcnfg.

Adding IBM SPSS Data Collection Base Professional users to the IBM SPSS Data Collection group

IBM® SPSS® Data Collection Interviewer Server Administration and all the
activities that run within it write log files to the folders named in the Directory
setting in HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\Log and
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\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Log in the registry. The default
for both keys is [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server
Administration\Logs. IBM® SPSS® Data Collection desktop applications such as IBM® SPSS®
Data Collection Base Professional usually write their log files elsewhere.

If you install a mixture of Interviewer Server Administration and desktop applications on a
machine, it makes sense to have all the log files written to the same location, and the Interviewer
Server Administration Logs folder becomes the central location for all log files. The product
installation programs deal with this automatically, but there may be times when you need to make
some additional changes.

Any user who is a member of the Data Collection group has permissions to write to files in the
Logs folder. All Interviewer Server Administration activities are run by the anonymous user.
The anonymous user is a member of the Data Collection group and therefore log messages can
be written by all Interviewer Server Administration activities. Desktop application users (for
example, users of Base Professional) are not necessarily members of this group and may not have
permission to write to the Logs folder. Therefore, you may sometimes need to add desktop users
to the Data Collection group. There are two situations when you will need to do this:

You install IBM® SPSS® Data Collection Interviewer Server, IBM® SPSS® Data
Collection Survey Tabulation, or IBM® SPSS® Data Collection Survey Reporter
onto a machine that already has Base Professional installed. The installation
procedure modifies the registry so that log files for all Data Collection products go to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server Administration\Logs.
You install Base Professional onto a machine that already has Interviewer Server, Survey
Tabulation, or Survey Reporter installed. Since the Interviewer Server Administration Logs
folder is already set as the logging folder, the application’s installation program does not
change the registry settings.

Follow these steps to add a user to the Data Collection group on machines on which Base
Professional is installed:

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, click Groups.

E In the right-hand frame, right-click the Data Collection group that you created for installing
Interviewer Server and choose Add to Group.

This opens the group’s Properties dialog box.

E Click Add.

This opens the Users or Groups dialog box.

E In the list of names, choose the names of the users you want to add to the group and click Add.

E Click OK to close the Users or Groups dialog box.
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Changes for machines with multiple IP addresses

If you have installed the Web Service onto a machine with multiple IP addresses, and have web
sites set up for each IP address, you must update the project management database so that it
refers to the IP addresses of the IBM® SPSS® Data Collection Interviewer Server Web sites
rather than the names of the machines on which the Web Service is installed. The recommended
way to do this is to use DPM Explorer, which is installed as part of the IBM® SPSS® Data
Collection Developer Library.

E Navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Code\Tools\VB.Net\DPMExplorer.Net
and double click DPMExplorer.exe.

E In the left-hand frame of the DPM Explorer screen, click Clusters.

E In the upper right-hand frame, click DefaultCluster.

The value of this property is displayed in the lower right-hand frame.

E In the lower right-hand frame, replace the machine names with the IP addresses of the web sites
you will be using. Do not delete the & symbols that enclose the names.

E Click Apply and then close DPM Explorer.

E Log on to a machine running the Interview Service.

E Browse to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\Server and
double-click RegIntSvr.exe to register the Interview Service machines with the Web Service
machines.

E Repeat these last two steps on all other machines running the Interview Service.

Replacing machine names in URLs with fully qualified machine names

If you have Web servers that are accessed through the internet, you will need to replace the
machine names in certain URLs with fully qualified machine names. For example, you might
replace the server name exampleserver with exampleserver.com. The URLs must be changed on
machines running the Accessories or Interviewing service, and are as follows:

ImageCacheURL
DimensionsInterviewUrl
FileManagerWebserviceUrl (must always be changed if users need to activate projects over
the internet using the Promote Project activity)
DefaultCluster

E In Windows Explorer, navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb and remove the read-only property on the Web.config file.

E Open Web.config.
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E Locate the section that adds the ImageCacheURL key and change the value of this key to use a
fully qualified domain name:

<appSettings>
<add key="ImageCacheURL" value="http://SERVER.DOMAIN.COM/SPSSMR/ImageCache/ImageCache.aspx"/>

</appSettings>

E Save your changes and close the file.

E Navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Code\Tools\VB.NET\DPM
Explorer.Net and double click DPMExplorer.exe.

This opens the DPM Explorer window.

E In the left-hand frame expand the main site entry and click the Properties entry.

A list of site properties is displayed in the upper right-hand frame.

E Do the following for the DimensionsInterviewUrl and FileManagerWebServiceUrl properties
and, if necessary, for InterviewUrl.

Click the property name or value.
This displays the property’s value in the lower right-hand frame.
In the lower right-hand frame, replace the machine name with the fully qualified machine
name and click Apply.
This updates the entry in the upper right-hand frame.

E If the Web Service cannot communicate with the Interviewing Engine Service using a basic
machine name, update the DefaultCluster property as follows:

In the left-hand frame click the Clusters entry.
In the DefaultCluster property, replace the value of WEBSERVERLIST with a fully qualified
domain name, for example:
DBSERVER&=&MyDbServer&;&DBDRIVER&=&SQL
Server&;&IVSERVERLIST&=&MyIntServer&;&WEBSERVERLIST&=&ServerName.DomainName.com&;&
Security=SSPI;Initial Catalog=mrInterviewData;Data Source=MyServerName;

E Close DPM Explorer.

Fully qualified machine names and IBM SPSS Data Collection Survey Reporter Server Edition/IBM
SPSS Data Collection Author Server Edition

When a fully qualified machine name is used to access IBM® SPSS® Data Collection Survey
Reporter Server Edition or IBM® SPSS® Data Collection Author Server Edition on an IBM®
SPSS® Data Collection Interviewer Server the Survey Reporter Server Edition/Author Server
EditionStartURL will need to be changed (via DPM) to the fully qualified machine name in order
to prevent connection issues. Do not use a relative URL when updating the StartURL value.

Cancelling the requirement for mrIEngWS to use a secure channel

If your web site uses SSL you will need to cancel the requirement for mrIEngWS to use a
secure channel.
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E From Control Panel select:
Administrative Tools > Internet Information Services

This opens the Internet Information Services window.

E In the left-hand frame, navigate to the Web site through which users will access IBM® SPSS®
Data Collection Interviewer Server. Then right-click on the web site name and select Properties.

This opens the Web Site Properties dialog box.

E Right-click mrIEngWS and select Properties.

E In the Secure communications frame, click Edit.

This opens the Secure Communications dialog box.

E Cancel Require secure channel (SSL) and click OK.

E Close IIS.

Things you must do if they are not done automatically
Register the Interview Service machines with the Web Service machines
Start mrUserAdminServer and mrDPMServer3 if they are not already running
Check that access permissions are set correctly for FMRoot and all its subfolders

Registering Interview Service machines with Web Service machines

When installing the Interview Service, the installer registers the Interview Service machine with
all machines currently running the Web Service. If you install the Interview Service before you
have installed IBM® SPSS® Data Collection Interviewer Server on all your Web servers, the
registration of that Interview server with the Web servers cannot take place. When this happens
you will need to register the Interview Service machine manually. There are two ways of doing
this.

Either:

E Reboot each Interview Service machine that you want to register.

Or:

E On each Interview Service machine to be registered, navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\Server and run
RegIntSvr.exe.

Starting mrUserAdminServer and mrDPMServer3

The installation process normally starts mrUserAdminServer and mrDPMServer3 on all machines
running the Interviewing Service. Take the following steps to check whether the services are
running and, if necessary, to start them.
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E Open Control Panel and choose:
Administrative Tools > Services

This opens the Services dialog box.

E In the list of services check that both services are running.

E If a service is not running, right-click on it and choose Start.

If neither service is running, you should start mrUserAdminServer followed by mrDPMServer3.

A dialog box reports progress of the start-up procedure.

Access permissions for FMRoot and its subfolders

Every folder has an Access Control List (ACL) that determines which users and groups can
access the folder and what they can do with it. The installation procedure sets access permissions
for the FMRoot folder and all its subfolders so that all members of the IBM® SPSS® Data
Collection group have access to those folders. However, a problem with the Windows operating
system means that occasionally these permissions are not stored in the correct order and that the
permissions for the Dimension group will be ineffective. If this happens, users may see messages
such as “The application was unable to resolve the path to the shared project files for the selected
project.” when they use IBM® SPSS® Data Collection Interviewer Server Administration
activities that access one of the FMRoot subfolders.

To avoid this problem, take the following steps.

E For each subfolder within FMRoot, right-click on the folder name and choose “Sharing and
Security”.

This opens the Properties dialog box for that subfolder.

E Select the Security tab.

If the permissions are stored in the wrong order, you will see the following message box:
Figure 3-2
Security message box when an FMRoot folder has an ACL problem

E To correct the ACL for this folder, click OK as directed.

E Select the entry for the Data Collection group and check that it has Full Control for the current
folder. If not, set this permission and click OK.

If you want further information about the Windows problem, refer to
http://support.microsoft.com/?id=834721 (http://support.microsoft.com/?id=834721)
and http://support.microsoft.com/default.aspx?scid=kb;en-us;322293
(http://support.microsoft.com/default.aspx?scid=kb;en-us;322293)

http://support.microsoft.com/?id=834721
http://support.microsoft.com/default.aspx?scid=kb;en-us;322293
http://support.microsoft.com/default.aspx?scid=kb;en-us;322293
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Optional tasks
Add indexes to any existing sample tables to improve performance
If your site uses telephone interviewing, increase the size of the appRequestQueueLimit
setting for the .NET Framework.
If your site uses telephone interviewing, change the thread configuration settings for the
interviewing engine and the .NET Framework to avoid requests beings queued due to blocked
thread pools.
Install the Load Tool
Configure the IBM® SPSS® Data Collection Interviewer Server Administration Email activity
Increase the number and/or size of the log files
Create a hosts file that will allow IBM® SPSS® Data Collection Interviewer Server services
to communicate across a firewall
Set up your Web site to use SSL
Change the Interview Engine load balancing algorithm used to distribute interviews to the
Interview Service machines
In cluster installations, modify the TCP/IP registry settings on machines running the Interview
and Web Services
If you are using SQL Server 2005 or 2008 and a named instance, edit
SampleMgtGUI.Config.xml to control the servers available to the Participants and Activate
activities
If you are upgrading from a previous version of IBM SPSS Data Collection Server, and you
want to query your old log files (from the Manage Logs activity for example), copy the old
logs from the previous version’s log directory to the new IBM SPSS Data Collection Server
6 log location (by default, [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server Administration\Logs).
Install the IBM® SPSS® Data Collection Developer Library

Adding indexes to sample tables

IBM® SPSS® Data Collection Interviewer Server indexes any sample tables that it creates to
provide improved performance on projects that use sample management. If you create sample
tables manually outside Interviewer Server, you can set the same indexes manually on those
tables to achieve the same performance gains. If you have sample tables created with Interviewer
Server\mrInterview 3.1 or earlier you may wish to add the indexes to those tables too.

You can also use these instructions as guidelines if you want to index new fields that you add to
sample tables.

E Start the SQL query analyzer as follows:

If you are using SQL Server 2005 or 2008, open SQL Server Management Studio and select the
New Query feature.

E Connect to your Interviewer Server database server.
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E In the drop-down list of databases, select the sample database whose table or tables you want to
index.

E In the Query window, type the following commands. You will need to repeat the commands for
each sample table you have created manually.

For tables that are used for Web (inbound) and/or telephone interviewing (outbound) projects:
CREATE NONCLUSTERED INDEX Name_idx_id_active ON TableName (Id, Active)
CREATE NONCLUSTERED INDEX Name_idx_queue ON TableName (Queue)
CREATE NONCLUSTERED INDEX Name_idx_active ON TableName (Active)

Tables that are used for telephone interviewing projects need the following additional indexes:
CREATE NONCLUSTERED INDEX Participants_idx_id_active ON (Id, Active)
CREATE NONCLUSTERED INDEX Participants_idx_queue_sortid ON SampleTableName (Queue, SortId, ExpirationT
CREATE NONCLUSTERED INDEX Participants_idx_queue_appointmenttime ON SampleTableName (Queue, Appointmen
CREATE NONCLUSTERED INDEX Participants_idx_queue_recalltime ON SampleTableName (Queue, RecallTime, Ex

E If you also wish to index the associated history tables, type the following for each history table
in the database:
CONSTRAINT Participants_ProjectName_HistoryTable_pk PRIMARY KEY CLUSTERED (Id)
CREATE NONCLUSTERED INDEX Participants_ProjectName_HistoryTable_idx ON SampleTableName (SampleId)
CREATE NONCLUSTERED INDEX Participants_ProjectName_HistoryTable_idx_starttime
ON SampleTableName (StartTime)

E Press F5 or click Execute Query (the green triangle).

E If you have sample tables in more than one database, select the next database from the drop-down
list and repeat these commands for the tables in that database.

E Save your changes and exit.

Increase the size of appRequestQueueLimit in the .NET framework

Each virtual directory on your Web server has a queue that stores requests to be passed from IIS to
the .NET Framework (ASP.NET). If an application’s queue becomes full, users see the HTTP
503, Server is busy, message and the queue starts to rejects requests. If your site uses telephone
interviewing, you should consider increasing the queue size to prevent the Phone activity flooding
its queue with requests. This change is strongly recommended, especially if you have many
interviewers working at the same time.

E On each machine running the Web Service, navigate to
c:\Windows\Microsoft.Net\Framework\v2.0.50727\CONFIG and open machine.config.

E Locate the line that starts <httpRuntime ...> (it is near the beginning of the file) and change the
value of the appRequestQueueLimit attribute from 100 to 1000.

E In the <system.web> section, add the following settings or edit your existing settings so that they
contain the designated properties and values.
<system.web>

<httpRuntime minFreeThreads="88" minLocalRequestFreeThreads="76" appRequestQueueLimit="1000"/>
<processModel autoConfig="false" maxWorkerThreads="100" maxIoThreads="100"/>

</system.web>

E Save your changes and close the file.
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For more detailed information about this change, refer to pages 818 and 819 of
http://download.microsoft.com/download/a/7/e/a7ea6fd9-2f56-439e-a8de-024c968f26d1/ScaleNet.pdf
(http://download.microsoft.com/download/a/7/e/a7ea6fd9-2f56-439e-a8de-024c968f26d1/ScaleNet.pdf).

Changing thread configuration settings for the .NET framework

This topic applies only to sites that run telephone interviews.

When a telephone interviewer requests a number to call, the Phone activity requests one from the
sample management system. If the system does not have enough resources allocated for dealing
with these requests, the requests will be queued and interviewers will have to wait longer than
necessary to receive numbers. You can reduce the likelihood that this will happen by increasing
the resources available for processing requests.
Make the following changes on each machine running the Phone Participants activity or the

Interviewing Service

For machines running the Interviewing Service

E From the Windows Start menu, choose Run.

E In the Run dialog box, type regedit and click OK.

E Step down through the hierarchy to
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Interviewing.

E Right-click in the right-hand frame, select New, DWORD value, and enter DefaultThreadPoolSize
as the value name.

E Right-click this new entry and select Modify.

E In the Edit DWORD Value dialog box, type 200 as the value and choose Decimal as the base. Click
OK to save your changes.

Note: You do not need to set this value if the server has eight or more logical processors.

E Close Registry Editor.

For machines running the Phone Participants activity or the Interviewing Service

E Navigate to c:\Windows\Microsoft.Net\Framework\v2.0.50727\CONFIG and open
machine.config.

E In the <system.web> section, add the following settings or edit your existing settings so that they
contain the designated properties and values.

<system.web>
<httpRuntime minFreeThreads="88" minLocalRequestFreeThreads="76"/>
<processModel autoConfig="false" maxWorkerThreads="100" maxIoThreads="100"/>

</system.web>

E In the <system.net> section, add the following settings or edit your existing settings so that they
contain the designated properties and values.

http://download.microsoft.com/download/a/7/e/a7ea6fd9-2f56-439e-a8de-024c968f26d1/ScaleNet.pdf
http://download.microsoft.com/download/a/7/e/a7ea6fd9-2f56-439e-a8de-024c968f26d1/ScaleNet.pdf
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<system.net>
<connectionManagement>

<add address="*" maxconnection="100"/>
</connectionManagement>

</system.net>

E Save your changes and close the file.

Installing the IBM SPSS Data Collection Load Tool

IBM® SPSS® Data Collection Interviewer ServerIBM® SPSS® Data Collection Load Tool
is a program that can be run to test Interviewer Server performance in various scenarios. It is
particularly useful for simulating live interviewing across a number of projects that are running
simultaneously, where it can highlight potential problems with system loading before the projects
go live. It can also be used it to test and evaluate the effect of changes in your system configuration
before implementing them.

The Load Tool is an installation option on the IBM SPSS Data Collection Server installation
DVD-ROM. You can install the Load Tool on any machine, but a machine outside the Interviewer
Server cluster is best. For further information about the Load Tool, refer to “Load Testing” in
IBM® SPSS® Data Collection Developer Library.

E Launch the IBM SPSS Data Collection Server installation program.

E Click Next on the Welcome page.

E On the License Agreement page, click Yes and click Next.

E On the Select Features page, select Load Tool (located under Interviewer Server -> Utilities),
and click Next.

E The Choose Destination Location page shows where the files for the Load Tool will be installed.
To accept the default location just click Next. To install into a different location, click Browse and
then browse to the folder you want to use (you may create a new folder if necessary). Click OK to
close the Choose Folder dialog and then click Next to continue.

E On the Start Copying Files page, click Next.

E The Setup Status page reports installation progress.

E Click Next on the Setup information page.

E When the installation has finished, choose whether to restart your machine now or later and click
Finish. If you want to run the post-installation steps straight away you must restart your machine
now.
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Configuring the IBM SPSS Data Collection Interviewer Server Administration Email activity

The installation procedure asks whether you want to configure the IBM® SPSS® Data Collection
Interviewer Server Administration Email activity as part of the installation process. If you choose
not to do this, or the automatic configuration fails, you can perform the configuration manually
as follows:

E In Windows Explorer, navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Code\Tools\VB.NET\DPM
Explorer.Net and double click DPMExplorer.exe.

DPMExplorer is installed as part of the IBM® SPSS® Data Collection Developer Library which
you can install from the IBM SPSS Data Collection Server installation CD. For more information,
see the topic Installing the IBM SPSS Data Collection Developer Library on p. 73.

E Expand the site entry and then select the Properties entry.

You should see properties called EmailServerName and EmailServerPort in the right-hand frame.

E If the properties exist but have no values, define their values as follows:
Select the property.
In the lower frame on the right of the screen, type the appropriate value and click Apply. The
property’s value is displayed in the upper right-hand frame.

E If the properties are not present, choose:
Add > Property

and enter the property’s name and value in the dialog box displayed.

E Close DPM Explorer.

Changing the number and/or size of the log files

IBM® SPSS® Data Collection Interviewer Server records the actions that it takes during each
interview, and any problems it encounters, in a series of log files. When a log file reaches 4Mb
in size, Interviewer Server closes that file and starts a new one. When the tenth file reaches its
maximum size, Interviewer Server starts overwriting the first log file in the set.

Depending on the amount of logging information you want to retain, you can increase the number
of log files that Interviewer Server creates before it starts overwriting existing files, or you can
increase the maximum size of each file. In general, it is better to increase the number of log files
used rather than the size of each file. Log files that will be opened in DM Query should not
be larger than 4Mb.

The MaxFiles and MaxFileSizeInKB keys that control logging behavior are defined in the
following locations in the registry:
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\Log
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\3\Log
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\MRPropertyManagement\2.0\Log
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\MRPropertyManagement\2.0\Security\Auditing
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Note: Any changes you make must be made in all locations since you cannot be sure which
application will start the logging component. For consistency, they should also be made on all
machines running the Interviewing and Accessories Services.

To Change the Maximum Number of Log Files and/or the Maximum Log File Size

E From the Windows Start menu, choose Run.

E In the Run dialog box, type regedit and click OK.

E Step down through the hierarchy to the appropriate location.

E In the right-hand frame, right-click on the key you want to change and choose Modify.

E On the Edit DWORD Value dialog box, enter the new value.

E Close the Registry Editor.

Creating a Hosts file for running IBM SPSS Data Collection Interviewer Server through a firewall

If you have installed IBM® SPSS® Data Collection Interviewer Server in a non-domain
environment, you may find that machines that communicate using machine names rather than IP
addresses cannot communicate across the firewall. If this happens, create a hosts file on those
machines linking the machine names with the machines’ IP addresses.

Setting up your Web site to use SSL

You can increase the security of the Web site that provides access to IBM® SPSS® Data
Collection Interviewer Server by using the Secure Sockets Layer (SSL) which encrypts Web
documents passed to and from the site. This topic explains how to set up and enable SSL, and
how to ensure that IBM® SPSS® Data Collection Interviewer Server Administration always
creates interview URLs that use SSL.

Note: It is not currently possible to configure the Interview Tier web service to use SSL.

Creating a Server Certificate

E From Control Panel select:
Administrative Tools > Internet Information Services

This opens the Internet Information Services window.

E In the left-hand frame, navigate to the Web site through which users will access Interviewer
Server. Then right-click on the web site name and select Properties.

This opens the Web Site Properties dialog box.

E On the Directory Security tab, click Server Certificate.

This starts the IIS Certificate Wizard.

E On the Welcome page, click Next.
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E On the Server Certificate page, select Create a new certificate and click Next.

E On the Delayed or Immediate Request page, click Prepare the request now, but send it later and
click Next.

E On the Name and Security Settings page, enter the name of your web site. (You can enter any
name you like here, but it is a good idea to enter a name that can be recognized later.) Click Next.

E On the Organization Information page, enter a name of your choice in both fields and then click
Next.

E The Your Site’s Common Name page should show the correct computer name for the chosen
web site, so click Next to continue.

E On the Geographical Information page, complete the fields as appropriate.

E Click Next on all other pages until you reach the end of the wizard. Then click Finish to return to
the Web Site Properties dialog box.

E In the Secure communications frame, click Edit.

This opens the Secure Communications dialog box.

E Select Require secure channel (SSL) and click OK.

E Close IIS.

E The certificate used for SSL must be trusted on the local machine. To check this, proceed as
follows:

Open Internet Explorer and select:
Tools > Internet Options

On the Content tab click Certificates.
On the Certificates dialog box, select the Trusted Root Certification Authorities tab and check
that the certificate for SSL appears in the list.
If the certificate does not appear in the list, click Import to run the Certificate Import wizard
which will add the certificate to the list.
Close Internet Explorer.

E Follow the instructions in Cancelling the Requirement for mrIEngWS to use a Secure Channel

E If your SSL certificate is assigned to a fully qualified domain name, change the value of the
LocalImageCacheURL setting in the Web Service’s Web.config file so that it uses the fully
qualified domain name. Perform the following steps on all machines running the Web Service.

In Windows Explorer, navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\Server\mrIWeb and
open Web.config using Visual Studio or a text editor.
Change the entry for LocalImageCache so that it reads something like:

<add key="LocalImageCacheURL"value="https://www.FQDomainName.com/SPSSMR/ImageCache/ImageCache.aspx"/>

Save the change and close the file.
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Changing the interview engine load balancing algorithm

The interview engine load balancing algorithm tries to ensure that interviews are evenly distributed
across machines running the Interviewing Service. If you find that the default algorithm does
not suit your requirements you may change it.

Refer to “Load Balancing Interviewing Engines” in the IBM® SPSS® Data Collection Interviewer
Server section of the IBM® SPSS® Data Collection Developer Library documentation for further
information about this facility and examples of load balancing algorithms based on different
criteria.

Changing the load balancing algorithm for distributing interviews

Perform the following steps on each machine running the Interview Service.

E Make a copy of the file [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\defaultload.mrs.

E Edit the copy of the script to implement the type of load balancing you require.

E Change the registry key
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\LoadBalancing\LoadBalancingScript
so that it has the full path to the new script file as its value.

E Stop and restart IIS. If you are running Windows 2003, you can stop and restart the Interviewer
Server application pool (usually SPSSmrnterviewPool) rather than restarting IIS if you prefer.
This has the advantage of not affecting any other applications that may be using IIS.

Modifying TCP/IP registry settings on Interview and Web servers in a cluster

Note: These instructions are only intended for use with Interview and Web servers. The settings
outlined in this topic should not be employed in any other environment.

In cluster installations, if the Interview or Web servers run out of available ports, interviews will
fail. An indication that a server is failing because of insufficient available socket ports is the
following message in the IVW logs:

Error calling WS method 'Method'. URL 'URL', Error codes: Client 5, HTTP -1, SOAP 0, TCP 10048

You can prevent this from happening by changing either of
the following settings for TCP/IP in the Windows registry
(HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters):

Increase the port range that is used for anonymous ports to approximately 20000 ports (for
example) by modifying the MaxUserPort registry key.
Change the connection time-out set in TcpTimedWaitDelay from the default 240 seconds to
anything from 30 to 300 seconds.
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Refer to the Microsoft Knowledge Base Article 319502 at
http://support.microsoft.com/kb/319502/en-us/ (http://support.microsoft.com/kb/319502/en-us/)
for more information on changing these settings.

Naming servers available to the Participants and Activate activities

This task applies only to sites running SQL Server and a named instance.

When the Participants and Activate activities generate the selection list for the Server field, they
do not include named instances. Users can normally choose an unlisted server simply by typing its
name in the input box. However, this does not work for named instances. To avoid this situation it
is best to restrict users to choosing from a predefined list of server names only.

The names of available servers and access rights to those servers are defined the
SampleMgtGUI.Config.xml file. To restrict the servers that can be chosen in Participants and
Activate edit the file as follows:

E Navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\FMRoot\Shared\Config and open SampleMgtGUI.Config.Xml using a text editor of your
choice.

E Locate the <SampleManagementGUI> tag and add the showexistingonly="false" attribute
as follows:

<SampleManagementGUI showexistingonly="false">
...

</SampleManagementGUI>

E Save your changes and close the file.

For further information about SampleMgtGUI.Config.xml refer to “Controlling Access to Sample
Data” in the IBM® SPSS® Data Collection Developer Library.

Modifying the default Web service settings for IBM SPSS Data Collection Remote Administration

If you have installed IBM® SPSS® Data Collection Remote Administration, you may
want to modify the default Web service settings that control synchronization between
remote interviewers and the Remote Administration. You can change the Web service
settings by editing the web.config file. By default, the web.config file is found in
C:\InetPub\wwwroot\SPSSMR\SyncWebService\web.config.

Property Description
DPMServerName Name of the DPM server machine. If the server is located on a remote machine,

change this value to that machine’s name.
Default Value: localhost

inbox Location of the SyncWebService inbox. If IBM® SPSS® Data Collection
Interviewer Server Administration was not installed in the default location of
C:\InetPub\wwwroot\SPSSMR, change this value to a complete file path that the
anonymous user has read/write access to.
Default Value: C:\InetPub\wwwroot\SPSSMR\SyncWebService\inbox

http://support.microsoft.com/kb/319502/en-us/
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ShouldHostTransferService Indicates whether IBM® SPSS® Data Collection Interviewer Server should host
a transfer service specifically for the Remote Administration. This is unnecessary
if Interviewer Server is being used on this cluster for Web or CATI interviews,
as Remote Administration will employ the same transfer service. However, if
Interviewer Server will not be used on this cluster for Web or CATI interviews,
set this value to True.
Default Value: False

PrincipalSyncWebService Indicates that the SyncWebService instance is a proxy for the specified service. By
default, this setting is commented out. To set the property, remove the comment
markers and replace the default value with the actual path to the principal service.
Note that if this line is uncommented, all other Web service settings specified in
the current web.config file are ignored.
Default Value: http://your-principal-server/SPSSMR/SyncWebService/SyncWeb-
Service.asmx

Installing the IBM SPSS Data Collection Developer Library

For more information, see the topic Installing the IBM SPSS Data Collection Developer Library
in Chapter 4 on p. 104.

Things you must do on local machines
If Phone Reports users will need to create charts, enable the charting facility
Enabling pop-ups and file downloads
Enable the Internet Explorer security setting “Allow websites to open windows without
address or status bars”.
Set up automatic Windows login for IBM® SPSS® Data Collection Interviewer Server
Administration users who use the Firefox browser
For users who will run Interviewer Server Administration using the Firefox browser on the
WYSE 5150SE, increase the default font size in Firefox

Adding DCOM permissions for scriptwriters to LogBckO2

If you have installed the Scriptwriter Service onto individual scriptwriters’ machines, and those
scriptwriters will be logging in using an account other than that of the installing user, you should
add DCOM permissions for the machine’s Users group to LogBckO2. This will prevent access
problems if the scriptwriter works on projects that use quota control.

E From the Windows Start menu, choose Run.

E Type dcomcnfg in the text box and click OK.

E In the left-hand frame expand the display to show the following hierarchy: Component Services >
Computers > My Computer > DCOM Config.

E In the left-hand frame, right-click LogBck02 and select Properties.

This opens the LogBckO2 Properties dialog box.

E Select the Security tab.
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E In the Access Permissions frame click Edit.

This opens the Launch Permissions dialog box.

E Click Add.

This opens the Select Users, Computers or Groups dialog box.

E In “Enter the object names to select”, type MachineName\Users, where MachineName is the
name of the scriptwriter’s machine.

E Click OK to save the change and then close dcomcnfg.

Enabling charts in the Phone Reports activity

The charting feature in IBM® SPSS® Data Collection Interviewer Server Administration is
disabled by default. Before enabling this feature for any user it is your responsibility to verify
that the said user is appropriately licensed for MS Office Web Components (OWC). Check
your MS OWC license agreement or EULA.

To enable the charting feature, you need to carry out the following steps:

1. Run the Chart Configuration program that is installed with IBM SPSS Data Collection Desktop
6.

2. Enable access to charts for users and roles.

Running the chart configuration program

E Use Windows Explorer to locate the executable file ChartConfiguration.exe. By default, this is
installed in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server Administration.

E Double-click the file name to run the program, then check the Display Charts in Interviewer Server
Administration box and click OK.

Enabling access to charting for users and roles

After running the chart configuration program, you can enable access to charting for users in a
particular role, so that only correctly licensed users are able to access it. You may find that you
need to create a separate role for these users. For more information, see the topic Adding roles
on p. 57.

E In Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E In the left frame, click Activities.

E Depending on the application, expand the Phone, IBM® SPSS® Data Collection Survey Reporter,
or IBM® SPSS® Data Collection Survey Tabulation activity, then expand the Features option.
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E Select the Can display charts feature.

A frame appears on the right of the page listing the roles currently assigned to this feature.

E Click Add/Remove.

This opens the Add Role dialog box.

E Choose the roles you want to assign to the feature and click OK.

Enabling pop-ups and file downloads

If the browser that is running IBM® SPSS® Data Collection Interviewer Server Administration
and IBM® SPSS® Data Collection Interviewer Server has pop-up blockers or restrictions on
downloading files, users will encounter problems with activities that make use of these features.
In order for Interviewer Server to work as intended pop-ups and file downloads should be enabled.

Enabling pop-ups

E In Internet Explorer, select:
Tools > Pop-up blocker > Pop-up blocker settings

E Add the name of the machine that is running Interviewer Server to the settings.

Enabling file downloads

E Follow the instructions that the browser provides the first time it is unable to download a file. The
changes made at this point enable all subsequent file downloads in Interviewer Server.

For example, when a user runs Export Data and chooses to download the exported data onto
his/her computer, the export process will run but will display a message in the browser’s
information bar saying that Internet Explorer has blocked the site from downloading files onto
the computer. To allow file downloads, the user should click on the location indicated in the
message to display options for enabling downloads.

Enabling the Internet Explorer security setting “Allow websites to open windows without address
or status bars”

If the browser that is running IBM® SPSS® Data Collection Interviewer Server Administration
or IBM® SPSS® Data Collection Interviewer Server displays a URL field for each dialog, you
will need to enable the Internet Explorer Allow websites to open windows without address or
status bars security setting.

Enabling the Security Setting

E In Internet Explorer, select:
Tools > Internet Options > Security > Custom level...

E Select the Enable option under the Allow websites to open windows without address or status
bars setting.
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Enabling automatic Windows login to IBM SPSS Data Collection Interviewer Server
Administration for Firefox

IBM® SPSS® Data Collection Interviewer Server Administration users who are using the Firefox
browser can login into Interviewer Server Administration automatically using their Windows
login credentials. However, this does not happen until users have logged into Interviewer Server
Administration manually at least once using these credentials. Users can avoid this by carrying out
the following tasks before using Interviewer Server Administration with Firefox for the first time.

E In Firefox, type about:config into the URL address bar.

This displays a list of configurable options.

E In Filter, type network automatic.

A reduced list of options is displayed.

E Double-click network.automatic-ntlm-auth.trusted-uris and then type the name of the Interviewer
Server Administration server. If your site has more than one Interviewer Server Administration
server, type a list of names separated by commas.

Changing font settings for Firefox on Wyse 5150SE terminals

The default font settings in the Firefox browser produce very small text in IBM® SPSS® Data
Collection Interviewer Server Administration when used on Wyse 5150SE terminals. You will
probably want to change these settings to make the Interviewer Server Administration text more
readable. Suggested settings are as follows:

Proportional Serif, 15 pixels
Serif Luxi Sans
Sans-serif Luxi Sans
Monospace Luxi Sans 13 pixels

E In Firefox, select
Edit > Preferences > Fonts & Colors

E Make whatever font changes you think are necessary to produce readable text.

Installing IBM SPSS Data Collection Interviewer Server for off-line use

The notes in this section summarize how to use the installation procedure to install a version of
IBM® SPSS® Data Collection Interviewer Server that will work whether or not your laptop
is connected to a network.
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If you install Interviewer Server onto a single machine using the default Domain option, you will
find that Interviewer Server works properly when you are logged in to your local network, but
not when your are using your laptop in standalone mode. The problems you will encounter
are as follows:

UNC pathnames are not resolved, so applications cannot access the FMRoot folder.
Domain user accounts cannot be authenticated.

The recommended procedure for installing Interviewer Server when you want to work attached to
a network or off-line is to install a single machine workgroup version of Interviewer Server and
then carry out the following post-installation tasks:

E Navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Code\Tools\VB.Net\DPMExplorer.Net
and double-click DPMExplorer.exe.

E In the left-hand frame, click Properties.

E In the upper right-hand frame, click FileMgt_RootFolderUNC.

The property’s value is displayed in the lower right-hand frame.

E In the lower right-hand frame, replace the pathname with
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\FMRoot.

E Select InterviewCacheUNC and replace the pathname with
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\FMRoot\Interview\Cache.

E Select Brad_Backup_UNC and replace the pathname with
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\FMRoot\Shared\Backup.

E Click Apply and close DPM Explorer

E To be able to access images held in the image cache, edit the file
\InetPub\wwwroot\SPSSMR\ImageCache\Web.Config and change the setting of the
BASE_LOCATION key so that it points to the Master folder:

<AppSettings>
<add key="BASE_LOCATION"

value="[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\FMRoot\Master" />
</AppSettings>

E Log in to IBM® SPSS® Data Collection Interviewer Server Administration using the DPM
Administrator account that you specified during installation.

E If you want to be able to log into Interviewer Server Administration using a user name other than
that of the DPM administrator, start User Administration and add this user. Make the user a
member of the DPMAdmins role to ensure that the user has unrestricted access to all applications,
application features, and files.

E Open the Services Manager and stop the Load Balancing service if it is running.
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The Load Balancing service is used for clustering the Accessories servers and is not necessary for
a single machine. If you try to start Interviewer Server Administration and your URL changes to
http://server1/... then you know that the Load Balancing service is running.

Improving stability when running IBM SPSS Data Collection Interviewer Server
Administration off-line

If you have installed any of the IBM SPSS Data Collection Server applications for off-line use
you may find that installing the Microsoft Loopback Adapter improves stability when running
off-line. When you install the Loopback Adapter, it becomes the first connection in the binding
order that determines the order in which connections are accessed by DNS. If you regularly
connect to a LAN and only occasionally run IBM® SPSS® Data Collection Interviewer Server
Administration off-line, you may wish to move the Loopback Adapter below your regular LAN
connection in the binding order.

Installing the Microsoft Loopback Adapter on Windows XP and Windows 2003/2008

E From the Control Panel, go to Add Hardware. This starts the Add Hardware wizard.

E On the Welcome page, click Next.

E On the Is the hardware connected? page, choose Yes, I have already connected the hardware and
then click Next.

E On the next page, scroll to the end of the hardware list and select Add a new hardware device.
Then click Next.

E On the next page, select Install the hardware that I manually select from a list (Advanced) and then
click Next.

E The next page displays a list of common hardware types. Select Network Adapters. Then click Next.

E On the Select Network Adapter page, select Microsoft Loopback Adapter. Then click Next.

E Click Next to start the installation procedure.

Changing the binding order of the network adapters

E From the Control Panel, go to Network Connections (or right-click the Network icon on your
desktop and choose Properties). This opens the Network Connections window.

E Choose:
Advanced > Advanced Settings

E This opens the Advanced Settings dialog box. The Loopback Adapter you have just installed
should be highlighted in the Connections frame.

E Click the green down-arrow next to this frame to move the adapter at least one place down. Your
default Local Area Connection will be at the top of the list again.
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IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data
Collection Survey Reporter Server Edition, and IBM SPSS Data
Collection Author Server Edition installation overview

To install IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data Collection
Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server Edition:

E If you have not already done so, verify you have the correct hardware and software:
See What you need to run the IBM SPSS Data Collection Server 6 applications to verify you
meet the minimum hardware and software requirements.
If necessary, install the required software.

E Create the users and the user group. For more information, see the topic Creating the users and the
user group on p. 86.

E If running Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition through a
firewall, open ports on the firewall.

E Install Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition. For more
information, see the topic Installing IBM SPSS Data Collection Survey Tabulation, IBM SPSS
Data Collection Survey Reporter Server Edition, or IBM SPSS Data Collection Author Server
Edition on p. 91.

E Carry out any post-installation steps necessary for your installation.

For a full checklist of these steps, see Checklist for IBM SPSS Data Collection Survey Tabulation,
IBM SPSS Data Collection Survey Reporter Server Edition, and IBM SPSS Data Collection
Author Server Edition installation.

© Copyright SPSS Inc. 2000, 2010 79
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Checklist for IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection
Survey Reporter Server Edition, and IBM SPSS Data Collection Author Server Edition
installation

Pre-installation checks

Check hardware and software requirements

Install required software

Microsoft .NET Framework 3.5 SP1

Microsoft Data Access Components 2.8

Internet Explorer 6.0 or above, including MS XML 4.0 SP3 add-in

Internet Information Services

SQL Server
Microsoft .NET Framework 3.5 SP1 (only on machines running IBM® SPSS® Data Collection Survey Reporter
Server Edition or IBM® SPSS® Data Collection Author Server Edition).
Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit) (only on machines running Survey Reporter
Server Edition or Author Server Edition).

Create users and groups

Create installing user

Create running user

Create anonymous access user
Create IBM® SPSS® Data Collection Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
group

Open ports on firewall
If running Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition through a firewall, open
ports on the firewall

Installation

Install Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition

Post-installation

Enable access to charting

Set up users and roles in IBM® SPSS® Data Collection Interviewer Server Administration

Add ASP.NET account to launch permissions on Logbck02

Allow remote access on Windows XP Service Pack 3
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Check Internet Explorer settings
If installing onto a machine with IBM® SPSS® Data Collection Base Professional, add Base Professional users to
the IBM® SPSS® Data Collection group.

If using an SSL accelerator, set up Interviewer Server Administration to use SSL accelerators

Set up Interviewer Server Administration load balancing

Set up shared variable cache folder for load balanced systems
If using Windows 2003, enable Survey Tabulationand DimensionNet load balancing between multiple IIS worker
processes

Set up Interviewer Server Administration to reject new sessions when the server is busy

Start mruserAdminServer and DPMServer3

If using SSL, configure your browser to save encrypted pages to disk

Set up projects in Interviewer Server Administration

Install IBM® SPSS® Data Collection Developer Library

IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey
Reporter Server Edition, and IBM SPSS Data Collection Author Server Edition
installation scenarios

There are several distinct installation scenarios. The installation procedure varies for each of
these scenarios.

Installing Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition with Interviewer
Server. You can install IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data
Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition with IBM® SPSS® Data Collection Interviewer Server on a single machine or on a
cluster. When installing Interviewer Server on a cluster, install Interviewer Server on all of the
machines in the cluster first. You can then install Survey Tabulation, Survey Reporter Server
Edition, or Author Server Edition on one or more machines in the cluster or on one or more other
machines that will become part of the cluster. The configurations that are supported are the
same as described in the Interviewer Server System Configurations topic in the IBM SPSS Data
Collection Interviewer Server Installation Instructions.

When you install Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
onto an Interviewer Server Accessories server, the installation detects the presence of the
existing DPM Server and will automatically connect Survey Tabulation, Survey Reporter Server
Edition, or Author Server Edition to it. When you install Survey Tabulation, Survey Reporter
Server Edition, or Author Server Edition onto a server that does not have the Interviewer Server
Accessories service installed, you should check the Connect to an Existing Survey Tabulation/Survey
Reporter Server Edition/Author Server Edition or Interviewer Server server box on the Cluster Settings
screen, and when subsequently prompted, enter the names of the machines on which the DPM
Server and the SQL Server are installed. Note that you cannot install Survey Tabulation, Survey
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Reporter Server Edition, or Author Server Edition onto an Interviewer Server Interview Service
machine unless it also has the Interviewer Server Accessories service installed.

Single-machine installation of Survey Tabulation, Survey Reporter Server Edition, or Author Server
Edition without Interviewer Server. You can install Survey Tabulation, Survey Reporter Server
Edition, or Author Server Edition without Interviewer Server in a single-machine installation. In a
single machine installation, the SQL Server can either be located on the same machine or on a
different machine in the same domain or workgroup.

When installing Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
without Interviewer Server, run the installation in the normal way, making sure you uncheck
the Connect to an Existing Survey Tabulation/Survey Reporter Server Edition/Author Server Edition
or Interviewer Server server option on the Cluster Settings screen. You will be prompted for the
name of the SQL Server machine.

Clustered installation of Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
(without Interviewer Server). You can install Survey Tabulation, Survey Reporter Server Edition, or
Author Server Edition on two or more machines in a cluster. When you do this, SQL Server is
required on only one of the machines in the cluster (this machine can optionally be a separate
machine from those on which Survey Tabulation, Survey Reporter Server Edition, or Author
Server Edition is installed). When you are installing onto machines in different domains, the
domains must trust one another (that is, be bi-directional).

When you install Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
on the first machine in the cluster, make sure you uncheck the Connect to an Existing Survey
Tabulation/Survey Reporter Server Edition/Author Server Edition or Interviewer Server server option on
the Cluster Settings screen. You will then be prompted for the name of the machine on which SQL
Server is installed. When you install the other machines, check the Connect to an Existing Survey
Tabulation/Survey Reporter Server Edition/Author Server Edition or Interviewer Server server option on
the Cluster Settings screen and when subsequently prompted for the names of the DPM Server
and the SQL Server, enter the names of the machine on which you installed Survey Tabulation,
Survey Reporter Server Edition, or Author Server Edition first and the SQL Server machine.

Installations onto a domain controller

SPSS Inc. does not recommend installing IBM® SPSS® Data Collection Survey Tabulation,
IBM® SPSS® Data Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection
Author Server Edition onto a domain controller. There are known issues with .NET running on
domain controllers and there may be an additional security risk if IIS runs on a domain controller
that is accessible from the Internet.

Silent installation

The IBM SPSS Data Collection Server 6 installation package includes four ISS files that provide
options for silently installing and removing the IBM SPSS Data Collection Server 6 applications.
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SingleTemplate.iss: used for silently installing IBM SPSS Data Collection Server 6 on single
machine. When installing IBM SPSS Data Collection Server 6 on an existing database, you
only need to replace DlgNewDPMAdmin with DlgAskDPMAdmin to change the installation
dialog sequence.
ClusterPrimaryTemplate.iss: used for silently installing IBM SPSS Data Collection Server
6 on the primary server in a clustered environment. When installing IBM SPSS Data
Collection Server 6 on an existing database, you only need to replace DlgNewDPMAdmin
with DlgAskDPMAdmin to change the installation dialog sequence.
ClusterSubTemplate.iss: used for silently installing IBM SPSS Data Collection Server 6 on
secondary servers in a clustered environment.
Remove.iss: used for silently uninstalling IBM SPSS Data Collection Server 6.

Silently installing IBM SPSS Data Collection Server 6

E Copy the appropriate silent install template, or you can record the ISS files yourself.
Click Start > Run and enter C:\Installation files\ IBMSPSSDataCollectionServer6.exe –r
-f1”c:\temp\myResonseFile.iss

E Edit the template with the appropriate values for the installation questions. In a 64-bit server
environment, the server applications operate as 32-bit applications. As a result, the components
and files are installed to C:\Program Files (x86) by default. If you are performing a silent
installation on a 64-bit server, you must replace C:\Program Files\ with C:\Program Files (x86) in
the response file template.

In the response file template, note the entry BootOption=3 for the dialog sdFinishReboot. This
means that the PC automatically reboots when the installation completes. If you do not the PC
to automatically reboot, set BootOption=1. The following table describes the custom dialogs
that need to be configured:

Dialog How to edit the template
SdComponentTree Selects features.

DimensionsServer-type=string
DimensionsServer-count=9
DimensionsServer-0=DimensionsServer\DimensionNet
DimensionsServer-1=DimensionsServer\V7Licensing
DimensionsServer-2=DimensionsServer\mrInterview
DimensionsServer-3=DimensionsServer\WebCATI
DimensionsServer-4=DimensionsServer\RemoteManager
DimensionsServer-5=DimensionsServer\mrTables
DimensionsServer-6=DimensionsServer\Reporter
DimensionsServer-7=DimensionsServer\DCP
DimensionsServer-8=DimensionsServer\Author
If you want to un-select the feature Reporter, the following entries should
be updated:
DimensionsServer-type=string
DimensionsServer-count=8
DimensionsServer-0=DimensionsServer\DimensionNet
DimensionsServer-1=DimensionsServer\V7Licensing
DimensionsServer-2=DimensionsServer\mrInterview
DimensionsServer-3=DimensionsServer\WebCATI
DimensionsServer4=DimensionsServer\RemoteManager
DimensionsServer-5=DimensionsServer\mrTables
DimensionsServer-6=DimensionsServer\DCP
DimensionsServer-7=DimensionsServer\Author
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Dialog How to edit the template
DlgClusterSettings Configures your site.

SiteName=Site
dlgUserAdmin The IBM® SPSS® Data Collection group used to access Data

Collection components and the Data Collection user for launching and
running Data Collection services. If you choose domain user, you
must change NOT_SET as your domain name; if you choose to use
workgroup user, you keep the settings USERDOMAIN=NOT_SET, and
GROUPDOMAIN=NOT_SET.
UserDomain=NOT_SET
UserName=
UserPassword=
GroupDomain=NOT_SET
ServerGroup=
The Anonymous User is used by Microsoft Internet Information Services
(IIS) for running web-based applications. If you choose domain user,
you must update NOT_SET as your domain name; if you choose to use
workgroup user, you must keep the setting ANONYMOUSUSERDOMAIN
=NOT_SET.
AnonymousUserDomain=NOT_SET
AnonymousUser=
AnonymousUserPassword=

SdShowDlgEdit1 Defines the SQL Server instance used to create the Data Collection
database.
szEdit1=<SQLServerInstance>

DlgNewDPMAdmin Defines the DPM Admin user to manage users on the system. EnableIWA
is used to enable Integrated Windows Authentication.
DpmAdminUser=
DpmAdminPassword=
EnableIWA=FALSE

DlgEmailSettings Specifies the e-mail SMTP server.
EmailServerName=NOT_SET
EmailServerPort=25

DlgSelectWebsite svComment configures the web site used for the Data Collection folders
and applications; szPath configures a physical location for the web files;
UseSSL configures whether SSL is used in product.
szPath=c:\Inetpub\wwwroot
svComment=Default Web Site
UseSSL=FALSE

DlgFIPS EnableFIPS defines whether SSL is used; PasswordUpgrade defines
whether the password is upgraded when upgrading from a previous version
to version 6 (when FIPS is disabled); NEWPASSWORDPATH configures a
physical location for the new password file path when upgrading from a
previous version to version 6.
EnableFIPS=FALSE
PasswordUpgrade=TRUE
NewPasswordPath=C:\Program Files\Common Files\IBM\SPSS\DataCol-
lection\6\Installer

DlgClusterMachines Define the names of the machines to be included in the cluster. You may
enter multiple machines per line by using a semicolon (;) delimiter.
InterviewServer=
WebServer=
AccessoriesServer=
SurveyTabulationServer=
SurveyReporterServer=
AuthorServer=



85

IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey Reporter Server Edition, and IBM
SPSS Data Collection Author Server Edition installation information

Dialog How to edit the template
DlgClusterMachinesSelect Defines the Web Service machines that will be used for Interviewing and

the ImageCache and Phone Interviews service.
InterviewWebServer=
ImageCacheWebServer=
CatiInterviewWebServer=

DlgClusterAdvanced Configures each machine in the cluster. You need to specify the port
number used in IIS for the service, and whether SSL is used. For each
item, it is a string in the form: hostname:port:protocol.
InterviewServerNum=
InterviewServer1=
WebServerNum=
WebServer1=
AccessoriesServerNum=
AccessoriesServer1=
SurveyTabulationServerNum=
SurveyTabulationServer1=
SurveyReporterServerNum=
SurveyReporterServer1=
AuthorServerNum=
AuthorServer1=
Ensure that the server number remains consistent with the defined
machines. For example:
InterviewServerNum=2
InterviewServer1=IBMServer1:80:HTTP
InterviewServer2=IBMServer2:80:HTTP

E Run the IBM SPSS Data Collection Server 6 installation and specify the location of the edited
response file template using a command similar to the following:

IBMSPSSDataCollectionServer6.exe /s /f1"<location of edited response file>" /f2"<location of silent install log>"

For example, select Start > Run and enter:

C:\Installation files\IBMSPSSDataCollectionServer6.exe " /s /f1"c:\temp\SingleTemplate.iss" /f2"c:\temp\install.log

Using the Setup.log to check for errors

Setup.log is the default name for the silent installation log file. A log file is a plain text file
consisting of sections containing data entries and can be viewed with any text editor (such as
Notepad). By default, it is located in the same directory as IBMSPSSDataCollectionServer6.exe.
You can specify a different name and location for Setup.log using the /f2 parameter with
IBMSPSSDataCollectionServer6.exe (see the example below).

A value assigned to the ResultCode key name in the [ResponseResult] section indicates installation
results:

Value Comment
0 Success
-1 General error
-2 Invalid mode
-3 Required data not found in the Setup.iss file
-4 Not enough memory available
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Value Comment
-5 File does not exist
-6 Cannot write to the response file
-7 Unable to write to the log file
-8 Invalid path to the InstallShield silent response file
-9 Not a valid list type (string or number)
-10 Data type is invalid
-11 Unknown error during setup
-12 Dialogs are out of order
-51 Cannot create the specified folder
-52 Cannot access the specified file or folder
-53 Invalid option selected

Creating the users and the user group

Note: If you are installing IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data
Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition and IBM® SPSS® Data Collection Interviewer Server, you must use the same Installing
User, Running User, Anonymous Access User, and Group for all products.

If you are installing only Survey Tabulation, Survey Reporter Server Edition, Author Server
Edition, or Interviewer Server in a single-machine installation, you need to create a number of
users and a user group, as described below. If you are installing Survey Tabulation, Survey
Reporter Server Edition, or Author Server Edition on multiple machines in a domain, the system
administrator will need to create these users and the group so that they are valid for all machines in
the domain. If you are using machines in different domains, the Installing User and Running User
must be visible and trusted on all those domains. Both users must also have permission to create
databases on the machine hosting the Database Service. If you are installing on machines within
a workgroup, the users and the group must be created on all of the machines in the workgroup.
If necessary, contact your system administrator for assistance.

Note: For domain installations, if you are using case-sensitive SQL you must create the Running
User and the Anonymous Access User with the Full Name and Logon Name in the same case.

Create a user for installing. This user will be referred to as the Installing User in the rest of
this document.
Optionally, create a user for running. This user will be referred to as the Running User in the
rest of this document. You can use the Installing User as the Running User if you wish.
Create a user that can be used for anonymous IIS access to Survey Tabulation or IBM®
SPSS® Data Collection Survey Reporter. This user will be referred to as the Anonymous
Access User in the rest of this document.
Create a group for users.
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Creating the installing and running users

If you are using IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data Collection
Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server Edition and
IBM® SPSS® Data Collection Interviewer Server, you must use the same Installing User and
Running User for all products.

Survey Tabulation, Survey Reporter Server Edition, and Author Server Edition needs to be run
by a user with the same rights as the installing user, who also has the ‘Log on as a service’ and
‘Log on as a batch job’ options set. Rather than using the standard Administrator account, we
recommend creating a new user account that is used specifically for running Survey Tabulation,
Survey Reporter Server Edition, or Author Server Edition. This maintains any existing security
that you have in place.

The notes that follow describe the process for a single machine installation. When installing on
multiple machines, the domain administrator will need to create the Installing User and Running
User so that they are valid for all machines in the domain. If you are using machines in different
domains, the Installing User and Running User must be visible and trusted on all those domains.
Both users must also have permission to create databases on the machine hosting the Database
Service. If you are installing on machines within a workgroup, you must create the Installing
User and Running User on all of machines in the workgroup on which you will install Survey
Tabulation, Survey Reporter Server Edition, or Author Server Edition. The passwords for these
users must be the same on all the machines in the workgroup.

The Survey Tabulation, Survey Reporter Server Edition, and Author Server Edition servers and
services must be run by a user who is a member of the Administrators group. You can use the
Installing User as the Running User if you wish, or you can create a separate account for the
Running User.

Creating the installing and running users and setting the log on options

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, right-click Users and choose New User.

This opens the New User dialog box.

E Enter the details for the Installing User and click Create and then Close.

Note: Do not give the user a password that contains single or double quotation marks or a
backslash as this will cause the installation to fail.

E In the Tree frame, click Groups.

E In the right-hand frame, right-click Administrators and choose Add to Group.

This opens the Administrator Properties dialog box.

E Click Add.
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This opens the Users or Groups dialog box.

E In the list of names, choose the user name you have just created and click Add.

E Click OK to close the Users or Groups dialog box.

E Close the Computer Management window.

E Open Control Panel and choose:
Administrative Tools > Local Security Policy

This opens the Local Security Settings window.

E In the Tree frame, expand Local Policies and click User Rights Assignment.

E In the right-hand frame, double-click Log on as a service. This allows the user to run services.

This opens the Log on as a service Properties dialog box.

E Click Add.

E In the list of names, choose the user name you created earlier and then click Add.

E Click OK to close the Select Users or Groups dialog box.

E Click OK again to return to the Local Security Settings window.

E In the right-hand frame, double-click Log on as a batch job. This allows the user to run a service
that itself starts another application or service.

This opens the Log on as a batch job Properties dialog box.

E Click Add.

E In the list of names, choose the user name you created earlier and then click Add.

E Click OK to close the Select Users or Groups dialog box.

E Click OK again to return to the Local Security Settings window.

E Close the Local Security Settings window.

E Open your SQL administration program and grant the Installing UserSYSADMIN authority. For
example, if you have SQL Enterprise Manager, or SQL Server Management Studio, the steps
will be as follows:

From the Windows Start menu choose:
Programs > Microsoft SQL Server > Enterprise Manager or SQL Server Management Studio

Expand the tree in the left-hand frame until the contents of the Security node are visible for
the Interviewer Server Database server, and select Server Roles.
In the right-hand frame, double-click System Administrators or sysadmin.
This opens the Server Role Properties dialog box.
Click Add.
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In the list of names, choose the user name you created earlier and then click OK.
Click OK to close the Server Role Properties dialog box and then close Enterprise
Manager/SQL Server Management Studio.

E If you are installing on machines within a workgroup, repeat these steps on each machine in the
workgroup that will run the applications so that there are identical Installing and Running Users
on each of those machines.

Note: Be sure to log in as the Installing User before you install Survey Tabulation or IBM®
SPSS® Data Collection Survey Reporter.

Creating the anonymous access user

Note: If you are installing IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data
Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition and IBM® SPSS® Data Collection Interviewer Server, you must use the same Anonymous
Access User for all products.

The applications must be run using the Anonymous IIS User account rather than the account of
the user who started the application. We recommend that you create a new user specifically for
this purpose. The Anonymous Access User must be a member of the group that you create for
Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition users.

Creating the anonymous access user (single machine installation)

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, right-click Users and choose New User.

This opens the New User dialog box.

E Enter the user’s details and click Create and then Close.

E If you are installing on machines within a workgroup, repeat these steps on each machine in the
workgroup that will run Survey Tabulation, Survey Reporter Server Edition, or Author Server
Edition so that identical Anonymous Access Users exist on each of those machines.

Creating the IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey
Reporter Server Edition, or IBM SPSS Data Collection Author Server Edition group

Note: If you are installing IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data
Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition and IBM® SPSS® Data Collection Interviewer Server, you must use the same Installing
User, Running User, Anonymous Access User, and Group for all products.
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The Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition Running User
and Anonymous Access User must belong to a single group. The notes that follow describe the
process for single machine installations. When installing on multiple machines, the domain
administrator will need to create the group so that it is valid for all machines in the domain. For
workgroup installations, the group must exist on all machines that will run Survey Tabulation,
Survey Reporter Server Edition, or Author Server Edition.

Creating a new group (single machine installation)

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, right-click Group and choose New Group.

This opens the New group dialog box.

E Enter a name and description for the group and click Add.

This opens the Select Users or Groups dialog box.

E Choose the users who will be part of the group and click Add.

Note: You must add the Installing User, the Running User and the Anonymous Access User to
this group.

E Click OK to close the Select Users or Groups dialog box.

E Click Create and then Close.

Ports for running IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data
Collection Survey Reporter Server Edition, or IBM SPSS Data Collection Author Server
Edition through a firewall

If you will be running IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data
Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition through a firewall, certain ports on the firewall must be open.

Firewall between the Internet and the IBM SPSS Data Collection Interviewer Server Administration
server

All communication between the browser and the IBM® SPSS® Data Collection Interviewer
Server Administration server (sometimes known as the Accessories server) defaults to using
HTTP on port 80. If your web site runs SSL or uses a different port number, you can specify this
on the Internet Information Services (IIS) Configuration screen during the installation procedure.
This port does not need to be opened until after installation is complete.
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Firewall between the IBM SPSS Data Collection Interviewer Server Administration server and the
database server

Communication between the Interviewer Server Administration Server and the Database Server
takes place using TCP on port 1433. This port must be opened before the installation begins, as
the installation process writes to the Database Server.

If you have SQL running on a named instance, then the port number is dynamically assigned and
could be something other than 1433. If you know which port number is being used, you
should open this port rather than port 1433. If you do not know which port is being
used (and for more information about named SQL instances in general) refer to
http://groups.google.nl/groups?q=connecting+to+second+SQL+instance+through+firewall&hl=nl&lr=&selm=uGvO
(http://groups.google.nl/groups?q=connecting+to+second+SQL+instance+through+firewall&hl=nl&lr=&selm=u

Installing IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection
Survey Reporter Server Edition, or IBM SPSS Data Collection Author Server Edition

E Log on as the Installing User. For more information, see the topic Creating the installing and
running users on p. 22.

E Insert the DVD-ROM into the DVD-ROM drive.

Depending on your system configuration, the AutoPlay feature may detect and start the installation
program when you insert the DVD-ROM into the drive. If this does not happen, you can start
the installation program manually, as follows:

From the Windows Start menu, choose Run.
In the Run dialog box, type d:\autoplay where d:\ is the DVD-ROM drive.

This opens the IBM SPSS Data Collection Server 6 Installer window.

E From the IBM SPSS Data Collection Server 6 Installer window, choose Install IBM SPSS Data
Collection Server 6.

This starts the IBM SPSS Data Collection Server 6 Setup wizard.

E Click Next on the Welcome screen.

E On the License Agreement screen, read the license agreement.

E If you accept the agreement, click Yes.

E On the Select Features screen, select Survey Tabulation, Survey Reporter Server Edition, or
Author Server Edition and then click Next.

E On the Machine Configuration page, choose Single Machine Install.

E On the Machine Settings page, enter a name for your IBM® SPSS® Data Collection site and click
Next. The site name that you choose is displayed on the main IBM® SPSS® Data Collection
Interviewer Server Administration page and can be any name of your choice.

E On the Data Collection User and Group screen, enter information about the user and group that
should be used for running IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS®

http://groups.google.nl/groups?q=connecting%2Bto%2Bsecond%2BSQL%2Binstance%2Bthrough%2Bfirewall&hl;=nl&lr;=&selm;=uGvOuCRGEHA.1988%40cpmsftngxa06.phx.gbl&rnum;=1
http://groups.google.nl/groups?q=connecting%2Bto%2Bsecond%2BSQL%2Binstance%2Bthrough%2Bfirewall&hl;=nl&lr;=&selm;=uGvOuCRGEHA.1988%40cpmsftngxa06.phx.gbl&rnum;=1
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Data Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author
Server Edition.

If you have already installed IBM® SPSS® Data Collection Interviewer Server on this
machine, all the fields on this screen (except the Password field) will show the information
entered for Interviewer Server. In this case you should enter the password and leave the
other fields unchanged.
Otherwise, if the machine on which you are installing Survey Tabulation, Survey Reporter
Server Edition, or Author Server Edition is part of a domain, click Domain and enter the
domain name in the box. If the machine is part of a workgroup or you are installing Survey
Tabulation, Survey Reporter Server Edition, or Author Server Edition on your local machine,
click Workgroup. In the Username and Password boxes, enter the name and password of the
Running User. In the Group box, enter the name of the Survey Tabulation, Survey Reporter
Server Edition, or Author Server Edition Group.

Note: The names you enter must be valid names for the domain or workgroup on which you are
installing.

E On the Data Collection Anonymous User screen, enter the details for the Anonymous Access User.
If you have already installed Interviewer Server on this machine, all the fields on this screen
(except the Password field) will show the information entered for Interviewer Server. In this
case you should enter the password and leave the other fields unchanged.
Otherwise, if the machine on which you are installing Survey Tabulation, Survey Reporter
Server Edition, or Author Server Edition is part of a domain, click Domain and enter the
domain name in the box. If the machine is part of a workgroup or you are installing Survey
Tabulation, Survey Reporter Server Edition, or Author Server Edition on your local machine,
click Workgroup. In the Username and Password boxes, enter the name and password of the
Anonymous Access User.

E On the Data Collection Database screen, enter the name of the server that hosts the Microsoft
SQL server software.

E On the DPM User Admin Details screen, enter a name and password for the Interviewer Server
Administration Administrator. If Interviewer Server has been installed, this user will already exist
and the user name will be displayed. Just enter that user’s password to continue.

Note: This user name is simply for accessing Interviewer Server Administration’s Distributed
Property Management (DPM) database to perform administrative tasks such as setting up
Interviewer Server Administration users and roles, and managing access to Interviewer Server
Administration files and applications. It exists only in DPM. To avoid possible conflicts with
other user names, the name that you choose should not match any of the NT user names known
to your system.

E On the Internet Information Services (IIS) Configuration screen, the installation program detects
any web sites available on the installation machine and displays them in the drop-down list box.
If you want to use a Web site other than the default for your SPSS Inc. applications, select
it from the drop-down list.
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The default file location for the web site you have selected is displayed. If the installation program
detects a folder called SPSSMR within the web site folder structure, you are prompted to install
the files in this folder instead. If you want to install the files to a different location, click Browse
and choose the folder you want to use.

Note: When selecting a non-default web site location on a 64-bit server, you cannot select a web
files location under C:\Program Files in the Internet Information Services (IIS) Configuration
dialog. For example, if you defined a non-default web site named myWebSite, and its local path
is C:\Program Files\myWebSite, you must select a web files location that is not located under
C:\Program Files when you select myWebSite for the Data Collection folders and applications
(you can instead select the location C:\Program Files (x86)).

The Advanced button is available for advanced configuration of your chosen web site. This allows
you to place Interviewer Server Administration in its own application pool so each process can be
split across multiple application pools The operating system places a 2 GB restriction on processes
in IIS. Put simply, splitting a process across application pools means it is possible to run larger
processes. Refer to your IIS documentation for general information about application pools. If
you want to use application pools, proceed as follows:

Click Advanced.
This opens the Advanced IIS Configuration screen.
To place Interviewer Server Administration in its own application pool, select Use
“SPSSDimensionNetPool” application pool. If you want processes to recycle and/or shut down
after specific number of minutes, select the appropriate option and enter the number of minutes
elapse time required. Selecting this option means that if the Interviewer Server Administration
process is recycled or shut down, anyone using Interviewer Server Administration activities at
that time will have to restart their session in order to continue working.
To place Interviewer Server in its own application pool, select Use “SPSSmrInterviewPool”
application pool. If you want processes to recycle and/or shut down after so many minutes,
select the appropriate option and enter the number of minutes elapse time required. Selecting
this option means that if the application process is recycled or shut down, anyone using
Interviewer Server activities at that time will have to restart their session in order to continue
working.
Click Apply.

On the Internet Information Services (IIS) Configuration screen, click Next when you are ready to
continue.

Note: If you already installed Interviewer Server, the IIS configuration settings are automatically
inherited, so the Internet Information Services Configuration screen will not appear.

E On the Setup Type screen, choose:
Typical to install all components on your current machine
Compact to install the minimum components on your current machine
Custom to choose the components you want to install
If you chose the Custom installation, two additional screens are displayed.
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E The Choose Destination Location screen displays the name of the folder in which the files will
be installed. The default is [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\. If you want to
install into a different folder, click Browse and choose the folder you want to use. Click Next.

E On the File Management Folder screen, enter the location of the root folder for the file
management system. Click Next.

E On the FIPS 140-2 Compliance page, select whether or not the installation will be configured for
FIPS 140-2 compliance. FIPS 140-2 is a U.S. government computer security standard used to
accredit cryptographic modules. Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information.

Configure for FIPS 140-2 Compliance. If your system is already configured to be FIPS 140-2
compliant prior to installation, the installation process will not let you deselect the Configure for
FIPS 140-2 Compliance option. If you no do not want the installed applications to be FIPS 140-2
compliant, you must manually set a Windows System cryptography setting to disabled:

1. From the Windows Control panel, select:
Administrative Tools > Local Security Policy > Local Policies (located in the left panel) > Security
Options (located in the left panel) > System cryptography: Use FIPS compliant algorithms... (located
in the right panel)

2. Double-click the System cryptography: Use FIPS compliant algorithms... policy and select Disabled.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not
Configure for FIPS 140-2 Compliance is enabled; for upgrade installations, the following
rules apply:

If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded
in the following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup
log file. The log file is located at: C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\\Installer\NewPassword.logInterviewer Server
Administration administrators can supply users these new, temporary passwords in a manner
that is in accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change
their passwords at next login.
When upgrading on a server that is currently not configured for FIPS 140-2, you are presented
with the option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash
function algorithm.
Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the
SHA-1 hash function algorithm will continue to be employed.
– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the
parameters outlined in the first bullet point are employed.

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
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Refer to the National Institute of Standards and Technology
(http://csrc.nist.gov/groups/STM/cmvp/standards.html#02) website for more information
regarding FIPS 140-2.

Note: When FIPS 140-2 is configured for IBM SPSS Data Collection products, the applications
adhere to the password protection security protocols that are defined on the Interviewer Server.
For example, if the Interviewer Server is configured for MD5 security, the client-side applications
will also use MD5 security for password protection, regardless of whether or not the Configure for
FIPS 140-2 Compliance setting was selected during installation.

E The Start Copying Files screen lists the installation choices you have made. If these settings are
correct, click Next to begin the installation. If not, click Back and step back through the screens to
make the necessary changes.

Note: The installation procedure places a number of keys in the registry. The WebServiceURL key
contains the URL to use for starting Survey Tabulation. If the installer can find the server’s domain
name in the registry, it includes it in the URL so that, for example, the server called olympus is
shown as olympus.spss.com. If the WebServiceURL is incorrect, Survey Tabulation will not start.

E To complete the installation, perform the post-installation tasks.

IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey
Reporter Server Edition, and IBM SPSS Data Collection Author Server Edition
post-installation tasks

After you install IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data
Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition there are a number of tasks you may need to perform to ensure all components are able to
function correctly. Full details of these tasks are given below under separate headings.

Users who have a license for Microsoft Office Web Components (OWC) can use the charting
feature in Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition.
Access to charting is disabled by default. To enable access for licensed users, see Enabling
charts in the Phone Reports activity.
Set up users and roles in IBM® SPSS® Data Collection Interviewer Server Administration
and assign roles to Interviewer Server Administration activities.
For Windows XP Service Pack 3, or if running Survey Tabulation, Survey Reporter Server
Edition, or Author Server Edition through a firewall, add the ASP.NET account to the Launch
permissions on LogBck02.
For Windows XP Service Pack 3 only, open port 80 on the firewall if remote connections are
required for this machine.
Check Internet Explorer settings.
If you have installed onto a machine on which IBM® SPSS® Data Collection Base
Professional is installed, add Base Professional users to the IBM® SPSS® Data Collection
group so they have access to the log file folder.
Start mrUserAdminServer and mrDPMServer3 if they are not already running.

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
http://csrc.nist.gov/groups/STM/cmvp/standards.html#02
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Set up projects in Interviewer Server Administration.
Optionally, install the IBM® SPSS® Data Collection Developer Library.

IBM SPSS Data Collection Survey Tabulation-specific tasks

If using SSL, configure your browser to save encrypted pages to disk.

Enabling charts in the Phone Reports activity

The charting feature in IBM® SPSS® Data Collection Interviewer Server Administration is
disabled by default. Before enabling this feature for any user it is your responsibility to verify
that the said user is appropriately licensed for MS Office Web Components (OWC). Check
your MS OWC license agreement or EULA.

To enable the charting feature, you need to carry out the following steps:

1. Run the Chart Configuration program that is installed with IBM SPSS Data Collection Desktop
6.

2. Enable access to charts for users and roles.

Running the chart configuration program

E Use Windows Explorer to locate the executable file ChartConfiguration.exe. By default, this is
installed in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server Administration.

E Double-click the file name to run the program, then check the Display Charts in Interviewer Server
Administration box and click OK.

Enabling access to charting for users and roles

After running the chart configuration program, you can enable access to charting for users in a
particular role, so that only correctly licensed users are able to access it. You may find that you
need to create a separate role for these users. For more information, see the topic Adding roles
on p. 57.

E In Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E In the left frame, click Activities.

E Depending on the application, expand the Phone, IBM® SPSS® Data Collection Survey Reporter,
or IBM® SPSS® Data Collection Survey Tabulation activity, then expand the Features option.
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E Select the Can display charts feature.

A frame appears on the right of the page listing the roles currently assigned to this feature.

E Click Add/Remove.

This opens the Add Role dialog box.

E Choose the roles you want to assign to the feature and click OK.

Setting up IBM SPSS Data Collection Interviewer Server Administration users, roles, and
permissions

Users and roles are part of the IBM® SPSS® Data Collection Interviewer Server Administration
security system. Every Interviewer Server Administration user has a unique user name and
password, plus a personal working directory within the FMRoot\Users directory. Roles are a
means of grouping users according to the activities they will use. For example, you might create a
Scriptwriting role for users who need access to questionnaire design and building activities,
and an Analysis role for users who need access to the activities that generate tables and export
data. You might also create an Analysis role for users who need access to the applications that
generate tables and export data.

The installation procedure creates one administrator with a name and password of your choice
and places that user in the DPMAdmins role.

In addition, three further roles are created when you install IBM® SPSS® Data Collection Survey
Tabulation: TabulationFullAccess, TabulationMediumAccess, and TabulationMinimumAccess.
Each role is set up with the appropriate Interviewer Server Administration activities and features.
You can attach users to these roles if required, or use them as a basis for creating your own roles.
For details of the activities and features assigned to each role, see the Access Levels in Survey
Tabulation topic in the Survey Tabulation Technical Documentation section of the IBM® SPSS®
Data Collection Developer Library.

Before you can add users and roles and set permissions, you need to start Interviewer Server
Administration.

E Open your browser and go to http://machine_name/SPSSMR/DimensionNet/default.aspx.

E On the Interviewer Server Administration login screen, enter the name and password for the user
you specified as the Interviewer Server Administration administration user during installation
and click Login.

This opens the main Interviewer Server Administration screen.

Adding users

E In IBM® SPSS® Data Collection Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.



98

Chapter 4

E Click Users.

A list of current user names appears on the right of the screen.

E On the right of the screen, click New User....

This opens the User Administration dialog box.

E Complete the fields in the dialog box and click OK to create the new account.

Adding roles

E In IBM® SPSS® Data Collection Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E Click Roles.

A list of current role names appears on the right of the screen.

E In this frame click New Role....

This opens the User Administration dialog box.

E Complete the fields in the dialog box and click OK.

E In the Add User\Project\Activity dialog box, select the users who will be members of this role.

E Click OK to create the role with the selected users as members.

Assigning activities to roles

Once you create users and roles, you can decide which roles may use each activity.

Some features of some activities have their own security settings. For example, while all users
may be able to run an activity, you may be able to restrict access to certain features within the
activity to a subset of users. When you assign activities to roles, you are prompted to specify
which activity features should be available to role members.

When you assign activities to roles, always check whether the activity has security controlled
features and consider who needs access to these features. The default may be that no one except
administrators have access (which is probably not what you want). You may find that you need to
create a separate role for these users.

E In IBM® SPSS® Data Collection Interviewer Server Administration, choose
Tools > User Administration

The User Administration activity starts.

E Click Activities.
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E Select an activity from the Activities tree.

Click the Roles tab on the right of the page. The tab lists the roles currently assigned to the
selected activity.

E Click Add/Remove.

This opens the Add Role dialog box.

E Choose the roles you want to assign to this activity and click OK.

E If the activity has features, a second dialog box is displayed. Select the features that should be
accessible to the roles you have just added.

E Click OK to assign the features to the role.

Adding the ASPNET account to the launch permissions on LogBck02

This task applies only to Accessories servers that are running Windows XP Service Pack 3.

E From the Windows Start menu, choose Run.

E Type dcomcnfg in the text box and click OK.

E In the left-hand frame, expand the display to show the following hierarchy:
Component Services > Computers > My Computer > DCOM Config

E In the left-hand frame, right-click LogBck02 and select Properties.

This opens the LogBckO2 Properties dialog box.

E Select the Security tab.

E In the Launch and Activation Permissions frame click Edit.

This opens the Launch Permissions dialog box.

E Click Add.

This opens the Select Users or Groups dialog box.

E Click Locations, and change the location to be your local machine. Then click OK.

E Add ASPNET, and click OK.

E In the Launch Permissions window, verify that Local Launch and Local Activation are allowed for
the ASPNET user and set them if they are not.

E Close dcomcnfg.
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I’m having problems running IBM SPSS Data Collection applications remotely on Windows XP

If you are working on a clustered site, your problems may be caused by a firewall between your
computer and one of the machines you are using. If you do not know whether there is a firewall,
check with your system administrator. If there is, you may need to open a port on the firewall,
allowing you to connect to the machines on the other side.

E Open Control Panel and choose:
Windows Firewall

E On the Exceptions tab, click Add Port.

E In Port Number, type 80.

E In Name, type Port 80 or any other suitable text of your choice.

E Select the “Port 80” check box on the Exceptions tab to apply the change.

Checking Internet Explorer settings for IBM SPSS Data Collection Survey Tabulation, IBM SPSS
Data Collection Survey Reporter Server Edition, and IBM SPSS Data Collection Author Server
Edition

After installation, check your Internet Explorer settings before running IBM® SPSS® Data
Collection Survey Tabulation, IBM® SPSS® Data Collection Survey Reporter Server Edition, or
IBM® SPSS® Data Collection Author Server Edition. The following changes may be required
to ensure that Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
runs correctly.

Enable pop-ups for IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey
Reporter Server Edition, or IBM SPSS Data Collection Author Server Edition Web page (Windows XP
Service Pack 3)

The pop-up blocker that comes with Windows XP Service Pack 3may block some of the dialog
boxes in Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition when the
default settings are used. This can result in the loss of all the work you have done in the current
session of Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition. To
prevent this from happening, enable pop-ups for the Survey Tabulation, Survey Reporter Server
Edition, or Author Server Edition web page before you run the application.

E From the Internet Explorer menu, choose:
Tools > Pop-up Blocker > Pop-up Blocker Settings

E Paste the URL of the Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
web page in the “Address of Web Site to allow” field and click Add.

E Click Close.
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General Internet options

E From the Internet Explorer menu, choose:
Tools > Internet Options

This displays the Internet Options dialog box.

E On the General tab:
Click Delete Files and confirm your request when asked to do so (it is up to you whether you
also choose to delete offline content). This ensures that any temporary files from previous
releases of Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition are
removed.
Click Settings. In the Settings dialog, ensure that “Check for newer versions of stored pages”
is set to either Every visit to the page or Automatically.

Security Internet options

E On the Security tab of the Internet Options dialog box, select Trusted Sites, and click the Sites
button.

E In the Trusted Sites dialog, add the URL for the Survey Tabulation, Survey Reporter Server
Edition, or Author Server Edition website to the list of trusted websites, and click OK to close
the dialog.

E Select Trusted Sites and set the Security level for this zone slider to Medium. The Medium setting
provides the required options for Survey Tabulation or IBM® SPSS® Data Collection Survey
Reporter to properly function.

Security Internet options when running IBM SPSS Data Collection Survey Tabulation GUI server and
Web service on different machines

E On the Security tab of the Internet Options dialog box, select the zone, and click the Custom
Level button.

E In the Miscellaneous section, select Enable or Prompt for “Access data sources across domains”.
This is necessary even if the Survey Tabulation Front End andWeb Service are in the same domain.

Advanced Internet options

E On the Advanced tab of the Internet Options dialog box:
In the Browsing section, ensure that “Show friendly HTTP error messages” is unchecked.
In the Security section, ensure that “Do not save encrypted pages to disk” is unchecked. For
more information, see the topic Configuring your browser to save encrypted pages to disk
on p. 103.

Enabling file downloads

E Follow the instructions that the browser provides the first time it is unable to download a file. The
changes made at this point enable all subsequent file downloads in Survey Tabulation, Survey
Reporter Server Edition, or Author Server Edition.
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For example, when a user chooses to download a file onto his/her computer, the process will run
but will display a message in the browser’s information bar saying that Internet Explorer has
blocked the site from downloading files onto the computer. To allow file downloads, the user
should click on the location indicated in the message to display options for enabling downloads.

Adding IBM SPSS Data Collection Base Professional users to the IBM SPSS Data Collection group

IBM® SPSS® Data Collection Interviewer Server Administration and all the
activities that run within it write log files to the folders named in the Directory
setting in HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\DimensionNet\Log and
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Log in the registry. The default
for both keys is [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server
Administration\Logs. IBM® SPSS® Data Collection desktop applications such as IBM® SPSS®
Data Collection Base Professional usually write their log files elsewhere.

If you install a mixture of Interviewer Server Administration and desktop applications on a
machine, it makes sense to have all the log files written to the same location, and the Interviewer
Server Administration Logs folder becomes the central location for all log files. The product
installation programs deal with this automatically, but there may be times when you need to make
some additional changes.

Any user who is a member of the Data Collection group has permissions to write to files in the
Logs folder. All Interviewer Server Administration activities are run by the anonymous user.
The anonymous user is a member of the Data Collection group and therefore log messages can
be written by all Interviewer Server Administration activities. Desktop application users (for
example, users of Base Professional) are not necessarily members of this group and may not have
permission to write to the Logs folder. Therefore, you may sometimes need to add desktop users
to the Data Collection group. There are two situations when you will need to do this:

You install IBM® SPSS® Data Collection Interviewer Server, IBM® SPSS® Data
Collection Survey Tabulation, or IBM® SPSS® Data Collection Survey Reporter
onto a machine that already has Base Professional installed. The installation
procedure modifies the registry so that log files for all Data Collection products go to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server Administration\Logs.
You install Base Professional onto a machine that already has Interviewer Server, Survey
Tabulation, or Survey Reporter installed. Since the Interviewer Server Administration Logs
folder is already set as the logging folder, the application’s installation program does not
change the registry settings.

Follow these steps to add a user to the Data Collection group on machines on which Base
Professional is installed:

E Open Control Panel and choose:
Administrative Tools > Computer Management

This opens the Computer Management window.

E Expand Local Users and Groups, click Groups.
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E In the right-hand frame, right-click the Data Collection group that you created for installing
Interviewer Server and choose Add to Group.

This opens the group’s Properties dialog box.

E Click Add.

This opens the Users or Groups dialog box.

E In the list of names, choose the names of the users you want to add to the group and click Add.

E Click OK to close the Users or Groups dialog box.

Starting mrUserAdminServer and mrDPMServer3

The installation process normally starts mrUserAdminServer and mrDPMServer3 on all machines
running the Interviewing Service. Take the following steps to check whether the services are
running and, if necessary, to start them.

E Open Control Panel and choose:
Administrative Tools > Services

This opens the Services dialog box.

E In the list of services check that both services are running.

E If a service is not running, right-click on it and choose Start.

If neither service is running, you should start mrUserAdminServer followed by mrDPMServer3.

A dialog box reports progress of the start-up procedure.

Configuring your browser to save encrypted pages to disk

You can increase the security of the Web site that provides access to IBM® SPSS® Data
Collection Survey Tabulation by using the Secure Sockets Layer (SSL) which encrypts Web
documents passed to and from the site. If you are using SSL, performance of Survey Tabulation
can be improved significantly by changing your browser settings so that encrypted pages are
saved to disk. To do this:

E Open your browser and select
Tools > Internet Options

E In the Internet Options dialog box, click the Advanced tab, and scroll down to the section on
Security.

E Deselect the Do not save encrypted pages to disk check box if it is selected.

E Click OK to save your changes and close the Internet Options dialog box.
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Setting Up IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey
Reporter Server Edition, or IBM SPSS Data Collection Author Server Edition projects in IBM
SPSS Data Collection Interviewer Server Administration

Follow the instructions in “Creating a New Project” in the IBM® SPSS® Data Collection
Interviewer Server Administration Help. These instructions are also available in the Interviewer
Server Administration User’s Guide and the IBM® SPSS® Data Collection Developer Library.

The Data Collection Developer Library also provides a range of sample data sets that may be
useful to users who are learning IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS®
Data Collection Survey Reporter Server Edition, or IBM® SPSS® Data Collection Author Server
Edition. Refer to the Survey Tabulation, Survey Reporter Server Edition, or Author Server Edition
sections in the Data Collection Developer Library for further information about these data sets
and also for instructions on how to install them.

Installing the IBM SPSS Data Collection Developer Library

The documentation for is provided in the IBM® SPSS® Data Collection Developer Library,
(DDL) which is available on the installation CD as a separate installation. It is also available as
a free download from http://www.spss.com.

The Data Collection Developer Library (DDL) is a collection of tools for developing your
own applications and for modifying existing IBM® SPSS® Data Collection products. The
documentation that comes with the DDL provides a host of valuable technical information about
how the Data Collection products work. It includes sections about .

The IBM® SPSS® Data Collection Interviewer Server Administration section includes the
following topics.

Security.
Interviewer Server Administration and IBM® SPSS® Data Collection Survey Tabulation
load balancing.
Wizards and the Interviewer Server Administration Application Framework for building your
own Interviewer Server Administration applications.
Distributed Property Management (DPM) and DPM Explorer.
File management.
Files that control how Interviewer Server Administration works.
Object models.

The IBM® SPSS® Data Collection Interviewer Server section includes the following topics.
The function of and interaction between Interviewer Server components.
Procedures for starting and stopping interviews, time-outs, and activation.
Database tables.
Log files.
Sample Management.

http://www.spss.com
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The Project Cache.
The Image Cache.
Interview Engine load balancing.
Object models.

You may find it useful when installing because it contains sample data sets that users can use while
learning , as well as step-by-step instructions for installing these data sets.

users may also like to have the Data Collection Developer Library available to them as it
provides technical information about and the IBM® SPSS® Data Collection Data Model that is
not available in the Help.

Installing the IBM SPSS Data Collection Developer Library

E Verify you meet all system requirements. See System requirements and Samples and tools.

E From the Installer window, choose Install Data Collection Developer Library. Follow the instructions
on each screen.

Notes

The DDL is available as a separate installation on all Data Collection product installation CDs.
To view the DDL Release Notes, browse the CD and open Release Notes.htm from the DDL
folder. You can also view the Release Notes after installation in the DDL installation directory
([INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Release Notes.htm).
If you have installed an earlier version of the DDL, it is recommended that you remove it
before installing the new version.
You may experience missing help topics when the Data Collection Developer Library is
installed after the Data Collection applications are installed. You can restore the missing
topics by manually deleting the IBM Eclipse Help System’s cache files:
1. Navigate to the Windows Control Panel > Administrative Tools > Services and stop the
DataCollectionHelpCenterService service.
2. Go to C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\Documentation\ibm_help\eclipse and delete the
workspace directory.
3. Open the configuration directory and delete the four child directories
(org.eclipse.core.runtime, org.eclipse.equinox.app, org.eclipse.osgi, and org.eclipse.update).
Take care that you DO NOT delete the file config.ini.
4. Restart the DataCollectionHelpCenterService service. All of the help system topics should
now display as expected.
If you do not have Visual C++ 6.0 installed, the installation program will not install the
Visual C++ CDSC wizard. However, this will not affect the rest of your installation. If
you subsequently install Visual C++ 6.0, you can install the Visual C++ CDSC wizard by
modifying your DDL installation via Add/Remove Programs in the Control Panel.
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System requirements

Operating systems

A 32-bit version of Microsoft® Windows® XP Professional with Service Pack 2, a 32-bit or
64-bit version of Microsoft Windows Vista Ultimate Edition, or 32-bit version of Windows
Server™ 2003 Standard or Enterprise Edition with Service Pack 2

Software

Microsoft Internet Explorer 6.0 or above
A program for extracting files from a ZIP archive

Hardware

Pentium-class processor operating at 90 MHz or faster
64 MB RAM minimum
A hard disk with at least 150 MB available space, plus an additional 150 MB if installing the
optional browser-based version of the DDL documentation
CD-ROM drive required for installation
A graphics adapter with 1024 x 768 resolution or higher
Minimum 16-bit color quality setting

Samples and tools

If installing the IBM® SPSS® Data Collection Developer Library (DDL), refer to the following
information to take full advantage of the DDL. You can install the DDL by clicking Install Data
Collection Developer Library from the Autoplay menu.

The DDL includes a number of samples and tools. All of these require IBM® SPSS® Data
Collection Data Model 6, and some have additional requirements:

Three C# wizards that can be used with Visual Studio .NET to simplify the creation of an
IBM® SPSS® Data Collection Interviewer Server Administration activity. The wizards
require installation of IBM® SPSS® Data Collection Interviewer Server 6 or IBM® SPSS®
Data Collection Survey Tabulation 6.
A Visual C++ wizard that simplifies the creation of a case data source component (CDSC).
This requires installation of Visual C++ 6.0 with Service Pack 4 or later.
The Visual C++ source code for the XML CDSC. To compile this source code, you must have
Microsoft Visual C++ 6.0 with Service Pack 4 or later, Microsoft Data Access Components
(MDAC) 2.8 or later, and Microsoft Windows Template Library from the Microsoft Platform
SDK.
The Visual Basic source code for the following tools and applications: a skeleton Visual Basic
CDSC project, an example Visual Basic CDSC, a CDSC test tool, DM Query, DSC Explorer,
IBM® SPSS® Data Collection Metadata Model Explorer, and a tool for creating aliases in an
MDM document. These require Visual Basic 6.0. Executable files are provided for DM Query
and Metadata Model Explorer so you can use them even if you do not have Visual Basic.
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The source code and executable files for three Visual Basic .NET applications: DM Query,
WinDMSRun, and DPM Explorer.NET. To run the WinDMSRun executable file, you need
IBM® SPSS® Data Collection Base Professional 6, and to run DPM Explorer.NET, you need
Interviewer Server 6 or Survey Tabulation 6. To compile the source code, you need these
products and Visual Basic .NET.
Numerous sample DataManagementScript (DMS) files. To run these files, you must install
Base Professional 6.
Numerous sample mrScriptBasic files. To run these files, you must have Data Model 6. Some
of these samples have additional requirements, such as Microsoft Office, Base Professional
6, or IBM® SPSS® Data Collection Author Professional 6.
A number of sample mrScriptMetadata files. To use these files, you must have Data Model 6.
The Short Drinks sample comes in the form of an SQL Server backup of a relational MR
(RDB) database. You need SQL Server Client Tools to restore and use this database.
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5
Maintenance tasks

Maintenance checklist

This section describes tasks that you may need to carry out periodically for the IBM SPSS Data
Collection Server applications. It includes:

IBM SPSS Data Collection Interviewer Server

Restarting all machines in a cluster
Adding a new interviewing server to an existing cluster
Adding session engines to an IBM SPSS Data Collection Interviewer Server
Updating passwords for IBM SPSS Data Collection Interviewer Server components and
services
Deleting or truncating SQL log files
Changing the Web site port
Changing interviewing URLs and registration passwords if your site switches to using SSL
Recycling application pools (applicable to IIS6 running on Windows 2003)

IBM SPSS Data Collection Survey Tabulation, IBM SPSS Data Collection Survey Reporter Server
Edition, and IBM SPSS Data Collection Author Server Edition

Updating passwords for IBM SPSS Data Collection Interviewer Server components and
services

IBM SPSS Data Collection Survey Tabulation only

Running the variable edits migration tool

Restarting all machines in a cluster

If you need to restart all machines in a cluster, you should restart the machines hosting the Web
Service first, then the machines hosting the Database Service, and finally the machines hosting
the Interview Service.

© Copyright SPSS Inc. 2000, 2010 108
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Adding a new interviewing server to an existing cluster

There are two options for adding a new interviewing server to and existing cluster:
Use the Modify option from the cluster’s primary server installation and then run the installation
on the new server. This method requires the primary server to be shutdown and restarted.
Manually update files on the primary server and then run the installation on the new server.
This method does not require the cluster’s primary server to be shutdown and then restarted.

Primary server Modify option

This option requires the primary server to be restarted. Use theManually update files on the
primary server option below if you do not want to disrupt active services and interviews.

E Go through the pre-installation checklist for the new server.

E Select the following from Windows Control Panel on the primary server’s :
Add or Remove Programs > IBM SPSS Data Collection Server 6 > Change/Remove

This launches the Installation Wizard.

E Select the Modify option. Enter the appropriate new server attributes. For more information, see
the topic Modifying an installation in Chapter 6 on p. 120.

E After the installation is complete, reboot the primary server.

E From the new server, browse the network for the primary server’s mrInterviewSiteInstallation
directory and run the installation program from there.

Note: The primary server’s mrInterviewSiteInstallation directory must be properly configured
for sharing.

E After the installation is complete, reboot the new server.

Manually update files on the primary server

To add a new Interviewing Server to an existing cluster with live respondents, without disrupting
the service for respondents currently taking surveys, follow the steps listed below (this is a general
overview, not a detailed set of instructions).

E Go through the pre-installation checklist for the new server.

E Make a back-up copy of mrInterviewSitePrep.ini from the original installation and also of key
areas of your system such as FMRoot and Projects.

E Edit mrInterviewSitePrep.ini from the original installation to reflect the new servers you want to
add, as follows:

Increment the value of InterviewServer as appropriate.
Add a new InterviewServern entry to the [InterviewServer] section giving the name, port, and
protocol to be used for communicating with this server.

E Double check mrInterviewSitePrep.ini to verify its accuracy.
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E Go to the mrInterviewSiteInstallation directory and run the installation program from there.

E Navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Code\Tools\VB.Net\DPMExplorer.Net
and double-click DPMExplorer.exe.

E In the left-hand frame, click Clusters.

E In the upper right-hand frame, click DefaultCluster.

The property’s value is displayed in the lower right-hand frame.

E In the lower right-hand frame, add the name of the new interviewing server to the IVServerList
variable (names must be separated with semicolons) and click Apply.

E Close DPM Explorer

E On the original interviewing server, do the following:
Navigate to C:\Program Files\Common Files\IBM\SPSS\DataCollection\6\ProjectMgmt
and edit pm.ini. Add the name of the new interviewing server to the IVServerList variable
(names must be separated by semicolons).
Open a command prompt and navigate to C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\ProjectMgmt. Type pmsetup.

E Back on the new interviewing server, open a command prompt, type RegIntSvr /u /d to unregister
and disable the server temporarily.

This allows you to activate projects on the server while ensuring that the server does not start
interviews. If you start the Interview Engine at this point, the Web server will try to send
interviews to the new server, but because the .mdd file does not exist on that server, respondents
will be redirected to another server in the cluster.

E Copy the folders for active jobs from the File Management folder (FMRoot\Master) into the
new server’s Projects folder.

E At a command prompt, type RegIntSvr /e to register and enable the interviewing server.

Adding session engines to an IBM SPSS Data Collection Interviewer Server

Each Interview Session Engine runs within its own w3wp.exe worker process. These worker
processes become unstable when their memory usage reaches about 1.5Gb. You can avoid this
problem by adding additional Interview Session Engines to your IBM® SPSS® Data Collection
Interviewer Servers, as long as the machines that are hosting the Engines have sufficient memory.
This automatically adds additional worker processes which effectively doubles the amount of
memory that each server can use for serving interviews.

E In Windows Explorer, browse to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server, and make a copy of the mrIEngWS folder. Rename the copy to mrIEngWS2.

E Create a new application pool:
Open IIS.
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Right-click Application Pools and select New and then Application Pool.
Enter SPSSmrInterviewPool2 as the name for the new application pool.
Click Use existing application pool as template and choose SPSSmrInterviewPool from the
drop-down list.

E Under Web Sites, right-click the web site that gives access to Interviewer Server and choose New
and then Virtual Directory.

E Click Next to continue.

E On the Virtual Directory Alias page, enter mrIEngWS2 as the alias and then click Next.

E On the Web Site Content Directory page, browse to the path of the mrIEngWS2 folder that you
created earlier and click Next.

E On the Virtual Directory Access Permission page, click Next to keep the default settings.

E Click Finish.

E Right-click the mrIEngWS2 virtual folder and select Properties.

E On the Virtual Directory page, click Create.

E In Application Pool, select the SPSSmrInterviewPool2 application pool that you created earlier.

E In Execute Permissions, select Scripts and Executables.

E Uncheck the Read and Write checkboxes.

E Click the Configuration button.

This opens the Application Configuration settings page.

E On the Mappings page, click Add.

This opens the Add / Edit Application Extension Mapping page.

E Browse to the mrIEngWS2 folder that you created earlier, and select mrIEngWS.dll.
You will need to enclose the path in double quotation marks so it may look
like this: “[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIEngWS2\mrIEngWS.dll”.

E In the Extension input box, type .dll.

E Under the Verbs heading, select Limit to: and type GET,HEAD,POST,DEBUG in the text box.

E Click OK once to close the dialog box, and then again to go back to the Virtual Directory
Properties page.

E On the Directory Security tab, under Authentication and Access Control, click Edit.

E Enter the user name and password for the Anonymous Access User that you specified during
the Interviewer Server installation.

E Click Apply to save your changes and then OK to close the dialog box.
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E In IIS, select Web Service Extensions.

E Double-click IBM® SPSS® Data Collection ISAPI Extensions.

E On the Required Files tab, click Add to add mrIEngWS.dll in the folder that you created at the
start of this procedure

E Click Apply and then close the dialog box.

E Add the URL for the new Interview Engine to the registry as a string in
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Interviewing\LocalEngineURLs.
For example:

LocalEngineURLs='http://intserver1/mrIEngWS','http://intserver1/mrIEngWS2'

E Open a command prompt, change directory to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\Server, and run
RegIntSvr.exe to register the new engine with the Web server.

E On the Web server, navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb and open RegisteredEngines.xml. This will show you a list of all registered,
unregistered and failed engines.

Properties for the new session engine are added to DPM and can be viewed in DPMExplorer by
expanding the Cluster properties entry.

When an interview starts, you will see one w3wp process in Task Manager for each session
engine that is running.

Making the session engines available to the Phone Participants and Review Interviews activities

All Data Collection telephone interviewing and interview reviewing sessions have access to the
default session engine (usually [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIEngWS\mrIEngWS.dll) and to any other interview session engines named in
the Phone Participants or Review Interviews Web.config files. To name alternate engines, do
the following:

E Navigate to C:\InetPub\wwwroot\SPSSMR\CatiInt and open the Web.config file.

E Add the following definition to the < appSettings> section:

<add key="ALTERNATE_INTERVIEW_ENGINES" value="engine_names"/>

where engine_names is a comma-separated list of the URLs of interview engines. For example:

<add key="ALTERNATE_INTERVIEW_ENGINES" value=" http://redserver/mriengws2, http://redserver/mriengws,

E Save your changes and close the file.

E Repeat these steps for the Web.config file in C:\InetPub\wwwroot\SPSSMR\ReviewInterview.
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Updating passwords for IBM SPSS Data Collection Interviewer Server components
and services

IBM® SPSS® Data Collection Interviewer Server components and services are installed with
the name and password of the Running User. Many companies have a policy of regularly
changing passwords to avoid security breaches, so Interviewer Server comes with a utility that
the administrator or other suitably qualified user can run to update the passwords of all installed
Interviewer Server components and services.

The ChangePasswords utility does not change the system password for the Interviewer
Server Running user; you must do this using the standard Windows tools before running
ChangePasswords. Rather, it updates password information held in the registry for Interviewer
Server components and services that will be run by the Running User.

Note: You can run this utility while the Interviewer Server services are running.

Updating passwords for IBM SPSS Data Collection Interviewer Server components and services

E If you have not already done so, use the standard Windows tools to change the account passwords
for the Running User and Anonymous Access User.

E Open Windows Explorer, browse to the folder in which the Interviewer Server application is
installed (for example, [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server)
and double-click ChangePasswords.exe.

This opens the Change Password Utility dialog box, showing the current domain name and user
name.

E In the Password fields, type the new passwords for the Running User and the Anonymous Access
User.

E Click Change.

The program displays a message confirming that all passwords have been changed.

Deleting or truncating SQL log files

Deleting or truncating log files prevents them from becoming too large and possibly running up
against a system limit that prevents IBM® SPSS® Data Collection Interviewer Server from
functioning correctly. Recommendations are as follows:

Delete or truncate the log files for the mrUserData and mrInterviewData databases as part of
your regular system maintenance plan, as there is always a lot of activity in this database and
the log file grows at a rapid rate.
When you back up a database, truncate or delete the log file that Interviewer Server uses for
recording messages related to that database.

Refer to your SQL Server documentation for information on how to delete or truncate SQL log
files.
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Changing the Web site port

The default port number for web sites is port 80. When you install the Web Service onto a web site
that uses a different port number, you can specify this port number and the installation program
will ensure that IBM® SPSS® Data Collection Interviewer Server will run using that port. If you
change the port number that your web site uses after installing Interviewer Server, you must make
the corresponding changes for Interviewer Server manually.

E Open regedit and navigate to
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Interviewing.

E Change the LocalEngineURLs setting so that it reads
http://ServerName:PortNumber/mrIEngWS

If you were previously using port 80 but are now using a different port, you will need to add
:PortNumber to the existing definition. If you are switching from using a port other than 80 to
using port 80, you will need to delete :PortNumber from the existing definition. Otherwise, simply
change the value of PortNumber.

E Change the RegistrationURL setting so that it reads
http://%Server%:PortNumber/mrIWeb/mrIWeb.dll?Handler=EngineRegistrationService
The rules for changing PortNumber are as described in the previous step.

E Save the changes and exit.

E Open [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb\Web.config and change the ImageCache and LocalImageCache keys so
that they read as follows (lines are split for ease of reading only):

<add key="LocalImageCacheURL"
value="http://servername:PortNumber/SPSSMR/ImageCache/ImageCache.aspx"/>

<add key="ImageCacheURL"
value="http://servername:PortNumber/SPSSMR/ImageCache/ImageCache.aspx"/>

As with the registry settings, you will either add, remove or change the :PortNumber parameter in
these definitions depending on what changes you have made to the web site port number.

Changing interviewing URLs and registration passwords

When you install IBM® SPSS® Data Collection Interviewer Server, the installation procedure
sets up URLs for interviewing based on the information given at that time. For example, if you are
using non-default ports or SSL, the URLs will be modified accordingly. If your site switches to
using SSL once Interviewer Server has been installed, you can make the changes manually and
your existing installation should continue to work.

Changing the URL for starting interviews

E Using Windows Explorer, navigate to the \InetPub\wwwroot\SPSSMR\ProjectEditor\Settings
folder on your web site.

E Using a text editor, open Properties Interviewer Server (Data Collection).xml.
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E Locate the entry for the InterviewStartURL property and change the default value so that it starts
with https rather than the standard http.

E Save your change and close the file.

Setting the URL for the image cache

E Navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb and open Web.config.

E Add the following lines to the file:

<appSettings>
<add key="ImageCacheURL" value="http://WebServerName/SPSSMR/ImageCache/ImageCache.aspx"/>

</appSettings>

If this setting is not defined, template files will not be available.

E Save the changes and close the file.

Configuring the RegistrationURL setting in the registry

On each machine running the Interviewing Service:

E Run regedit and navigate to
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Interviewing\.

E Change the value of the RegistrationURL setting so that it starts with “https” rather than the
standard “http”:

https://%SERVER%/mrIWeb/mrIWeb.dll?Handler=EngineRegistrationService

If this setting is not defined, add it and give it the value shown above.

E Save your changes and close regedit.

Changing the registration password

This is optional and applies to all machines running the Interviewing Service.

E Navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb and open Web.config.

E Replace the default registration password stored in RegistrationPW with a password of your
choice.

E Save your changes and close the file.

E Run regedit and navigate to
\HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\Interviewing\.

E Change the value of the RegistrationPW setting so that it matches the password you have just
defined in the Web.config file.

E Save your changes and close regedit.
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Recycling application pools

This task applies only to machines running Internet Information Services (IIS) 6 with Windows
2003 or 2008.

You should recycle processes periodically, for both stability and performance reasons. Over long
periods of time, leaked resources and system or application problems may affect Web server
throughput. You should balance this with recycling too often, however, since the cost of stopping
the worker process, reloading pages and re-obtaining resources and data may override the benefits
of a recycle. If there is high load on the interviewing server, you may need to configure your
IBM® SPSS® Data Collection Interviewer Server application pool to recycle once a day. If there
is low load, you can set the application pool to recycle once a week, or disable it completely. By
default application pool recycling is disabled for the Interviewer Server application pool.

The steps to set up recycling for the Interviewer Server application pool are as follows:

E Open Internet Information Services Manager.

E Expand the display in the left-hand frame so that you can see the SPSSmrInterviewPool
application pool in the Application Pools branch.

E Right click SPSSmrInterviewPool and select Properties.

The SPSSmrInterviewPool AppPool dialog box opens.

E On the Recycling tab select the type of recycling you want and enter the additional information
required.

E Click OK to save your changes and then close IIS Manager.

Updating the password for IBM SPSS Data Collection Survey Tabulation, IBM SPSS
Data Collection Survey Reporter Server Edition, and IBM SPSS Data Collection Author
Server Edition

IBM® SPSS® Data Collection Survey Tabulation, IBM® SPSS® Data Collection Survey
Reporter Server Edition, and IBM® SPSS® Data Collection Author Server Edition run using
the name and password of the Running User specified during the installation procedure. Many
companies have a policy of regularly changing passwords to avoid security breaches, so Survey
Tabulation, Survey Reporter Server Edition, and Author Server Edition include a utility that the
administrator, or other suitably qualified user, can run to update the passwords for the Running
User and Anonymous Access User.

The ChangePasswords utility does not change the system password for the Survey Tabulation,
Survey Reporter Server Edition, or Author Server Edition Running User password at the
domain or workgroup level; you must do this using the standard Windows tools before running
ChangePasswords. Rather, the utility updates password information held in the registry for
Survey Tabulation, Survey Reporter Server Edition, and Author Server Edition components that
will be run by the Running User and Anonymous Access User.
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Updating the Running User password

E If you have not already done so, use the standard Windows tools to change the account passwords
for the Running User and Anonymous Access User.

E Open Windows Explorer, browse to the folder in which the IBM® SPSS®
Data Collection Interviewer Server application is installed (for example,
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server) and double-click
ChangePasswords.exe.

This opens the Change Password Utility dialog box, showing the current domain name and user
name.

E In the Password fields, type the new passwords for the Running User and the Anonymous Access
User.

E Click Change.

The program displays a message confirming that all passwords have been changed.

Running the variable edits migration tool

Projects created in mrTables 4.0 or earlier need to be upgraded so users can take advantage of
the changes made starting in release 4.5 to save variable edits in table document files so they can
be shared by other users. The upgrade needs to be performed once for each project that was
created in mrTables 4.0 or earlier, to upgrade it to mrTables 4.5 through 5.5 or IBM® SPSS® Data
Collection Survey Tabulation 6. The IBM® SPSS® Data Collection Survey Tabulation Upgrade
tool saves the variable edits, stored in the project management system (DPM) for projects created
in version 4.0 and earlier, into each of the table document (.mtd) files that exist in each user’s
project folder. Optionally, it also deletes the variable edits from DPM (this is recommended once
you have completed the upgrade for all users). Once you have upgraded the table documents, you
can transfer them between Survey Tabulation, IBM® SPSS® Data Collection Base Professional,
and IBM® SPSS® Data Collection Survey Reporter, without losing variable edits or filters that
have been added in Survey Tabulation.

Note: Variable edits saved in DPM are no longer supported from release 4.5.

Table document files in the shared area. Table document files stored in the shared area are not
affected by the upgrade tool. To upgrade shared table documents, it is recommended that before
running the upgrade tool, a user with the appropriate access permissions saves the shared files
to their own user area. The files will then be upgraded with that user’s variable edits, and can
be replaced in the shared area when the upgrade is complete.

Table document files from Survey Reporter and Base Professional. If a table document file in
the user’s folder already contains variable edits that were added in Survey Reporter or Base
Professional, these edits take precedence over the Survey Tabulation edits in DPM, and the file
is not updated with the DPM edits.
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Running the migration tool

E Log on to the Survey Tabulation server.

E In Windows Explorer, navigate to the Survey Tabulation folder, for example:
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Survey Tabulation\.

E Double-click the mrTablesVariableEditsMigrationTool.exe file.

E In the Survey Tabulation Upgrade Tool window, enter your DPMAdmin user name and password.

You can either choose to migrate all the information for all projects or for a specific table
document, user, and project.

Migrating information for all projects

Using the Migrate All option means you can complete the upgrade for all users and projects
at once. It also includes an option to delete the variable edits from DPM once the migration
completes successfully. Deleting variable edits is recommended as, once all projects have been
upgraded, they are no longer of any use, and are simply taking up space.

E If required, select Delete old variable edits once successfully migrated.

E Click the upper Migrate button.

The migration tool checks for any users who have variable edits in DPM, and displays a list of the
users. You can either choose to migrate all users, or press Cancel to return to the window and
select individual users to migrate.

If you choose to migrate all users, the results of the migration process are recorded in a log at
the bottom of the window. You can copy the information from this log and save it to a file as a
record of the upgrade process.

Note: Once the upgrade has run successfully for all users and projects, the upgrade tool sets the
VariableEditsMigratedToMTD property on the Survey Tabulation application in DPM to true, to
indicate that all projects have been upgraded.

Migrating information for a specific table document, user, or project

Using the Migrate to selected file options means you can carry out the migration for users, projects,
and table document files individually. You may prefer to use these options rather than the Migrate
All option if you want to perform the upgrade in stages.

The option to delete edits from DPM is not available when you use the Migrate to selected file
options. This is because the edits may be required by other table documents that have not yet
been upgraded. When you have migrated the required users and projects, you may want to use
the Migrate All option to check that nothing has been missed, and to delete the variable edits
from DPM.
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E To migrate information for individual table documents, users, or projects:
To migrate information to a specific table document, browse to the
location of the table document in the FMRoot folder, for example:
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\FMRoot\Users\Admin\Projects\Museum\museum tables.mtd.
To migrate information for a specific project, enter the project’s name
To migrate information for a specific user, enter the user name

E Click the lower Migrate button to run the migration.

The results of the migration process are recorded in a log at the bottom of the window. You can
copy the information from this log and save it to a file as a record of the upgrade process.
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Modifying, repairing, or removing your installation

You can Modify, repair, or remove an existing IBM SPSS Data Collection Server 6 installation.
Refer to the following sections:

Modifying an installation
Repairing an installation
Removing IBM SPSS Data Collection Server applications

Modifying an installation

E Log on with the user name you created for installing the IBM SPSS Data Collection Server
applications.

E From the Windows Start menu, select:
Control Panel > Add or Remove Programs > IBM SPSS Data Collection Server 6

E Click Change/Remove to open the IBM SPSS Data Collection Server 6 Maintenance window.

E Select Modify and click Next. Modifying an existing installation allows you to perform the
following tasks:

Add/remove features on the local machine (IBM® SPSS® Data Collection Load Tool, Phone
Interviews, Remote Administration, and so on).
Add/remove servers to an existing cluster. Note that adding servers via the modify option
requires the cluster’s primary server to be rebooted. Refer to Adding a new interviewing
server to an existing cluster for instructions on adding additional servers to a cluster without
interrupting active services and interviews.

E The remaining steps are identical to installing the IBM SPSS Data Collection Server applications.
Refer to IBM SPSS Data Collection Interviewer Server installation information or IBM SPSS
Data Collection Survey Tabulation, IBM SPSS Data Collection Survey Reporter Server Edition,
and IBM SPSS Data Collection Author Server Edition installation overview for more information.

E After modification, either reboot all of the IBM® SPSS® Data Collection Interviewer Servers,
or navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\Server on
each Interviewer Server and run RegIntSvr.exe. Both actions register the Interviewing Service
with the Web Service.

© Copyright SPSS Inc. 2000, 2010 120
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Repairing an installation

E Log on with the user name you created for installing the IBM SPSS Data Collection Server
applications.

E From the Windows Start menu, select:
Control Panel > Add or Remove Programs > IBM SPSS Data Collection Server 6

E Click Change/Remove to open the IBM SPSS Data Collection Server 6 Maintenance window.

E Select Repair and click Next.

E The remaining steps are identical to installing the IBM SPSS Data Collection Server applications.
Refer to IBM SPSS Data Collection Interviewer Server installation information or IBM SPSS
Data Collection Survey Tabulation, IBM SPSS Data Collection Survey Reporter Server Edition,
and IBM SPSS Data Collection Author Server Edition installation overview for more information.

Removing IBM SPSS Data Collection Server applications

To remove IBM SPSS Data Collection Server applications, use the uninstall feature. If you simply
delete the files and folders associated with the products, the applications will not be properly
removed and you may have problems installing or removing later versions.

After you installed IBM SPSS Data Collection Server applications, you may have changed some
of the files that control how IBM® SPSS® Data Collection Interviewer Server Administration or
IBM SPSS Data Collection Server applications work. The removal procedure backs up key files,
allowing you to copy them back to their original locations after a reinstall.

Files are backed up to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\\Backup\Interviewer
Server Administration version_date_time; for example, Interviewer Server Administration
2.3_10.15.2004_13.59.20. Inside this folder are subfolders containing files from various locations
within \Program Files and the IIS Web site folder. Files that are backed up typically include
the following:

Web.config files for Interviewer Server Administration activities
Web.config files for IBM® SPSS® Data Collection Interviewer Server activities
The Web.config file for IBM® SPSS® Data Collection Survey Tabulation
ProjectMgmt\pm.ini.
SampleMgt.GUI.Config.xml
The load balancing script files defaultreport.mrs and defaultload.mrs

Removing IBM SPSS Data Collection Server applications

E Log on with the user you created for installing the IBM SPSS Data Collection Server applications.

E From the Windows Start menu, select:
Control Panel > Add or Remove Programs > IBM SPSS Data Collection Server 6

E Click Change/Remove to open the IBM SPSS Data Collection Server 6 Maintenance window.
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E Select Remove and click Next.

E Confirm your request when prompted to do so.

E On the Maintenance Complete page, click Finish.

E Reboot when prompted to do so. If you do not reboot, you will not be able to reinstall IBM SPSS
Data Collection Server applications.

Removing residual IBM SPSS Data Collection Survey Reporter files from workstations

When IBM® SPSS® Data Collection Survey Reporter Server Edition or IBM® SPSS® Data
Collection Author Server Edition is installed from the Interviewer Server there are a number of
files that need to be manually removed from each workstation. Delete the following downloaded
folders from each workstation machine.

Survey Reporter Server Edition

C:\Documents and Settings\<your Windows user name>\Application
Data\IBM\SPSS\DataCollection\6\Survey Reporter
C:\Documents and Settings\<your Windows user name>\Local Settings\Apps\2.0

Author Server Edition

C:\Documents and Settings\<your Windows user name>\Application
Data\IBM\SPSS\DataCollection\6\Author
C:\Documents and Settings\<your Windows user name>\Application
Data\IBM\SPSS\DataCollection\Activate
C:\Documents and Settings\<your Windows user name>\Local Settings\Apps\2.0
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Troubleshooting and FAQs

How do I change the options in a site preparation file?

You may edit the site preparation file using a text editor of your choice, but take care not to change
the names of any of the variables defined in the file. The installation program expects to find the
information it requires in variables with specific names. If you change the variable names the
installation is likely to fail.
If you have already installed IBM® SPSS® Data Collection Interviewer Server on some of the

machines named in the site preparation file, you will need to uninstall Interviewer Server from
these machines and install it again after you have edited site preparation file.

The folder in which I created the site preparation file is not visible from the machines
named in the site preparation file.

Check that you have shared the folder and that you have assigned permissions for the Installing
User and the IBM® SPSS® Data Collection Group. For more information, see the topic Creating
the site preparation file and folder in Chapter 3 on p. 39.

The installation program fails when I select a non-default web site installation location
on a 64-bit system

When selecting a non-default web site location on a 64-bit server, you cannot select a web
files location under C:\Program Files in the Internet Information Services (IIS) Configuration
dialog. For example, if you defined a non-default web site named myWebSite, and its local path
is C:\Program Files\myWebSite, you must select a web files location that is not located under
C:\Program Files when you select myWebSite for the IBM® SPSS® Data Collection folders and
applications (you can instead select the location C:\Program Files (x86)).

© Copyright SPSS Inc. 2000, 2010 123
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The installation program fails with the message ‘Error 1608: Unable to create
InstallDriver instance’

This is an InstallShield problem that can happen for the following reasons:
The Client for Microsoft Networks networking protocol is not installed on the machine on
which you are trying to install IBM® SPSS® Data Collection Interviewer Server. If this is
part of your company’s security policy, install the protocol temporarily so that you can install
Interviewer Server and then uninstall it.
The dcomcnfg default security settings do not include the Installing User under the Launch
and/or Default Access permissions. To set the necessary permissions, do the following:

E Run dcomcnfg.

E On the Default Security tab, click Edit Default in the Default Launch Permissions section.

E Add the Installing User.

E If necessary, make the same change in the Default Access Permissions section.

E Click OK.

How do I create an installation log file?

If you are having problems installing the application and you cannot see from the existing error
messages what the problem is, you may be able to solve the problem by creating a log file as the
installation procedure is running. To do this, you need to run the installation program manually,
as follows:

E Open a command prompt and go to the directory on the CD containing the installation program,
IBMSPSSDataCollectionServer6.exe.

E To log just the application part of the installation, type: IBMSPSSDataCollectionServer6.exe
/V"/l*v log_filename /i"where log_filename is the full pathname, including drive letter, of the log file
you want to create. To log the IBM® SPSS® Data Collection Interviewer Server Administration
part of the installation as well, type IBMSPSSDataCollectionServer6.exe /V"/l*v log_filename
LOGDIM_INSTALL=TRUE /i". This will create a log file called C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\Installer\Interviewer Server Administration\DimInstallLog.txt.

If you still cannot resolve the problem, contact your support representative for assistance.

I’ve installed a new application version and get errors when I try to select things from
the menus in IBM SPSS Data Collection Interviewer Server Administration

When you run applications from your browser, the browser maintains a number of temporary files
that help it to keep track of what you have done and to run the application as efficiently as possible.
Sometimes, when you install and run a different version of an application, your browser attempts
to reuse the information in the temporary files. If this no longer matches the way the application
works, errors will occur. You can solve this problem easily by deleting the temporary files.



125

Troubleshooting

E Open your browser and select
Tools > Internet Options

E In Temporary Internet Files, click Delete Files.

E Confirm your request when prompted to do so.

I can log in to IBM SPSS Data Collection Interviewer Server Administration if I enter the
URL as //localhost/... but not if I enter the server’s name instead of localhost

If the server name contains any characters other than letters, numbers, hyphen, and dot, you
will not be able to log in to IBM® SPSS® Data Collection Interviewer Server Administration
by specifying the server name in the URL. This is due to a limitation in Internet Explorer which
prevents servers whose names contain characters other than these from setting cookies. If you
want to use this server with Interviewer Server Administration and IBM® SPSS® Data Collection
Interviewer Server you will either have to change its name or refer to it using its IP address.

How do I simultaneously login to separate IBM SPSS Data Collection Interviewer
Server Administration or IBM SPSS Data Collection Interviewer Server sessions as
different users in Internet Explorer?

If you attempt to simply open a new Internet Explorer window or tab, the second window/tab
will use the first session’s settings and will not allow you to launch an additional IBM® SPSS®
Data Collection Interviewer Server Administration or IBM® SPSS® Data Collection Interviewer
Server session as a different user. If you want to simultaneously login to separate Interviewer
Server Administration or Interviewer Server sessions as different users, select the Internet Explorer
File > New Session option.

Machines in the cluster can ping one another successfully but cannot see FMRoot

The standard test for ensuring that all machines in a cluster can communicate with one another is
to try pinging each machine from every other machine in the cluster. If your site has increased
its security by switching off Client for Microsoft Networks, then even though machines will be
able to ping one another they may not be able to access FMRoot on the primary DPM server. To
resolve this problem, switch on Client for Microsoft Networks on the machines on which IBM®
SPSS® Data Collection Interviewer Server Administration and IBM® SPSS® Data Collection
Interviewer Server are installed.

Errors when attempting to ping machines in a cluster

If machines in a cluster cannot ping one another, the problem is usually due to the security set
up between those machines.
The message “Request timed out” usually occurs if there is a firewall blocking communication

between the two machines.
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The message “Ping request could not find host server_name. Please check the name and try
again” usually occurs when a firewall or security setting is preventing certain communications
from the DMZ (demilitarized zone) to the main network or to trusted machines. A typical
example of this is when the Interviewing server can ping the Web server, but the Web server
cannot ping the Interviewing server.
Try connecting to the machine by typing http://MachineName into your browser instead.

I want to check that SQL Server is running on the Database server but I cannot see the
server name in the list of servers

If there is a firewall or a DMZ boundary between the Interviewing server and the Database server,
you may not see the name of the Database server in the list of SQL servers displayed in the Create
a New Data Source to SQL Server dialog box. Just type the name of the Database server into the
Server box and the connection request will generally be allowed.

The location of the Web Site folder containing SPSSMR has changed since IBM SPSS
Data Collection Server applications were installed.

What changes do I need to make in order to continue using IBM SPSS Data Collection Server
applications?
If the location of the Web site on which you installed IBM SPSS Data Collection Server

applications changes after installation, you will need to move the IBM SPSS Data Collection
Server application and IBM® SPSS® Data Collection Interviewer Server Administration
application folders and the webctrl_client folder from the original Web site to the new one. You
will also need to change the pathname defined for the Interviewer Server Administration load
balancing configuration file in Interviewer Server Administration’s Web.config file.

E If the SPSSMR folder does not appear in the new Web site folder, copy it from the Web site folder
in which it was installed into the new location.

E Move the webctrl_client folder from the original Web site folder into the new folder so it is at the
same level as the SPSSMR folder.

E From the Control Panel, go to:
Administrative Tasks > Internet Information Services

This opens the Internet Information Services window.

Create the new SPSSMR virtual directory

E In the left-hand frame, right-click the Web site to which you have just copied the SPSSMR folder
and select New, Virtual Directory.

This starts the New Virtual Directory wizard.

E On the first page of the wizard, click Next.

E On the Virtual Directory Alias page, enter SPSSMR as the Alias name and then click Next.
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E On the Web Site Contents Directory tab, click Browse and select the SPSSMR folder in its new
location. Then click Next.

E On the Access Permissions page, ensure that only the Read and Run script check boxes are
selected. Then click Next.

E On the last page, click Finish.

Create virtual directories for IBM® SPSS® Data Collection activities

E Create virtual directories for activities within the SPSSMR folder by repeating the previous set of
steps for each activity folder. For example, to create a virtual directory for the Activate activity,
right-click SPSSMR in the left-hand frame and choose New, Virtual Directory.

E Within each activity’s virtual directory, create virtual directories pointing to the SPSSMR\Shared
and SPSSMR\Shared\Login folders. For example, to create an SPSSMR\Activate\Shared virtual
directory, right-click Activate in the left-hand frame and choose New, Virtual Directory.

Remove the Create Application setting from the SPSSMR, Shared, and Login virtual directories

E In the left-hand frame, right-click SPSSMR and select Properties.

This opens the SPSSMR Properties dialog box.

E In the Application Settings frame, click Remove.

The text box is greyed out and the button name changes to Create.

E Click OK.

E Repeat this procedure for every Shared and Login virtual directory within SPSSMR.

E Close IIS.

Reconfigure Interviewer Server Administration load balancing

E Browse to the Interviewer Server Administration folder in the new Web site folder.

E Right-click Web.config, select Properties, and remove the Read-only attribute from the file. Click
OK to close the dialog box.

E Using a text editing program such as Notepad, open Web.config.

E Scroll to the end of the file and locate the line that defines the SPSS_LoadBalanceXmlFile key.
In this line, replace the pathname with the drive letter and pathname of the new Web site folder
(do not change the filename itself).

E Save your changes and close the file.

Update the Registry setting for the IBM® SPSS® Data Collection Survey Tabulation variable cache
directory

E From the Windows Start menu, select Run.

E In the Open box, type regedit and click OK. This opens the Registry Editor.

E In the left-hand frame, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\MR Tables\6.0.
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E In the right-hand frame, right-click VariableCacheDir, and select Modify.

E In the Edit String dialog, replace the pathname with the drive letter and pathname of the new
Web site folder and click OK.

E You must reboot your machine before the changes take effect.

My site uses Microsoft ISA. Are there any changes I need to make in order to run IBM
SPSS Data Collection Interviewer Server Administration?

If you have Microsoft Internet and Security Acceleration (ISA) installed, you may encounter
problems if your site has machines that have different names or IP addresses depending on
whether they are being accessed via an intranet or via the Internet. Typically, if a user runs IBM®
SPSS® Data Collection Interviewer Server Administration from the Internet and starts an activity,
Interviewer Server Administration will fail when the user ends the activity. This is because it tries
to return the user to Interviewer Server Administration using the server’s intranet name or IP
address rather than the Internet name or IP address that the user originally used. To avoid this
problem, make the following changes:

E Open ISA and select the Action tab.

E Select Send the original host header to the publishing server instead of the actual one.

E Click OK.

For further information refer to http://support.microsoft.com/?kbid=838252 (
http://support.microsoft.com/?kbid=838252)

I’m installing onto Windows XP, and the installation fails when I click
Next on the mrInterviewData IBM SPSS Data Collection Interviewer Server
Administration Database Setup page

When you click Next on the mrInterviewData IBM® SPSS® Data Collection Interviewer Server
Administration Database Setup page, the installation procedure runs a script to verify it can
communicate with the database server named on this page. If you are installing applications on
a machine running Windows XP (this is supported for demonstration machines only), you may
find that the installation procedure fails at this point with the message “The procedure entry point
SetFileSecurityI could not be located in the dynamic link library MSDART.DLL,” regardless of
the server name you enter and whether you can communicate with the server in other ways.

This is due to a problem with the operating system, which you should be able to resolve by copying
the msdart.dll file to be msdart32.dll. You’ll find the file in c:\Windows\system32. Once you have
created a copy with the new name you should be able to install applications with no problems.

http://support.microsoft.com/?kbid=838252
http://support.microsoft.com/?kbid=838252
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The installer says it can’t find SQL server running on the machine specified

If the installation procedure issues the message “Can’t find SQL server running on the machine
specified.” when you click Next on the mrInterviewDataIBM® SPSS® Data Collection
Interviewer Server AdministrationDatabase Setup page, this may be for any of the following
reasons:

You mistyped the server’s name.
The machine running the SQL Server is unreachable.
Microsoft Data Access Components (MDAC) are not correctly installed.
The latest Windows updates are not installed.

To resolve the problem, do the following:

E Check that your spelling is correct and, in the case of a named SQL server instance, that you have
typed the instance name correctly.

E Check that you can ping the machine. For more information, see the topic Checking that machines
in a cluster can communicate with each other on p. 21.

E If MDAC are not installed, proceed as follows:
Cancel the installation and select Install Microsoft Data Access Components (MDAC) 2.8 from
the autoplay menu. For more information, see the topic Installing Microsoft Data Access
Components 2.8 in Chapter 2 on p. 9.
When the MDAC installation finishes, reboot the machine.

E Download and install the latest Windows updates from the Microsoft web site.

E If you are using Windows XP and the error still persists and you now see the message “The
procedure entry point SetFileSecurityI could not be located in the dynamic link library
MSDART.DLL,” follow the instructions in I’m installing onto Windows XP, and the installation
fails when I click Next on the mrInterviewData IBM SPSS Data Collection Interviewer Server
Administration Database Setup page.I’m installing onto Windows XP, and the installation fails
when I click Next on the mrInterviewData IBM SPSS Data Collection Interviewer Server
Administration Database Setup page.

Checking that machines in a cluster can communicate with each other

Each machine in a cluster must be able to communicate with all the other machines in the same
cluster. The easiest way to verify this is to use ping. This program sends a short stream of data
from one machine to another and waits for the receiving machine to return the data.

E On each machine in turn, open a DOS window and type ping machine_namewheremachine_name
is the name of one of the machines in the cluster.

If the machines can communicate, you will see several lines starting ‘Reply from’ appear on your
screen as the pinged machine returns the signal. If the machines cannot communicate you will see
the message ‘Request timed out’.

E Repeat this step for each other machine in the cluster.
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After upgrading to a IBM SPSS Data Collection Server 6 cluster, custom instances that
were created for the purpose of load balancing are no longer present on the servers.

Instances were introduced in DPM for the purpose of load balancing in version 5.6. When
upgrading from version 5.6 to 6, the installation process removes the 5.6 installation, resulting in
the removal of all installed instances (including custom instances) from each server in the cluster.

You will need to recreate any custom instances on each server in the cluster after upgrading to
IBM SPSS Data Collection Server 6.

Refer to the “The IBM SPSS Data Collection Interviewer Server Administration Load Balancing
Configuration” topic in the IBM® SPSS® Data Collection Developer Library for more
information.

Installing the export components

IBM® SPSS® Data Collection Survey Tabulation automatically downloads and installs the
relevant export component on your local machine the first time you run each type of export
in Survey Tabulation. Therefore, most people will find it unnecessary to install the export
components from the IBM SPSS Data Collection Server DVD-ROM. In some cases, however,
the security settings in your browser may prevent Survey Tabulation from downloading the
components needed to export tables. If this is the case, you can install the export components
from the IBM SPSS Data Collection Server DVD-ROM.

Required software

Installation of the export components requires that you first download and install the Microsoft
Visual C++ 2008 Redistributable Package (x86 32-bit). For more information, see the
topic Installing Microsoft Visual C++ 2008 Redistributable Package (x86 32-bit) in Chapter 2
on p. 14.

Installing the export components:

E Log on to the machine as a user who has power user or higher privileges for that machine.

E Insert the DVD-ROM into the DVD-ROM drive.

E From the Windows Start menu, choose Run.

E In the Run dialog box, type d:\autoplay. (Where d:\ is the DVD-ROM drive.) This opens the
main installer window.

E In the main installer window, choose Browse the DVD-ROM.

E Browse to the Survey Tabulation Exports Installer folder and double-click the appropriate
installation file.

This opens the IBM® SPSS® Data Collection Survey Tabulation 6 Exports window.

E On the Welcome page, click Next.
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E On the License Agreement page, read the license agreement.

E If you accept the agreement, click Yes.

E In the Customer Information page, enter your user name and your organization’s name, and
then click Next.

E In the Setup Type page, choose one of the following and then click Next:
Complete. Choose this option if you want to install the export components into the default
locations.
Custom. Choose this option if you want to specify which where the export components
will be installed.

E If you chose the Custom installation, in the Custom Setup page specify where the files will be
installed by clicking the Change button in the lower part of the window.

The IBM® SPSS® Data Collection Exports Setup wizard is now ready to start the installation.

E Click Install.

This installs and registers the export components on your local machine. You can then select
export options from Survey Tabulation.

Installing the export components from the command line:

E Open a Windows Command Prompt.
Start > All Programs > Accessories > Command Prompt

E Change to the directory on the DVD-ROM containing the Installer file
(IBMSPSSDataCollectionSurveyTabulationExports_<languagecode>.exe).

E Enter the following command to start the installation:

IBMSPSSDataCollectionSurveyTabulationExports_<languagecode>.exe /s /v/qn

where <languagecode> is the appropriate language code (for example, es for Spanish).

Enabling security access for Microsoft Excel, Word, and PowerPoint exports

If you are using Microsoft Office XP, Microsoft Office 2003, or Microsoft Office 2007, security
settings in Microsoft Excel, Word, or PowerPoint may prevent you from exporting to these
applications. If this occurs, you can enable the export to run by changing a security setting in
Microsoft Excel, Word, or PowerPoint. If you need to change the setting on your machine, a
message will inform you of this. Follow the instructions below to change the settings. If you
are in doubt about whether changing security settings is permitted by your organization, please
contact your system administrator.

Note: Ensure that you have the latest Microsoft Office service pack installed. For Microsoft
Office 2000 or XP, Service Pack 3 or later is required, and for Microsoft Office 2003, Service
Pack 2 or later is required. To check this, choose the Check for Updates option on the Microsoft
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Excel Help menu to display the Microsoft Office Downloads page, where you can download
the latest service pack.

Microsoft Office XP or 2003

Note: Setting the security options in one program does not set them in the other. You may need to
follow these steps for both Excel and Word, depending on your existing security settings.

E Ensure that IBM® SPSS® Data Collection Survey Tabulation and all Microsoft Office
applications are closed.

E Open Excel or Word.

E From the menu, choose:
Tools > Macro > Security

E This opens the Security dialog box in Excel and PowerPoint, or the Macro Security dialog box in
Word.

E Click the Trusted Sources tab (the Trusted Publishers tab in some versions of Excel, Word, and
PowerPoint).

E Select the Trust access to Visual Basic Project check box.

E Click OK to apply the setting.

E Close Excel, Word, or PowerPoint.

Microsoft Office 2007

Note: Setting the security options in one program does not set them in the other. You may need to
follow these steps for Excel, Word, and PowerPoint depending on your existing security settings.

In Microsoft Office 2007, macro security settings are located in the Trust Center.

E Ensure that Survey Tabulation and all Microsoft Office applications are closed.

E Open Excel, Word, or PowerPoint.

E Click the Microsoft Office button.

E Click the Excel Options, Word Options, or PowerPoint Options button.

E Click
Trust Center > Trust Center Settings

E In Excel, additionally click Macro Settings.

E Select the Trust access to the VBA project object model check box.

E Click OK to apply the setting.

E Close Excel, Word, or PowerPoint.
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For more information, see Enable or disable macros in Office documents
(http://office.microsoft.com/en-us/help/HA100310711033.aspx) at
http://office.microsoft.com/en-us/help/HA100310711033.aspx.

I’m having problems running IBM SPSS Data Collection applications remotely on
Windows XP

If you are working on a clustered site, your problems may be caused by a firewall between your
computer and one of the machines you are using. If you do not know whether there is a firewall,
check with your system administrator. If there is, you may need to open a port on the firewall,
allowing you to connect to the machines on the other side.

E Open Control Panel and choose:
Windows Firewall

E On the Exceptions tab, click Add Port.

E In Port Number, type 80.

E In Name, type Port 80 or any other suitable text of your choice.

E Select the “Port 80” check box on the Exceptions tab to apply the change.

I’m having problems logging into IBM SPSS Data Collection Interviewer Server
Administration or installing/running IBM SPSS Data Collection Survey Reporter Server
Edition or IBM SPSS Data Collection Author Server Edition

The following issues can result in problems logging into IBM® SPSS® Data Collection
Interviewer Server Administration or installing/running IBM® SPSS® Data Collection Survey
Reporter Server Edition or IBM® SPSS® Data Collection Author Server Edition Server:

The Internet Explorer security settings can adversely affect access to Survey Reporter Server
Edition and Author Server Edition. It is recommended that you configure Internet Explorer for
Medium security (Tools→ Internet Options→ Security tab→ Security level for this zone).
– A security setting of High will prevent all users from logging into Interviewer Server
Administration, thus preventing access to Survey Reporter Server Edition and Author Server
Edition.
– A security setting of Medium -high will allow users to login to Interviewer Server
Administration, but will prevent most users from launching Survey Reporter Server Edition
and Author Server Edition from their respective links.
Users who only belong to the Windows Guests account are not able to install or run Survey
Reporter Server Edition and Author Server Edition.

http://office.microsoft.com/en-us/help/HA100310711033.aspx
http://office.microsoft.com/en-us/help/HA100310711033.aspx
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Users who log in with Windows user names cannot activate projects

If you have installed IBM® SPSS® Data Collection Interviewer Server on a domain and have
customized it so that projects are activated using Windows login information rather than the
IBM® SPSS® Data Collection Interviewer Server Administration File Management component,
you may find that Active Directory users are unable to activate projects. These users will usually
see the message “Access is denied”.

You can resolve this problem by modifying the active directory settings for those users. Open
each user’s account and, on the Security tab, add Read permission for Authenticated Users.

My site blocks access to URLs that reference .dll files

Some companies have strict security that blocks access to sites whose URLs contain executable file
extensions. The URL for running interviews references mrIWeb.dll. To get around this problem,
you can create anmrIWeb.srf file and then register the .srf extension with the mrIWeb virtual folder.

Note: On you have done this, you will need to change the interview URL for all your existing
projects as well as for any that are created in the future.

E Navigate to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Servers\mrIWeb and create a text file called mrIWeb.srf containing the following line:

{{ handler mrIWeb.dll/Default }}

E Register the .srf extension with the mrIWeb virtual folder. There are two ways to do this. Either,
run the following command from the command line (type it all on one line not split across lines
as shown here):

C:\Inetpub\AdminScripts\adsutil set W3SVC/1/Root/mrIWeb/ScriptMaps
".srf,[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server\Server\mrIWeb\mrIWeb.dll,0,GET,HEA

Or, use Internet Information Services Manager as follows:
From Control Panel select

Administrative Tools > Internet Information Services

In the left-hand frame of the Internet Information Services window, expand the display to show
the contents of your default (or IBM® SPSS® Data Collection Interviewer Server) web site.
Right-click mrIWeb and select Properties.
The mrIWeb dialog box opens.
On the Virtual Directory tab, click Configuration.
The Application Configuration dialog box opens.
On the Mappings tab click Add.
The Add/Edit Application Extension Mapping dialog box opens.
In Executable, browse to [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer
Server\Server\mrIWeb and select mrIWeb.dll.
In Extension, type .srf.
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Select Limit to and in the text box, type GET,HEAD,POST,DEBUG.
Click OK.
Close IIS.

E For each interviewing project, change the InterviewStartURL property so that it uses the .srf file
rather than the .dll file. You will need to do this for new projects too as they are created.

Navigate to
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\DDL\Code\Tools\VB.NET\DPM
Explorer.Net and double click DPMExplorer.exe.
Expand the left-hand frame so that you can see the list of projects inside the Projects collection.
Expand the project entry in the left-hand frame and select Interviewer Server. You’ll see a list
of project properties in the right-hand frame.
Select InterviewStartURL and, in the lower section of the screen, replace mrIWeb.dll with
mrIWeb.srf.
Click Apply.

IBM SPSS Data Collection Server applications are not running properly in Internet
Explorer 8.x

If you are using Microsoft Internet Explorer 8.x or above, you may experience various issues when
using the IBM SPSS Data Collection Server applications. You can avoid these issues by adding
the appropriate IBM SPSS Data Collection Server application URLs to the Internet Explorer 8.x
Compatibility View list. Refer to the Compatibility View topic on the Microsoft Internet Explorer
8: Features website (http://www.microsoft.com/windows/internet-explorer/features/easier.aspx)
for more information.

I receive the error message “Failed to load MDM Document: The network location
cannot be reached”

Many of the IBM® SPSS® Data Collection Interviewer Server applications and activities are
dependant on a network connection in order to function properly. In order to avoid this and other
similar errors, ensure that the Interviewer Server has an active network connection.

I receive a “Maximum Length Exceeded” error when populating numerous tables in
IBM SPSS Data Collection Survey Tabulation

This error can be resolved by increasing the jsonSerialization maxJsonLength setting in
the web.config file for the IBM® SPSS® Data Collection Survey TabulationFrontend and
WebService:

The Survey TabulationFrontendweb.config file is located at
C:\InetPub\wwwroot\SPSSMR\mrTables\Frontend\web.config
The Survey TabulationWebServiceweb.config file is located at
C:\InetPub\wwwroot\SPSSMR\mrTables\WebService\web.config

http://www.microsoft.com/windows/internet-explorer/features/easier.aspx
http://www.microsoft.com/windows/internet-explorer/features/easier.aspx


136

Chapter 7

E Open each web.config file and locate jsonSerialization maxJsonLength.

E Change the value to the following: <jsonSerialization maxJsonLength="5000000" />

Note: 5000000 is the recommended value. This value will prevent the error in most situations and
will not decrease the web site’s concurrency and performance.

E Restart the Internet Information Services (IIS) service after modifying the value.

The IBM SPSS Data Collection Interviewer Server Administration User Administration
activity does not work in a FIPS 140-2 enabled, Windows Server 2008 environment

When configuring for FIPS 140-2 compliance in the Windows Server 2008 environment, you must
first install a Microsoft hotfix. Failure to install the hotfix may result in problems when using the
IBM® SPSS® Data Collection Interviewer Server Administration User Administration activity.
Refer to the Microsoft support article “FIX: You cannot run an ASP.NET 3.5-based application
that uses a ScriptManager control” (http://support.microsoft.com/kb/981119) for more information.

I’m unable to activate a project in a Windows Server 2008 cluster

When implementing a cluster in a Windows Server 2008 environment, you must ensure that TCP
port 65100 is open via the Windows firewall. Refer to you Windows Server 2008 documentation
for information on opening ports.

I receive an error when attempting to activate a project that contains certain
non-English characters

The .NET Framework’s default encoding reads the registry’s ANSI codepage when encoding. As
a result you may encounter errors when activating questionnaires that include characters such
as umlauts (for example, when the project name contains the character Ä). You can resolve this
issue by updating the server’s ANSI codepage:

1. Access the registry on the server (Start > Run >regedit).

2. Navigate to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Nls\CodePage\ACP

3. For servers running a German operating system, enter a value of 850; for Chinese, enter a value of
936; for Japanese, enter a value of 932.

Refer to Encoding Class (http://msdn.microsoft.com/en-us/library/system.text.encoding.aspx) on
the Microsoft MSDN site for more information.

http://support.microsoft.com/kb/981119
http://support.microsoft.com/kb/981119
http://msdn.microsoft.com/en-us/library/system.text.encoding.aspx
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I’ve successfully licensed IBM SPSS Data Collection Dialer but cannot work with CATI
projects in the Phone Participants activity

When licensing IBM® SPSS® Data Collection Dialer in a Windows Server 2003 or 2008 (x64
64-bit edition) environment, you must locally login to the server before attempting to license
Dialer. If you attempt to login to a domain and then license Dialer, you will not be able to work
with CATI projects in the Phone Participants activity.

How do I view logs files from a previous IBM SPSS Data Collection Server installation?

If you are upgrading from a previous version of IBM SPSS Data Collection Server, and you
want to query your old log files (from the Manage Logs activity for example), copy the old
logs from the previous version’s log directory to the new IBM SPSS Data Collection Server 6
log location (by default, [INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\Interviewer Server
Administration\Logs).

After installing the IBM SPSS Data Collection Developer Library, topics are missing
from the help system?

E You may experience missing help topics when the IBM® SPSS® Data Collection Developer
Library is installed after the IBM® SPSS® Data Collection applications are installed. You can
restore the missing topics by manually deleting the IBM Eclipse Help System’s cache files:

1. Navigate to the Windows Control Panel > Administrative Tools > Services and stop the
DataCollectionHelpCenterService service.

2. Go to C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\Documentation\ibm_help\eclipse and delete the workspace
directory.

3. Open the configuration directory and delete the four child directories (org.eclipse.core.runtime,
org.eclipse.equinox.app, org.eclipse.osgi, and org.eclipse.update). Take care that you DO NOT
delete the file config.ini.

4. Restart the DataCollectionHelpCenterService service. All of the help system topics should now
display as expected.

I’ve uninstalled IBM SPSS Data Collection Interviewer Server but IBM SPSS Data
Collection Interviewer Server Administration is still there

When you uninstall IBM® SPSS® Data Collection Interviewer Server, the uninstallation
procedure checks whether there are any other installed products that use IBM® SPSS®
Data Collection Interviewer Server Administration and, if not, deletes Interviewer Server
Administration. Very occasionally this does not work and you will need to uninstall Interviewer
Server Administration manually before you can install any product that uses Interviewer Server
Administration (this may happen if you have previously installed an early test version of a product
rather than a release version).
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E Navigate to the Interviewer Server Administration folder on the original CD image and double
click setup.exe.

The set-up program runs and displays a dialog box with an option to remove Interviewer Server
Administration.

E Select Remove and then click OK to start uninstalling.

I’ve uninstalled IBM SPSS Data Collection Interviewer Server but can’t reinstall it

After uninstalling IBM® SPSS® Data Collection Interviewer Server (or any other IBM® SPSS®
Data Collection product) you should not need to clean a machine before you can install a new
version or reinstall the same version of Interviewer Server. However, occasionally something
will happen that causes the uninstallation procedure to fail in some way. If this happens, you
will need to perform the failed tasks manually.

Note: Never clean a machine if there are SPSS Inc. products installed on the machine. If you
delete files that are part of an installed product you may break the uninstallation procedure for
that product.

Follow the steps in the checklist to clean the machine safely. If you are at all unsure about what to
do contact your Support Representative for assistance.

Where to Look What to Do
Installed Data Collection Products
Check Add/Remove Programs for any Data
Collection products.

Uninstall using the Remove option in Add/Remove
Programs.

File locations
Common files:
C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\
Application files (default):
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\
Web files (default):
C:\InetPub\wwwroot\SPSSMR

Check which files are present in each location.
Common Files should contain only two or three
files. If there are more, double check that all
products have been uninstalled and, if so, delete the
files.
Application files will contain folders for projects
and log files. Delete these. Answer Yes when asked
to confirm deletion of \SPSSMR_FMRoot.
Web files will contain a few temporary and cache
folders. You can delete these.

Global Assembly Cache (GAC)
c:\WINDOWS\assembly

This folder contains shared .NET assemblies. Delete
all the Data Collection files listed in the next table.
If you see the message “Assembly Cache Viewer –
Uninstall failed Assembly ‘AboutBox.resources’
could not be uninstalled because it is required by
other applications”, check again that there are no
Data Collection programs listed under Add/Remove
Programs. If not, continue with the clean-up
checklist.
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Where to Look What to Do
Registry
Product keys:
HKEY_LOCAL_MACHINE\SOFTWARE\SPSSHKEY_CURRENT_USER\Software\SPSS
Shared DLL:
HKEY_LOCAL_MACHINE\SOFTWARE\
Microsoft\Windows\CurrentVersion\SharedDlls
.NET Global assembly:
HKEY_CLASSES_ROOT\Installer\Assemblies
\Global

Be very careful when editing the registry as deleting
the wrong keys may break the machine.
Delete the product keys for SPSS Inc..
Under the Shared DDL key, delete any keys
that match the folder locations you deleted
in the previous step; that is C:\Program
Files\Common Files\IBM\SPSS\DataCollection\6\,
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\6\,
and \InetPub\wwwroot\SPSSMR.
In the Global Assembly section, delete only the keys
whose names match those in the following table.
Once you have done this, delete any Data Collection
files remaining in c:\WINDOWS\assembly (see
previous step).
Note: You will see other Data Collection entries in
the registry but they will not cause a reinstallation
to fail, so there is no need to delete them.

IIS
From Control Panel, select Administrative Tools,
Internet Information Services.
Under Application Pools you will see:
SPSSDimensionNetPool
SPSSmrInterviewPool
Under Web Sites, Your Website you will see:
SPSSMR
mrIWeb
mrIEngWS

The files that may be references in IIS have been
deleted already, so any virtual folders or application
pools remaining in IIS will be tagged with an error
icon. For each application pool and virtual folder
mentioned in the first column, select the folder and
delete it.

Services
mrDPMServer3
mrLoadBalanceService
mrUserAdminServer

You should not see any Interviewer Server services
listed in the Services menu. If a service does remain
on the machine, perhaps because it was running
when the program file was delete, reboot the
machine and recheck the Services menu to ensure
that it is no longer there.

Dcomcnfg
From the Start menu, select Start Run and type
dcomcnfg
This opens the Component Services dialog.
In the left-hand frame expand Component Services
to show the contents of Computers, My Computer.
Click DCOM Config.

If the right-hand frame shows any of the following,
reboot the machine and repeat this step. These
items should no longer appear.
Logbcko2
mrPrepro
mrScriptLP
mrUserAdminServer
OAgent2

Task Manager
Select the Process tab.

You may see the following Data Collection
processes listed:
Logbcko2
OAgent2
mrUserAdminServer
mrDPMServer3
Either select each process in turn and click End
Process, or reboot the machine to make sure they
are removed.

Export files
c:\WINDOWS\Downloaded Program Files

This folder may contain some export files from
IBM® SPSS® Data Collection Survey Tabulation
or the Phone Reports activity. Delete any Survey
Tabulation Export Class files.

Once you have completed these tasks, reboot the machine before you install another product.
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.NET Files Added to the Global Assembly Cache

AboutBox MRALIASMAPLib MRSQLSTORAGELib
Interfaces mrCacheLib mrUserAuth
ActivateClient MRComponentsLib mrUserCrypto
ActivateDocument mrCsvDsc mrWebExplorer
ActivateEvents mrDPMInstall MRWEIGHTLib
ActivateServer mrDPMNTS ProductInfo
AppLogLib MRDSCReg ProgressDialog
BackupAndRestoreDomLib MRENGINELib QuotaObjectModelLib
BackupAndRestoreLib MROLEDBLib SPSSMR.Data.Scripting
CDSCLib MRPREPROLib SPSSMR.Data.Transformations
CLEANMDMFORIVSLib MRPROPERTIESLib SPSSMR.DataCollection.

SMProvider
DataLinkDialog mrQdiDrsDsc SPSSMR.Dimensions.Windows.

UI.Controls
DimensionNet mrQtSpecDsc SPSSMR.DPM.Agent
HTMLPlayerLib mrRegistrar SPSSMR.DPM.CommonClassses
ICSharpCode.SharpZipLib MRSAMPLEMANAGEMENTLib SPSSMR.DPM.Interfaces
IOMLib MRSCRIPTCORELib SPSSMR.DPM.Scripting
LoadBalanceLib MRSCRIPTLib SPSSMR.DPM.NET
LogFrontLib MRSCRIPTLPLib SPSSMR.Management.Monitoring
Login mrScriptMDSCLib SPSSMR.Management.Monitoring.

DimensionNet
ManageUserProperties MRSMINTERFACESLib SPSS.UI.Utilities.Expression

Splitter
MDM2QuantumLib QUOTAPROVIDERLib SPSSMR.Utilities.BackupAnd

Restore
MDMLib QuotaRuntimeLib SPSSMR.Utilities.BackupAnd

Restore.Dom
MDMMGRLib RAP SPSSMR.Web
MDMToolsLib RegIntSvrLib TomLib
MDSC RemoteUtilities Upgrade_3.0
MEOWMONILERLib Scripting UpgradeCati_3_0
mrEngineMemoryLib SPSS.Dimensions.FileManager UserProperties
MREVALUATELib SPSS.Configuration.Dimensions Utilities
MRFILEMGTLib SPSS.Constants
mrIHTMLTidyLib SPSS.Data.Databaseagent
mrInstall.net SPSSMR.Data.Datasource
MRINTERVIEWLib iSPSSMR.Data.Interfaces
MRLIBVERLib SPSSMR.Data.Participants
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Licensed Materials – Property of SPSS Inc., an IBM Company. © Copyright SPSS Inc. 2000,
2010.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: SPSS INC., AN IBM COMPANY, PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of
the publication. SPSS Inc. may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.

Any references in this information to non-SPSS and non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web sites. The
materials at those Web sites are not part of the materials for this SPSS Inc. product and use of
those Web sites is at your own risk.

When you send information to IBM or SPSS, you grant IBM and SPSS a nonexclusive right
to use or distribute the information in any way it believes appropriate without incurring any
obligation to you.

Information concerning non-SPSS products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. SPSS has not tested those
products and cannot confirm the accuracy of performance, compatibility or any other claims
related to non-SPSS products. Questions on the capabilities of non-SPSS products should be
addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations.
To illustrate them as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any similarity to the names
and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to SPSS Inc., for the purposes of developing,
using, marketing or distributing application programs conforming to the application programming
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interface for the operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. SPSS Inc., therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample programs are provided
“AS IS”, without warranty of any kind. SPSS Inc. shall not be liable for any damages arising out
of your use of the sample programs.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks of IBM Corporation, registered in many
jurisdictions worldwide. A current list of IBM trademarks is available on the Web at
http://www.ibm.com/legal/copytrade.shmtl.

SPSS is a trademark of SPSS Inc., an IBM Company, registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other product and service names might be trademarks of IBM, SPSS, or other companies.

Adobe product screenshot(s) reprinted with permission from Adobe Systems Incorporated.

Microsoft product screenshot(s) reprinted with permission from Microsoft Corporation.
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